abl eton

Reference Manual




Live Version 5.0 for Windows and Mac OS

Created by Bernd Roggendorf, Gerhard Behles, Robert Henke, awi, Reiner Rudolph, Stefan
Haller, Torsten Slama, Eduard Mueller, Stefan Franke, Frank Hoffmann, Andreas Zapf, Hans-
Thomas Mueller, Henrik Hahn, Ralf Suckow, Gregor Klinke, Matthias Mayrock, Friedemann
Schautz, Ingo Koehne.

Reference Manual by Rose Knudsen, Gerhard Behles, Jakob Rang, Robert Henke, Torsten
Slama.

Loops and samples provided by Big Fish Audio.

Web: www.bigfishaudio.com

E-mail: info@bigfishaudio.com

Address: 11003 Penrose Street, Suite C, Los Angeles, CA 91352

IS
lc!l! |t!ton

Copyright 2005 Ableton AG. All rights reserved.

This manual, as well as the software described in it, is furnished under license and may be used or copied only in accordance with
the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice and
should not be construed as a commitment by Ableton. Ableton assumes no responsibility or liability for any errors or inaccuracies
that may appear in this book.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system or transmitted, in
any form or by any means, electronic, mechanical, recording or otherwise, without the prior written permission of Ableton.

Macintosh, Audio Units and QuickTime are registered trademarks of Apple Computer, Inc. Windows is a registered trademark
of Microsoft Corporation. VST is a trademark of Steinberg Media Technologies GmbH. ReWire is a trademark of Propellerhead
Software AB. Mackie Control is a trademark of LOUD Technologies Inc. Ogg Vorbis and FLAC are trademarks of Xiph.Org. Ableton
is a trademark of Ableton AG. All other product and company names are trademarks or registered trademarks of their respective
holders.


mailto:info@bigfishaudio.com

Chapter 1

Welcome to Live

1.1 The Ableton Team Says: Thank You

Live is the result of musicians wanting a better way to create, produce and perform music
using a computer. A great deal of effort has been put into making Live easy and fun to
use, yet at the same time capable of helping you create music with unlimited depth and
sophistication. This effort continues even as you read these lines... in fact, a new, improved
Live version might already be available for download! Please check on our website now?,

or choose “"Check for Updates” from the Help menu.

We hope you enjoy using Live and that it enhances your creative process. Should you have
suggestions about how we can improve Live, please let us know?.

Thttp://www.ableton.com/downloads
2contact@ableton.com
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Your Ableton Team.

1.2 What's New in Live 5?

1.2.1 Remix Features

Support for MP3, Ogg Vorbis, Ogg FLAC and FLAC compressed audio files (see
Sample Files)

Auto-Warp (see Syncing Longer Pieces)

Complex Warp Mode (see Complex Mode) for warping music containing beats, tones
and textures

Clip scrub, nudge and improved transport controls (see Clip Offset and Nudging)

1.2.2 Organizational Tools for Files and Sets

e File search function (see Searching for Files)

e Better browsing for files and folders (see Working with the File Browsers)

Live Clip (see Live Clips) format for easy storage and retrieval of clip and device settings

Import and export of Live Sets (see Importing and Exporting Sets with the Browser)
and their components directly from the Browser

Open Recent Set command
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1.2.3 Clip and Track Enhancements

e Track Freeze (see Track Freeze) for conserving CPU resources and simplifying project
sharing

e Track Delay controls (see Track Delays) to control for human, acoustic and hardware
delays

e Multi-selection clip editing (see Clip View)
e Clip deactivation option (see Clip Activator Switch)

1.2.4 Working with Arrangements

e Launchable Arrangement Locators (see Launching the Arrangement with Locators)
e New Arrangement Transport (see Transport)
e Track I/O in the Arrangement View (see Routing and 1/O)

1.2.5 Editing MIDI

e Detailed and adaptive MIDI quantization options (see Arranging and Quantizing Notes)
e Preview in the MIDI Editor (see The MIDI Editor)

e MIDI note deactivation option (see Deactivating Notes)

1.2.6 MIDI and Key Remote Control

¢ Mackie Control support (see Mackie Control)
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¢ Improved mapping for the crossfader (see Using Live's Crossfader)

1.2.7 Resources

e Valuable library (see The Library) of clips, device presets and Live Sets
e Library expansion and customization with Live Packs (see Live Packs)

e New interactive built-in program lessons (see Learn About Live)

1.2.8 Live Effects and Instruments

e Beat Repeat (see Beat Repeat) for reorganizing and “shredding” beats and vocals
e Phaser (see Phaser) and Flanger (see Flanger)

e Auto Pan (see Auto Pan) for LFO-driven manipulation of amplitude and panning

e Saturator (see Saturator) for subtle-to-drastic distortion effects

e Arpeggiator (see Arpeggiator)

o New features for Simpler (see Simpler) and Operator (see Operator)

1.2.9 Using Devices

e Browser-based device preset management (see Live Device Presets)

e Device groups (see Device Groups) for saving multi-effect combinations together with
instruments
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¢ Device delay compensation (see Device Delay Compensation) for Live and plug-in
instruments and effects

e Live can receive MIDI messages from plug-ins
e VST Plug-ins can be stored in various directories (see The VST Plug-In Folder)

1.2.10 Miscellaneous

e (O (PC)/ [cth ]E) (Mac) context menus for many commands and settings

Zoom-adaptive or fixed grid options (see Using the Editing Grid)

Count-in recording (see Recording with Count-in)

Monitoring status easily visible when the In/Out section is hidden

Files, Sets and presets can be dragged into Live from the Explorer (Windows) / Finder
(Mac)



Chapter 2

First Steps

When you install Live and run it for the first time, you will be presented with the Products
Preferences tab.

If you own Live, you can authorize your copy of the software by selecting it from the listed
products and clicking the Unlock button at the bottom of the window. Please see the

chapter on unlocking Live (see Unlocking Live) should you have questions or concerns that
arise during the unlocking process.

If you do not (yet) own Live, you can close the Preferences and proceed, as Live will run in
Demo Mode by default. In Demo Mode, you will be able to work with all of Live's features
with the exception of saving and exporting.
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2.1 Learn About Live

Live comes with a set of interactive lessons to take you step by step through the key features
of the program. The lessons are organized in a table of contents, which can be opened
directly in the program via the Help menu. We highly recommend following the lessons.
Many users have told us that the lessons helped them get familiar with the program very
quickly.

We also recommend that you read the Live Basics chapter (see Live Basics), which encap-
sulates everything that Live is and can do, and is therefore a worthwhile read for both
beginners and experienced users. The remaining chapters of this manual serve as in-depth
reference for the material introduced in Live Basics.

2.1.1 Using the Info View and Index

Live’s Info View tells you the name and function of the user interface element currently under
the mouse.
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The Info View.

If you require more information on a specific user interface element or topic, please consult
this reference manual. The index, found at the end of the manual, contains the names of all
user interface elements and will lead you to the relevant section.

2.2 Setting up Preferences

Live's Preferences dialog is where you can find various settings that govern how Live looks,
behaves and interfaces with the outside world. This dialog is accessed with the Options
menu’s (Windows) / Live menu'’s (Mac OS X) “Preferences” entry.

Live's Preferences are distributed over several tabs:

¢ The Audio Preferences are used to set up Live's audio connections with the outside
world via an audio interface. Please take the time to follow the program’s built-in
"Setting up Audio I/0” lesson, which will walk you through all the steps required to
set up and optimize the settings for any given system. To access the lesson, choose
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“Lessons Table of Contents” from the Help menu.

The MIDI/Sync Preferences are used to help Live recognize MIDI devices for three
separate and distinct purposes:

- Playing MIDI notes. To learn how to route an external device into Live for MIDI
input, or how to send MIDI to an external device, please see the chapter on
routing (see External MIDI In/Out).

- Controlling parts of the interface remotely. This subject is covered in detail in the
chapter on remote control (see MIDI and Key Remote Control).

- Syncing the program with an external sequencer or drum machine, either as a
master or a slave. Please see the manual section on sync (see Synchronizing via
MIDI) for details.

The Plug-In Preferences pertain to the use of plug-in virtual instruments and effects,
as described in the chapter on using plug-ins (see Using Plug-Ins).

The Default Preferences allow customizing the default state for new projects (see
Live Sets) and their components (see Clip View), as well as selecting options for new
recordings (see Recording New Clips).

The Misc(ellaneous) Preferences include various options. Here, you can select Live’s
system language and a color scheme, or “skin,” for the Live user interface.

The Products Preferences are used to manage licensing and installation of the Live
platform (see Unlocking Live), and add-on components like the Operator instrument
(see Operator) and Live Pack library packages (see Live Packs).
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2.3 The Main Live Screen

Most of your work in Live happens in the main Live screen. This screen consists of a number
of views. Each view manages a specific aspect of your project. As screen space is limited,
the Live views cannot all be up at the same time.

Each one of the selector buttons at the screen borders calls up a specific view; click this one,
for instance, to access the Live devices:

AP |1z 4 1 4 o® | EX

Waweforms
prams A View Selector.
To hide one of Live's views and free up screen space, click on the triangle-shaped button

next to it. To restore the view, click the button again.

AP |12 4 14 o® | EX

ﬂ (¢ Library +

Wawvaforms A View Show/Hide
Drums Button.

You can run Live in Full Screen Mode by selecting “Full Screen” from the View menu. To
leave Full Screen Mode, click the button that appears in the lower right corner of the screen.
Full Screen Mode can also be toggled by pressing the F11 key.

You can adjust the main window’s horizontal split by dragging.
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Chapter 3

Unlocking Live

Live is protected against illegal use by a copy protection scheme. This scheme has been
designed to meet the highest security standards while avoiding hassles for the customer. If
you find this procedure to be an inconvenience, please understand that the copy protection
secures your investment: It allows Ableton to provide you with support and to continue
developing Live.

Authorization of Ableton products takes place in the Preferences’ Products tab, which will
appear when you start Live for the first time.

Here you can choose to authorize (“unlock”) or purchase any Ableton products available to
you, for example the Operator instrument (see Operator).

Please note that products such as Operator are sold separately from Live but are unlocked
using the same procedure described in the following sections. They will run in Demo Mode
by default so that you can try them out.

12
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This software incorporates 2 Ableton products that you can separately demo, buy
or unlock,

Product

The Products Tab as it
Appears upon Startup.

Clicking on any product listed in the Products tab will give you the option of unlocking or
buying that product. Please click the Unlock button here to complete the unlocking process
in two steps. If you have not yet purchased the product, you can do so online by clicking the
Buy button. You can always return to the Products Preferences tab later or visit the Ableton
webshop! to make a purchase. Live's Preferences are available via the Options menu (or
the Live menu in Mac OS X).

The Real-Time Music Production Platform.
Live 5 has not yet been unlocked and is running in Demo Mede. In Demo
Maode, you can explore the product’s functionality, but you cannot save or

export your work,
Buy Find out about buying options and buy Live § online.
Unlock Onca you own Live 5, unlock Live 5 using the Sarial Numbar

‘you received from Ableton.

To continue using Live 5 in Demo Mode, simply close this dialog.

Selecting the Unlock

(I- Button in the Products
Tab.

1 http://www.ableton.com/shop
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3.1 Step 1: Entering Your Serial Number

As an owner of Live, you have received a Serial Number from Ableton, either via e-mail (if
you ordered Live directly from Ableton), or on a card as part of the Live package.

iter Your Serial Number

m

Please enter the Serial Numbar for Live which you received from Ablaton,

After selecting “Unlock” in the Products tab, you will be presented with six fields for typing
in your Serial Number. Each field holds four characters. The Serial Number is composed of
numbers 0..9 and letters A..F. If you accidentally type the wrong string into a field, the field
will turn red. When you have successfully entered the Serial Number, click the “Ok” button
to proceed.

The Serial Number identifies your ownership of Live. Because your Serial Number is a
valuable good, you should keep it in a safe place and out of reach of unauthorized hands.
Please be aware that sharing your Serial Number will render it unusable. The only way for
Ableton technical support to help you get back your Serial Number if you lose it is via your
registration data. Therefore, please register your product?, as otherwise you might lose
your property!

3.2 Step 2: Unlocking Live

The second step of authorizing Live is called “unlocking.” Unlocking means associating
your Serial Number with a specific computer. Please be aware that the standard Live license
grants you the right to use Live on only one computer at a time. You can, however, unlock

Zhttp://www.ableton.com/register

The Fields for Entering
Your Serial Number.
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Live with your Serial Number more than once under the legal and technical conditions
described later (see Copy Protection FAQs).

3.2.1 The Unlock Key

For unlocking, you require an Unlock Key that can only be created by the Ableton server.
Unlocking therefore requires access to the Internet. The computer from which you connect
to the Internet does not have to be the same computer for which you wish to unlock Live,
but it does make things easier.

3.2.2 The Challenge Code

The Ableton server creates the Unlock Key from your Serial Number and a so-called Chal-
lenge Code. The Challenge Code is a “fingerprint” that Live takes of your computer’s
components. For details, please see the corresponding section (see Copy Protection FAQs).

3.2.3 Unlocking Online

Unlock Online

This method of unlocking Live is much faster and easier than unlocking
offling, as it is done automatically via tha internet. If this computer is

connected to the internet, please press the ‘Unlock Online" button.

Unlocking Live Online.

If the computer you want to unlock Live for is connected to the Internet, the only thing you
need to do is press the Unlock Online button. Live will then create a connection to the
Ableton server, send your Serial Number and Challenge Code, and receive the Unlock Key
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from the server. No information other than this is exchanged between your computer and
the Ableton server.

3.2.4 Unlocking Offline

Unlocking Live Offline.

If the computer you want to unlock Live for is not connected to the Internet, you can use
any other computer to access the Ableton server's web interface3. This is a website with
fields for entering your Serial Number and the Challenge Code, which you can copy from
Live’s Unlock dialog.

Please enter your Serial Number and Challenge Code to retrieve an Unlock Key:

Unlock Offline

Serial Number:

Challenge Code:

The Live Unlocking Web
Site.

3http://www.ableton.com/unlock
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If you have entered your Serial Number and Challenge Code correctly, another website will
appear to provide you with the Unlock Key. There now are two options for transferring the

Unlock Key to the computer that is to be unlocked:

Follow the weblink to download the Unlock Key as a file. Transfer the file to the target
computer via a diskette or CD-ROM. Then, press the Unlock dialog’s Load Unlock Key

button to load the Unlock Key file.

Live 4, Live 3 or Live 2 - Download Unlock Key

MAC: Please hold the Option key while clicking here and the Unlock Key should
begin to download.

PC: Please right click here and save the Unlock Key to disk.

Transfer the Unlock Key (Unlock_ xxxx xxxx xxxx xoooctxt) to the computer
where Live is installed. Start Live and in the Live unlock dialog press "Load
Unlock Key". Finally, load the Unlock Key in the file selection dialog.

Note: If transferring the file to the computer seems too inconvenient, and you
are already using Live 4, Live 3 or Live 2, you can enter the Unlock Key

manually.

OR it might be more convenient to print the webpage with the Unlock Key on it. On the
target computer, press the Enter Unlock Key button to open a dialog with fields for typing
in the Unlock Key. Typing it in is easier than it first appears, because the fields will turn red

if you type the wrong string.

The Unlock Key Can Be
Downloaded as a Text
File.
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Live 4, Live 3 or Live 2 - Enter the Unlock Key

Mote: The Unlocl 2y 5 € : sensitive

Unlock Key:

HENXEHEY = NHMEXEYY - NEXXXXX

HEMXXEEY — XEMMYXX — XEXEXXEX

XENXEXY = XEXXXXX = XXEXXXXX

Manually Enter Your
Unlock Key.

3.3 Copy Protection FAQs

3.3.1 Can | Run Live Without a Serial Number?

If you do not (yet) own Live, you can work with Live in Demo Mode. Demo Mode offers
Live's complete functionality, but saving and exporting are disabled. Live will run in Demo
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Mode by default if it has not been authorized.

Tha Real-Time Music Production Platform.

Live 5§ has not yet been unlocked and is running in Demo Mode. In Demo
Mode, you can explora the product’s functionality, but you cannot save or
axport your work,

Buy Find out about buying options and buy Live 5 onlina.

Unlock Onca you own Live 5, unlock Live 5 using the Serial Mumber
you received from Ableton,

To continue using Live 5 in Demao Mode, simply close this dialog.

Click Here if You Are

Interested in Buying

Live.

If running Live in Demo Mode raises your interest in purchasing the full version of Live,
please select Live from the Products Preferences tab and then click the Buy button, or
visit the Ableton webshop?. This site contains information about Ableton’s distributor and
dealer network. It also offers you the opportunity to buy Live online. Live's Preferences are
available via the Options menu (or the Live menu in Mac OS X).

3.3.2 What if | Change My Computer’s Components?

If the Challenge Code of your computer changes for some reason, Live will indeed ask
you to unlock the software another time (see Can | Unlock Live More than Once?). The
Challenge Code does not change, however, when computer peripherals are replaced (audio

4http://www.ableton.com/shop
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or MIDI hardware, printers, modems). The Challenge Code may change if the motherboard,
processor or network card is replaced. On some computers, reformatting a hard drive also
changes the Challenge Code.

3.3.3 Can | Unlock Live More than Once?

The standard Live license allows you to use Live on only one computer at a time. However,
if you have registered your product®, the Ableton server will provide you with two Unlock
Keys in good faith that you will use Live on only one machine at a time. Just proceed as
described in the corresponding section (see Step 2: Unlocking Live).

You can therefore run Live on both a studio desktop computer and a tour laptop, but not at
the same time.

Should the Ableton server reject your demand for another Unlock Key, please contact
Ableton’s technical support.

They can be reached by:
e E-mailé:
e Telephone: +49 (0)30 - 288 763 151 (available Monday to Friday 11 to 15hrs CET);
e Fax: +49 (0)30 - 288 763 11.
To speed up the process, please:
e Register your copy of Live’;

e Include a brief explanation of the circumstances.

Shttp://www.ableton.com/register
Ssupport@ableton.com
"http://www.ableton.com/register
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To use Live on more than one computer at a time, you require a secondary license or a site
license. Ableton offers these licenses at special rates. Please contact the sales team?® for
details.

3.3.4 Can | Play my Set from a Computer That Is Not Unlocked?

In Demo Mode, you can load and perform a Live Set with no time limitation. You cannot,
however, save or export your work. When you go on tour, consider taking along your Live
program CD and a CD with the last state of your Live Set(s). In case of an emergency, you
can install and run Live on any computer available and play your backup Live Set(s).

3.3.5 Can | Hide Products or Features if I'm Not Ready to Purchase
Them?

In the Products tab of the Preferences, you can view your available products and their
statuses (e.g., Demo Mode, Unlocked, etc.). Clicking on any product will provide you with
more information and the option of buying or unlocking.

If you are not ready to purchase a particular product, you can hide it and its features from
view in Live using the Hide button. If hidden, a product and its features will be unavailable.
You can always choose to show a product again later, and then try out its features by using
them in Demo Mode.

8orders@ableton.com
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Click Here to Hide a
Product’s Features.

3.3.6 What Do | Do About Problems or Questions Regarding Copy Pro-
tection?

Please contact technical support”. They are happy to help!

?support@ableton.com
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Chapter 4

Live Basics

This chapter introduces the essential concepts of Live. We advise you to read this chapter
early in your Live career, as a solid understanding of the program'’s basic principles will help
you fully exploit Live's potential for your music-making.

4.1 Live Sets

The type of document that you create and work on in Live is called a Live Set (see Live Sets).
Live Sets can be opened either through the File menu’s Open command or via the built-in
File Browsers.

23
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Pressing the Library button in Live's Browser will take you to Live's library of creative tools.
There are a number of starter Sets here; double-clicking a Live Set's name in the Browser
will open that Live Set.

4.2 Arrangement and Session

The basic musical building blocks of Live are called clips. A clip is a piece of musical material:
a melody, a drum pattern, a bass line or a complete song. Live allows you to record and
alter clips, and to create larger musical structures from them: songs, remixes, DJ sets or
stage shows.

A Live Set consists of two environments that can hold clips: The Arrangement is a layout of
clips along a musical timeline; the Session is a real-time-oriented “launching base” for clips.
Every Session clip has its own play button that allows launching the clip at any time and in
any order. Each clip’s behavior upon launch can be precisely specified through a number of
settings (see Launching Clips).

[cizL |uwRevere | Clips in the Session View
(Left) and in the
[frack3 | Arrangement View
(Right).

The Arrangement is accessed via the Arrangement View (see Arrangement View) and the
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Session via the Session View (see Session View); you can toggle between the two views
using the computer's Tab key or their respective selectors. Because the two views have
distinct applications, they each hold individual collections of clips. However, it is important
to understand that flipping the views simply changes the appearance of the Live Set and
does not switch modes, alter what you hear or change what is stored.

B Return Master ®

The Arrangement and
Session View Selectors.

Arrangement and Session interact in useful (though potentially confusing) ways. One can, for
instance, improvise with Session clips and record a log of the improvisation (see Recording
Sessions into the Arrangement) into the Arrangement for further refinement. This works
because Arrangement and Session are connected via tracks.

4.3 Tracks

Tracks host clips and also manage the flow of signals, the creation of new clips through
recording, sound synthesis, effects processing and mixing.
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Session and Arrangement share the same set of tracks. The tracks are vertically laid out from
left to right in the Session View, and horizontally from top to bottom in the Arrangement
View. A simple rule governs the cohabitation of clips in a track:

A track can only play one clip at a time.

Therefore, one usually puts clips that should play alternatively in the same Session View
column, and spreads out clips that should play together across tracks in rows, or so-called
scenes (see Tracks and Scenes).

The exclusivity of clips in a track also implies that, at any on time, a track will either play a
Session clip or an Arrangement clip, but never both. So, who wins? When a Session clip
is launched, the respective track stops whatever it is doing to play that clip. In particular, if
the track was playing an Arrangement clip, it will stop it in favor of the Session clip — even
as the other tracks continue to play what is in the Arrangement. The track will not resume

A Track in the
Arrangement View.

A Scene in the Session
View.
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Arrangement playback until explicitly told to do so.

This is what the Back to Arrangement button, found in the Control Bar at the top of the
Live screen, is for. This button lights up to indicate that one or more tracks are currently not
playing the Arrangement, but are playing a clip from the Session instead.

We can click this button to make all tracks go back to the Arrangement. Or, if we like what
we hear, we can capture the current state into the Arrangement by activating the Record
button. Disengaging Record Mode or stopping Live using the Stop button leaves us with
an altered Arrangement.

4.4 Audio and MIDI

Clips represent recorded signals. Live deals with two types of signals: audio and MIDI. In the
digital world, an audio signal is a series of numbers that approximates a continuous signal
as generated by a microphone or delivered to a loudspeaker. A MIDI signal is a sequence
of commands, such as “now play a C4 at mezzo piano.” MIDI is a symbolic representation
of musical material, one that is closer to a written score than to an audio recording. MIDI
signals are generated by input devices such as MIDI or USB keyboards'.

It takes an instrument (see Working with Instruments and Effects) to convert MIDI signals
into audio signals that can actually be heard. Some instruments, such as Live's Simpler,
are for chromatic playing of one sound via the keyboard. Other instruments, such as Live's
Impulse, have a different percussion sound assigned to each keyboard key.

Audio signals are recorded and played back using audio tracks, and MIDI signals are

'For an introduction to digital audio and MIDI, please see http://img.uoregon.edu/emi/emi.php and
http://www.midi.org/

The Play, Stop, Record
and Back to
Arrangement Buttons.
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recorded and played back using MIDI tracks. The two track types have their own corre-
sponding clip types. Audio clips cannot live on MIDI tracks and vice versa.

Information about inserting, reordering and deleting audio and MIDI tracks is found here
(see Audio and MIDI Tracks).

4.5 Audio Clips and Samples

An audio clip contains a reference to a sample (also known as a “sound file” or “audio file”)
or a compressed sample (such as an MP3 file). The clip tells Live where on the computer’s
drives to find the sample, what part of the sample to play and how to play it.

When a sample is dragged in from one of Live's built-in File Browsers (see Working with the
File Browsers), Live automatically creates a clip to play that sample. Prior to dragging in a
sample, one can audition or preview it directly in the Browser; the switch in the Browser with
the headphone icon activates previewing.

ap | 1: 4 1 4 o® | EX »

&) SampleLibrary e 0m@
@ cark. water 1 Audio
@ cd
fon] €0 PLYR 2
fon] cELLULAR
fn] EASTLK.
@ fan
@ genarator T =
o] hard drive
fon] misC. ELECT.

[ PHOENIX

Monitor

Live offers many options for playing samples in exciting new ways, allowing you to create an

Samples Are Dragged in
from Live’s File Browsers.
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abundance of new sounds without actually changing the original sample — all the changes
are computed in real time, while the sample is played. The respective settings are made in
the Clip View (see Clip View), which appears on screen when a clip is double-clicked.
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Many powerful manipulations arise from Live's warping (see Time-Warping Samples) capa-
bilities. Warping means changing the speed of sample playback independently from the
pitch so as to match the project tempo as adjusted in the Control Bar's Tempo Field.

TAP 414 50 | o® | EXT *

The most elementary use of this technique, and one that usually requires no manual setup,
is synchronizing sample loops to the chosen tempo. Live's Auto-Warp algorithm actually
makes it easy to line up any sample with the project tempo, such as a recording of a drunk
jazz band’s performance. It is also possible to radically change the sonic signature of a
sound using extreme warp settings.

An Audio Clip’s
Properties as Displayed
in the Clip View.

The Control Bar's Tempo
Field.
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4.6 MIDI Clips and MIDI Files

A MIDI clip contains musical material in the form of MIDI notes and controller envelopes.
When MIDI is imported from a MIDI file (see Working with the File Browsers), the data gets
incorporated into the Live Set, and the original file is not referenced thereafter. In the Live
File Browsers, a MIDI file appears as a folder that can be opened to reveal its individual
component tracks, which can be selectively dragged into the Live Set.
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As expected, a MIDI clip’s contents can be accessed and edited (see Editing MIDI Notes
and Velocities) via the Clip View, for instance to change a melody or “paint” a drum pattern.
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4.7 Devices and the Mixer

A track can have not only clips but also a chain of devices (see Working with Instruments
and Effects) for processing signals. Double-clicking a track’s title bar brings up the Track
View, which shows the track’s device chain.
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Live's built-in audio effects (see Live Audio Effect Reference), MIDI effects (see Live MIDI
Effect Reference) and instruments (see Live Instrument Reference) are available from the
Device Browser and can be dragged from there into the Track View or onto a track title bar.
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Live’s Built-in Devices
Are Available from the
Device Browser.

You can also use plug-in devices (see Using Plug-Ins) in Live. VST and Audio Units (Mac OS

X only) Plug-ins are available from the Plug-In Device Browser.
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Consider an audio clip playing in an audio track. The audio signal from the clip reaches the
leftmost device in the chain. This device processes (changes) the signal and feeds the result
into the next device, and so on. The number of devices per track is theoretically unlimited.



4.7. DEVICES AND THE MIXER 33

In practice, the computer’s processor speed does impose a limit on the number of devices
you can use at the same time, a topic that deserves separate discussion (see Managing the
CPU Load). Note that the signal connections between audio devices are always stereo, but
the software’s inputs and outputs can be configured to be mono in the Audio Preferences.

When the signal has passed through the device chain, it ends up in Live's mixer (see The Live
Mixer). As Session and Arrangement share the same set of tracks, so they share the mixer.
The mixer can be shown in both views for convenience. To optimize the screen layout, the
individual mixer sections can be shown or hidden using the View menu's entries.
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The mixer has controls for volume, pan position and sends, which adjust the contribution
each clip track makes to each return track’s input. Return tracks cannot host clips, only
effects. Via their sends, all tracks can feed a part of their signal into a return track and share
its effects.

The mixer also includes a crossfader (see Using Live's Crossfader), which can create smooth
transitions between clips playing on different tracks. Live’s crossfader works like a typical DJ
mixer crossfader, except that it allows crossfading not only two but any number of tracks —

The Live Mixer in the
Arrangement View (Top)
and Session View
(Bottom).
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including the returns.

35

Devices that receive and deliver audio signals are called audio effects. Audio effects are the

only type of device that fit in an audio track or a return track. However, two more types of

devices are available for use in MIDI tracks: MIDI effects and instruments.

Considera MIDlI track playing a clip. The MIDI signal from the clip is fed into the track’s device
chain. There, it is first processed by any number of MIDI effects. A MIDI effect receives

and delivers MIDI signals.

One example is the Scale effect, which maps the incoming

notes onto a user-defined musical scale. The last MIDI effect in the chain is followed by an
instrument. Instruments, for instance Live’s Simpler and Impulse, receive MIDI and deliver
audio. Following the instrument, there can be any number of audio effects — as in an audio

track.
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If a MIDI track has no instrument (and no audio effects), then the track’s output is a plain

Live's Crossfader.

MIDI Effects, an
Instrument and Audio
Effects in a MIDI Track.
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MIDI signal, which has to be sent somewhere else to be converted into audio. In this case,
the track’s mix and Send controls disappear from the mixer.
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4.8 Presets and Device Groups

Every Live device can store and retrieve particular sets of parameter values as presets (see
Live Device Presets). As presets are stored independently from Live Sets, new presets
become part of a library that any project can draw from.

Live's Device Groups (see Device Groups) allow saving combinations of devices and their
settings as a single preset. This feature allows for the creation of powerful multi-device
creations and effectively adds all the capabilities of Live’s MIDI and audio effects to the
built-in instruments.
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4.9 Routing

As we have seen, all tracks deliver signals, either audio or MIDI. Where do these signals
go? This is set up in the mixer's In/Out section, which offers, for every track, choosers to
select a signal source and destination. The In/Out section, accessible through the View
menu’s “In/Out” entry, is Live's “patchbay.” Its routing options (see Routing and I/O) enable
valuable creative and technical methods such as resampling, submixing, layering of synths,

complex effects setups and more.
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Signals from the tracks can be sent to the outside world via the computer’s audio and MIDI
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interfaces, to other programs that are connected to Live via ReWire (see Connecting via
ReWire) or to other tracks or devices within Live.

Likewise, a track can be set up to receive an input signal to be played through the track’s
devices. Again, tracks can receive their input from the outside, from a ReWire program or
from another track or device in Live. The Monitor controls regulate the conditions under
which the input signal is heard through the track.

4.10 Recording New Clips

Audio tracks and MIDI tracks can record their input signal and thereby create new clips
(see Recording New Clips). Recording is enabled on a track by pressing its Arm button
(Hold down the (PC) / (Mac) modifier to arm several tracks at once). When
the Control Bar's Record button is on, every armed track records its input signal into the
Arrangement. Every take yields a new clip per track.

(‘U i

It is also possible to record into Session View slots on the fly (see Recording Into Session
Slots). This technique is very useful for the jamming musician, as Session recording does
not require stopping the music. When a track is armed, its Session slots exhibit Clip Record
buttons, and clicking one of these commences recording. Clicking the Clip Record button
again defines the end of the recording and launches the new clip. As these actions are
subject to real-time launch quantization, the resulting clips can be automatically cut to the
beat.

A Track Arm Button, as
Appears in the Session
View.
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Session recording in conjunction with the Overdub option and Record Quantization is the
method of choice for creating drum patterns, which are built up by successively adding
notes to the pattern while it plays in a loop. It only takes a MIDI keyboard (or the computer
keyboard) and a MIDI track with Live’s Impulse percussion instrument to do this (see Overdub
Recording MIDI Patterns).

4.11 Automation Envelopes

Often, when working with Live's mixer and effects, you will want the controls’ movements
to become part of the Arrangement. The movement of a control across the Arrangement
timeline is called automation (see Automation and Editing Envelopes); a control whose
value changes in the course of this timeline is automated. Automation is represented in the
Arrangement View by breakpoint envelopes, which can be edited and drawn.

23.4.4 24 24.1.2 24.1.3
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Practically all mixer and effect controls in Live can be automated, even the song tempo.
Creating automation is straightforward: All changes of a control that occur while the Control
Bar's Record switch is on become automation.

Changing an automated control’s value while not in Record Mode is similar to launching a
Session clip while the Arrangement is playing: It deactivates the control’s automation (in

The Control Bar's
Quantization Chooser.

The Automated Pan
Control and its
Envelope.
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favor of the new control setting). The control will stop tracking its automation and rest
with the new value until the Back to Arrangement button is pressed, which will resume
Arrangement playback.

4.12 Clip Envelopes

Envelopes can be found not only in tracks but also in clips. Clip envelopes (see Clip
Envelopes) are used to modulate device and mixer controls. Audio clips have, in addition,
clip envelopes to influence the clip’s pitch, volume and more; these can be used to change
the melody and rhythm of recorded audio. MIDI clips have additional clip envelopes to
represent MIDI-controller data. Clip envelopes can be unlinked from the clip to give them
independent loop settings, so that larger movements (like fade-outs) or smaller gestures
(like an arpeggio) can be superimposed onto the clip’s material.

Clip Envelopes +

An Envelope for Clip
Transposition.
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4.13 MIDI and Key Remote

To liberate the musician from the mouse, most of Live's controls can be “remote-controlled”
via an external MIDI controller. Remote mappings are established in MIDI Map Mode (see
Assigning MIDI Remote Control), which is engaged by pressing the MIDI switch in the
Control Bar.

In this mode, you can click on any mixer or effect control, and then assign it to a controller
simply by sending the desired MIDI message (for example, by turning a knob on your MIDI
control box). Your assignments take effect immediately after you leave MIDI Map Mode.
Session clips can be mapped to a MIDI key or even a keyboard range for chromatic playing.

MIDI keys and controllers that have been mapped to Live's controls are not available for
recording via MIDI tracks. These messages are filtered out before the incoming MIDI is
passed on to the MIDI tracks.

Session clips, switches, buttons and radio buttons can be mapped to computer keyboard
keys as well. This happens in Key Map Mode (see Keyboard Remote Control), which works
just like MIDI Map mode.

Live offers, in addition to this general purpose mapping technique, dedicated support for
Mackie Control-compatible mixer surfaces (see Mackie Control), which allows for mouse-free
operation of the program.

The Key/MIDI Map
Controls.
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4.14 Saving and Exporting

Saving a Live Set saves everything it contains, including all clips, their positions and settings,
and settings for devices and controls. An audio clip can, however, lose the reference to its
corresponding sample if it is moved or deleted from disk. The links between samples and
their clips can be preserved with a special command, the Save Set Self-Contained command
(see The Sounds Folder and Self-Containing), which makes a copy of each sample and stores
itin a “Sounds” folder along with the Live Set.

A separate Save button in the Clip View saves a set of default clip settings (see Saving
Default Clip Settings with the Sample) along with the sample, so that each time the sample is
dragged into the program, it will automatically appear with these settings. This is especially
useful if you have made warp settings for a clip and want to use it in multiple Live Sets.

Exporting audio from Live can be done from both the Session and Arrangement Views.
Live will export the audio coming through on the Master output as an audio file of your
specifications via Render to Disk (see Exporting Audio).

Live can also export individual MIDI clips as MIDI files (see Exporting MIDI Files).

Exporting and saving material for later use in Live can be done very conveniently with the
Live Clip format. Session View clips can be dragged back out of a Live Set to the File
Browsers, and thereby exported to disk as Live Clips (see Live Clips).
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Live Clips are a very powerful way of storing ideas, as they save not only the clip’s Clip View
settings, but also the corresponding track’s instruments and effects chain. Live Clips in the
Browser can be previewed and added to any open Live Set just like sample files. In the Live
Set, they restore the original clip’s creative options.

Using Live Clips, you can build your own personalized library of:

e MIDI sequences with matching instruments and effects, e.g., a MIDI drum pattern with
the associated Impulse and effects settings;

e Different regions or loops (see Sample Loop/Region and Display) referencing the same
source file;

e Variations of a sample loop created by applying Warp Markers (see Time-Warping
Samples), clip envelopes (see Clip Envelopes) and effects (see Working with Instru-
ments and Effects);

e |deas that may not fit your current project but could be useful in the future.

A Live Clip in the File
Browser.
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4.15 The Library

Live comes with a library of sound ideas that can serve as a starting point for your own
creations.

The first part of the library is a large preset collection for Live instruments and effects,
accessible through the Live Device Browser (see Browsing and Loading Presets).

The second part of the library is accessed via the Library button in the upper right corner of
the File Browser.

3 Ableton + +JZ-

Contant

There are three folders:

e Clipsis a collection of Live Clips that offer a broad stylistic variety of sound ideas. Live
Clips have a very open format and can serve both as a starting point for your own
creations and as a resource for learning new sound design tricks.

e Sets is the default location for Live Sets.

e Waveforms is a repository of samples such as one-shot drum hits and single-cycle
waveforms to be used for sound design purposes, particularly in conjunction with
Live's built-in Simpler and Impulse instruments.

The library is built from several Live Packs (see Live Packs), which can be separately down-
loaded, installed and uninstalled. Live Packs are available from installation CDs or the
Ableton website?.

2http://www.ableton.com/downloads

Browsing the Library’s
Creative Options.
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Chapter 5

Managing Files and Sets

Various types of files are used in making music with Live, from those containing MIDI (see
MIDI Files) and audio (see Sample Files), to more program-specific files such as Live Clips
(see Live Clips) and Live Sets (see Live Sets). This chapter will explain everything you need
to know about working with each of these file types in Live. However, we should first take a
look at Live's File Browsers, through which most files arrive in the program.

5.1 Working with the File Browsers

5.1.1 Browsing the Folder Hierarchy

Files are browsed and imported from disk using Live's on-board Browsers, which can be
pointed to any folder location on the computer. The Browsers can also be searched based

45
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on specific criteria, a topic that we will cover in the next section (see Searching for Files).

Each File Browser can have its own root directory, shown at the top of the Browser, the
contents of which are available for browsing below.

o .

The Browser root can easily be changed: The Folder-Up button moves the Browser root one
step up in the disk hierarchy.

Library

You can also set the Browser root to any folder in the Browser by selecting the folder and
clicking the Root button, double-clicking the folder, or pressing . Note that there are
three File Browsers that you can set up to point to commonly used folders.

L

To set the root of the Browser to Live’s library (see The Library) of clips, Sets and presets, use
the Library button just to the right of the Root button, or the Set Root To Library & (PC)/
& (Mac) context menu command.

Contant

Moving through the files in Live’s Browser can be done with either the mouse or the computer
keyboard:

e Scroll up and down in the Browser with and (¥].

“Library” Is this
Browser’s Root.

The File Browser's
Folder-Up Button.

The File Browser’s Root
Button.

The Library Button.
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e Close and open folders with and PJ.

e Jump to the parent folder of any closed folder using [«. (Hint: If executed on a
top-level folder, this is an alternative to pressing the Folder-Up button, and will move
the Browser root up one level.)

To clean up the Browser, use & (PC)/ [Ctl |8 (Mac) to access the context menu, and
then select the Close All Folders option to show only top-level folders. Double-clicking any
of the three File Browser icons will also close all sub-level folders.

(¢ Library 3 N

: VstPresets
Wawveforms

@ Double-Click These
® Icons to Clean up the
Browser.

Note that you may occasionally want to refresh the Browser if you are working on a network.
Todoso, @ (PC)/ © (Mac) to open the context menu, and then select the Refresh
command.

5.1.2 Searching for Files

Live's File Browsers are equipped with a search function for finding files. Clicking the
Search button in the upper right corner of the Browser or using the (Ctl J{({  ][F] (PC)/
(& 8@ JF] (Mac) shortcut will open the Browser's Search Mode.

- Activating Browser
Search Mode.
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Live will search for the contents typed in the Search field throughout the entire Browser
root. Alternatively, you can search within a single folder in the Browser with the & (PC)/
® (Mac) context menu'’s Search In Folder command.

After entering search criteria, begin the search by pressing on your computer key-
board. Live will find files that contain the search criteria in their name or suffix (e.g., “.wav").

The search results will also include files that contain the entered criteria in any part of their file
path. This means that a search for “bass,” for example, will yield not only files with names
containing the word “bass” but also those located in folders with names containing the
word “bass.” Compressed sample metadata tags are also included in the search, making it
possible to search for songs from a specific album or artist, for example. Searching file paths
and metadata can be deactivated with the Search In Path and Search In Metadata settings,
available in Live's Options menu or via the context menu. The names of MIDI tracks within
multitrack MIDI files are also included in searches.

Note that the first search of any folder will always take longer than subsequent searches, as
Live creates an index of the folder's contents to facilitate efficient searching.

You can abort an in-progress search with the Exit Search button located to the right of the
Search field. A second click on this button closes Search Mode, returning the Browser to
Browse Mode. Beginning a new search aborts any current searches by default.

J
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A useful feature of Live's Browser search function is the Locate In Browser button, found to
the right of the Search field. After finding a particular file in Search Mode, you can select
the file and click this button to open the file in Browse Mode, where its location in the folder
hierarchy will be displayed.

Exiting Search Mode.
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5.1.3 Previewing Files

tips The Preview Switch.

Live allows you to preview files in the File Browser before they are imported into the program.
Previewing is activated using the Browser's Preview switch.

Click on the files (or use and (%)) to select and listen to them.

You can adjust the previewing volume using the Preview Volume knob in the mixer.

™ 1
L

o7

The Preview Volume
Knob.

If your audio hardware offers multiple audio outs, you can privately audition, or cue, files
via headphones connected to a separate pair of outs — while the music continues to play.
To learn how to set up Live for cueing, please refer to the appropriate manual section (see
Soloing and Cueing).

Hint: You can preview files even when the Preview switch is not activated by pressing ).
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5.1.4 Adding Clips from the Browser

There are several ways to add clips to a Live Set:

e Files can be dragged and dropped from the File Browsers into tracks in the Session or
Arrangement View. Dragging and dropping material from the Browser into the space
to the right of Session View tracks or below Arrangement View tracks will create a new
track and place the new clip(s) there.
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e In the Session View, double-clicking or pressing on a file in the Browser will
automatically create a new track to the right of the other tracks and load it with the

clip.
e Files can be dropped directly into Live from the Explorer (Windows) / Finder (Mac).

5.1.5 File Maintenance in the Browser

You can use Live's File Browsers for all of the file maintenance activities that you are familiar
with on your operating system.

e Move files and folders by dragging and dropping, or by copying/cutting and pasting.
Copying, cutting and pasting can be done with either Edit menu commands or key-
board shortcuts (see Editing). A file can be moved from one File Browser to another

Dropping a Clip to
Create a New Track.
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by dragging it over the target Browser's 0] button.

e Rename files and folders using the Edit menu’s Rename command or the (Ctl J[R]
(PC)/ (& $R) (Mac) shortcut. Cancel renaming with the ([Esc ] key.

e Create folders by opening the context menu with & (PC)/ ® (Mac), and then
selecting the Create Folder command.

o Delete files and folders using the Edit menu’s Delete command or your computer’s
Backspace or Delete key. Deleting items within Live moves them to the system trash; if
necessary, you can recover items from the system trash via your computer’s operating
system.

Note that, while you can rename or delete entire MIDI files (see MIDI Files) via the Browser,
this is not possible with the individual MIDI tracks contained within them. This is also the
case with the individual components of Live Sets (see Live Sets).

5.2 Sample Files

A sample is a file that contains audio data. Live can play both uncompressed file formats
(WAV, AIF and Sound Designer Il for Mac) and compressed file formats (MP3, Ogg Vorbis,
Ogg FLAC and FLAC).

A note on using Variable Bit Rate (VBR) files: Please install QuickTime for decoding purposes
if you do not already have it on your system. It can be downloaded from the Apple website!.

As Live plays the samples directly from disk, you can work with a large number of (large)
samples without running into RAM memory limitations.

Live can combine uncompressed mono or stereo samples of any length, sample rate or
bit depth without prior conversion. To play a compressed sample, Live decodes (see The

1 http://www.apple.com/quicktime/download/mac.html
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Decoding Cache) the sample and writes the result to a temporary, uncompressed sample
file. This usually happens quickly enough that you will be able to play the sample right away,
without waiting for the decoding process to finish.

Note: When adding a long sample to a project, Live might tell you that it cannot play the
sample before it has been analyzed. Please see the section on analysis (see Analysis Files
(.asd)) for an explanation.

5.2.1 The Decoding Cache

To save computational resources, Live keeps the decoded sample files of compressed
samples in the decoding cache, a sub-directory of the Audio Record Folder (see Setting up
File Types). Maintenance of the cache is normally not required, as Live automatically deletes
older files to make room for those that are new. You can, however, impose limits on the
cache size using the Misc Preferences’ Decoding Cache section. The cache will not grow
larger than the “Maximum Cache Size"” setting, and it will always leave the “Minimum Free
Space” on the hard disk. Pressing the Cleanup button in the Decoding Cache preferences
will delete all files not being used by the current Live Set.
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Samples
Create Analysis Files

Sample Editor

Library

Library Path

Decoding Cache

Minimum Free Space

Maximum Cache Size

5.2.2 Analysis Files (.asd)

An analysis file is a little file that Live creates when a sample file is brought into the program
for the first time. The analysis file contains data gathered by the program to help optimize
the stretching quality, speed up the waveform display and automatically detect the tempo
of long samples (see Syncing Longer Pieces).

When adding a long sample to a project, Live might tell you that it cannot play the sample
before it has been analyzed. This will not happen if the sample has already been analyzed
(i.e., Live finds an analysis file for this sample), or if the Default Preferences Auto-Warp
Long Samples preference (see Deactivating Warping) has been deactivated. To prevent
waiting for analysis of longer samples, you can pre-analyze them (see File Pre-Analysis) via
the Browser, as we will see in a moment.

An analysis file can also store default clip settings for the sample:

Clicking the Clip View's Save button (see Saving Default Clip Settings with the Sample) will

Preferences for the
Decoding Cache.
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store the current clip’s settings with the sample’s analysis file. The next time the sample is
dragged into Live, it will appear with all its clip settings intact. This is particularly useful
for retaining Warp Marker settings (see Time-Warping Samples) with the sample. Storing
default clip settings with the analysis file is different from saving the clip as a Live Clip, as
described in the relevant section (see Live Clips).

The analysis file’s name is the same as that of the associated sample, with an added “.asd”
extension. Live puts this analysis file in the same folder as the sample.

Samples that have an .asd file are displayed like this in the Browser.

@ Samples without an .asd file look like this.
The analysis files themselves do not appear in Live's Browsers.

Note that you can suppress the creation of .asd files by turning off the Create Analysis Files
option in the Misc Preferences. All data (except for the default clip settings) can be recreated
by Live if the .asd file is missing, however this will take some time for longer samples.

5.2.3 File Pre-Analysis

To avoid waiting for longer samples to be analyzed the first time they are imported into Live,
you may want to pre-analyze them.
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To pre-analyze all the files contained in any folder in the Browser, use the @& (PC)/ 9
(Mac) context menu’s Analyze Audio command. This process can also be cancelled via the
context menu.

5.2.4 Exporting Audio

The File menu’s Render to Disk command allows exporting Live’s Master audio output as a
new sample. The resulting file can be used to burn an audio CD for listening purposes or
a data CD, which could serve as a backup of your work or be used with other digital audio
applications.

Which Signal Will Be Rendered?

Render to Disk will always render the signal at Live's Master output. If you are monitoring
the Master output, you can be sure that the rendered file will contain exactly what you hear.
To export individual tracks, deactivate all tracks other than the ones you want to export by
turning off their Track Activator switches (see The Live Mixer) in the mixer.

Pre-Analyzing Audio
Files.
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When Render to Disk is invoked while the Arrangement View is up, Live will render the
selected time range.

If you would like to render the current Arrangement loop, choose the Select Loop command
from the Edit menu prior to choosing Render to Disk. Keep in mind that the selection of
tracks is irrelevant: The signal to be rendered is the Master output.

If you choose Render to Disk while the Session View is up, Live will ask you to specify the
length of the sample to be rendered. The Render to Disk dialog will come up with a bars-
beats-sixteenths field where you can type in the desired length. Live will capture audio from
the Master output starting at the current play start position for whichever duration you have
specified.

Rendering Options

The Render to Disk command opens a dialog that offers several rendering options:

o Normalize. If this is activated, the sample resulting from the render process will be
normalized (i.e., the file will be amplified so that the highest peak attains the maximum
available headroom).

e Render as Loop. If this is activated, Live will create a sample that can be used as a
loop. For example, suppose your Live Set uses a delay effect. If Render as Loop is on,
Live will go through the rendering process twice: The first pass will not actually write
samples to disk, but add the specified delay effect. As the second pass starts writing
audio to disk, it will include the delay “tail” resulting from the first pass.

e File Type, Bit Depth, Sample Rate. These options specify the type of sample to be
created.

e Create Analysis File. If this is activated, Live will create an .asd file that contains analysis
information about the rendered sample. If you intend to use the new sample in Live,
check this option.
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e Convert to Mono. If this is activated, Live will create a mono file instead of a stereo
file.

5.3 MIDI Files

A MIDI file contains commands that prompt MIDI-compatible synthesizers or instruments,
such as Live's Simpler (see Simpler), to create specific musical output. MIDI files are exported
by hardware and software MIDI sequencers. Importing MIDI files into Live works differently
than with samples: MIDI file data is incorporated into the Live Set, and the resulting MIDI
clips lose all reference to the original file. MIDI files appear as folders in the File Browser;
opening the folders gives you access to the file’s individual tracks (also called “voices” or
“instruments”).

2 MIDI Loops by K... & (% @

BRK_120
Iz‘ BRK-Bass.mid 1 Bass 2 Chora
E BRE-Chord. mid
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[£] eRK olody.mic (B [ owrs
DT 95 [1-[Bass ] [ fthom
> [2] ue-BASS.mid BT
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> [7] DuB-Lead.mid
> [2] DuB-Piano.mid
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HOUSE 120

A MIDI File and Its
Tracks in the Browser.



5.4. LIVE CLIPS 58

5.3.1 Exporting MIDI Files

Live MIDI clips can be exported as Standard MIDI files. To export a MIDI clip, use the File
menu’s Export Selected MIDI Clip command. This command will open a file-save dialog,
allowing you to choose the location for your new MIDI file.

Exporting a MIDI file is different from saving the clip as a Live Clip, as described in the
relevant section (see Live Clips).

5.4 Live Clips

Individual Session View clips can be exported to disk in the Live Clip format for easy retrieval
and reuse in any project.

To save a clip from the open Live Set to disk, simply drag it from the Session View to the File
Browser and drop it into any folder. You can then type in a new name for the clip or confirm
the one suggested by Live with Return’ .

Acoustic
‘ (] Backbeat - 120 - Intro....
[PL] Backboat - 120 - Ride
(B Backbeat - 120 - Side
[E] Backbeat - 120 - Tom
[F] Backbeat - 120 - Upbe
—

Live Clips are a great way of storing your ideas for later use or development, as they save
not only the original clip, including all its clip and envelope settings, but also the original
track’s devices. In order to recreate a Live Clip’s device chain, either import it (see Adding

A Live Clip in the
Browser.
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Clips from the Browser) into a track containing no clips or devices, or drag it into the space
in the Session or Arrangement View containing no tracks. Note that Live Clips that are
imported into tracks already containing devices or clips will appear with their clip settings
but not their devices. You could, for instance, drop a bass line Live Clip on an existing track
that drives a bass instrument rather than creating a new track.

Clips belonging to any Live Sets already on disk are also Live Clips. Please see the section
on importing and exporting Sets (see Importing and Exporting Sets with the Browser) for
more on this topic.

Note that storing default clip settings (see Saving Default Clip Settings with the Sample) with
a sample’s analysis file is different from saving a Live Clip. The default clip in the .asd file
annotates the sample with sensible default values (warp, gain and pitch settings) so that it
will play in a defined way when it is added to a Set. Live Clips, on the other hand, are stored
on disk as separate musical ideas. For example, you could create a number of variations
from the same audio clip by using different warp, pitch, envelope and effect settings, and
store them all as separate Live Clips. In the Browser, you could then independently sort and
preview these clips, even though they are all referring to the same source sample.

5.5 Live Sets

The type of document that you create and work on in Live is called a Live Set.

5.5.1 Creating, Opening and Saving Sets

Use the File menu’s New command to create new Live Sets, and the Open or Open Recent
command to open existing ones. In the File Browser, you can double-click or press
on a Live Set to open it.
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The File menu’s Save command saves the current Live Set exactly as it is, including all clips
and settings.

You can also use the Save As command to save the current Live Set under a different name
and/or in a different directory location, or the Save a Copy command to create a copy of
the current Live Set with a new name and/or new directory location.

Saving a Live Set leaves the samples referenced by that Live Set's clips in their current
locations. If these files are later moved, Live will attempt to help you find them (see Offline
and Lost Files) when next you open that particular Live Set. The File menu’s Save Set
Self-Contained command (see The Sounds Folder and Self-Containing) can help you avoid
missing files altogether.

5.5.2 Importing and Exporting Sets with the Browser

Live Sets can now be opened in the File Browsers, just like standard disk folders, to reveal
their component tracks and clips. Each of the clips belonging to a Live Set is a Live Clip
(see Live Clips).

Library >
Clips
Beats
Acoustic

Elactronic

Sets
d = [B] MySetals
VstPresets

Waveforms

These tracks and clips can be selectively previewed and dragged into the current Set, or
the entire Live Set can be dragged in to merge the two. Dragging a Set into the space to
the right of Session View tracks or below Arrangement View tracks will create new tracks to

A Live Set in the
Browser.
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host the new content, whereas dragging a Set into existing tracks will replace any current
clips. Note that, if a Set is dragged into existing tracks containing clips or devices, its tracks’
corresponding device chains will not be loaded.

You can export a selection of Session View clips as a new Live Set by dragging them to the
File Browser. To export a Set, first click and drag, or use the or (€l ] (PC)/
(Mac) modifiers, to select more than one Session View clip. Then, simply drag the clips to

a folder in the File Browser, where you can either confirm Live's suggested name or type in
one of your own.

5.5.3 Template Sets

Use the Default Preferences’ Template Save button to save the current Live Set as a template.
Live will use these settings as the initialized, default state for new Live Sets. You can use this
to pre-configure:

e Your multichannel input/output setup.

e Preset devices, like EQs and Compressors, in every track.

e Computer key mappings (see Keyboard Remote Control).

e MIDI mappings (see MIDI Remote Control).
The template Live Set “Template.als” is located in Live's Preferences folder and can be

copied or deleted from there. The easiest way to locate this folder is to search your disk for
“Template.als.”
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5.6 Offline and Lost Files

If you load a Live Set or Live Clip that references samples missing from their referenced
locations, Live will issue a warning message and ask whether you want to locate the missing
files.

If you do not, the Live Set or Live Clip will open anyway, with the clips that reference missing
files marked “Offline.” Live will play silence in place of the offline clips.

You can find the missing files by selecting offline clips and clicking the Clip View’s Replace
button (see Replacing the Clip's Sample).

5.7 The Sounds Folder and Self-Containing

The Sounds folder is a Live Set's private location for storing samples. All samples that are
recorded into a Live Set end up in this Live Set’s Sounds folder. Live offers a convenient
method for gathering all the files that are referenced by a Live Set in this folder: When you
choose the File menu’s Save Set Self-Contained command, Live copies all externally refer-
enced files there. After Live has self-contained the files, there will no longer be references
to samples spread over one or more hard drives. You can back up the Live Set along with
its Sounds folder, or send it to collaborators via the Internet, and all files used in the project
will be included.

The Sounds folder for “My Live Set” is called “My Live Set Sounds.” It is located next to (in
the same folder as) “My Live Set.”
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5.8 Live Packs

Live's library (see The Library) is broken down into several Live Packs that can be separately
downloaded, installed and uninstalled. A Live Pack is a single file (much like a ZIP file) that
expands into many files upon installation.

Live Packs are available from installation CDs or the Ableton website?. To install a down-
loaded Live Pack, drag the file into Live, double-click the file, or select Install Live Pack from
the File menu.

A list of all installed Live Packs is kept in the Preferences’ Products tab. You can select
individual Live Packs from the list and click the Uninstall button to remove them.

You can, of course, remove, rename, alter and add to the individual files that come with Live
Packs at will, making someone else’s library your own.

2http://www.ableton.com/downloads
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Chapter 6

Arrangement View

The Arrangement View displays the Arrangement, which contains music laid out along a
song timeline, like a multitrack tape.
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The Arrangement View is a powerful editing tool that easily lets you combine and arrange
musical material of all types: MIDI, loops, sound effects and complete pieces of music.

6.1

Navigation

Live offers several fast methods for zooming and scrolling the Arrangement display:

Bass

. . . - - .
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guitarchord iguitamhurd |gultar~:horu

I w 2 Chords

1. To smoothly change the zoom level, click and drag vertically in the beat-time
ruler at the top of the Arrangement View (you can also drag horizontally to scroll

the display).

2. To zoom in and out around the current selection, use the computer keyboard’s +
and - keys. To “pan” the display, click and drag while holding the [Ctrl
(PC)/ (Mac) modifier.

3. The Arrangement Overview is like a “bird's-eye view" of your music. It always
shows the complete piece, from start to end. The black rectangular outline repre-

Navigating the
Arrangement View.
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sents the part of the Arrangement that is currently displayed in the Arrangement
display below. To scroll the display, click within the outline and drag left or right;
to zoom out and in, drag up and down.

4. To change the displayed part of the Arrangement, drag the outline’s left and
right edges.

5. To see a specific part of the Arrangement in more detail, click on itin the Overview
and drag downwards to zoom in around that part. Note that you can also drag
horizontally to scroll the display. Using this method, you can zoom and scroll to
focus around any part of the Arrangement with just one mouse motion.

6. To have the Arrangement display follow the song position and scroll automati-
cally, turn on the Follow switch, or use the Follow command from the Options
menu.

6.2 Transport

There are a number of ways to control Live's transport with the computer keyboard and
mouse:

1. You can start Arrangement playback by clicking the Control Bar's Play button,
and stop playback by clicking the Stop button. Arrangement playback can also
be toggled on and off by pressing the keyboard's space bar.

, 1. i Elo OVR | =+ | Bar & The Play and Stop

| Buttons in the Control
Bar.

2. You can set the Arrangement playback position by clicking anywhere along the
Arrangement to place the flashing insert marker. Double-clicking the Stop button
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will return the Arrangement play position to 1.1.1.

To continue playback from the position where it last stopped, rather than from
the insert marker, hold down the modifier while pressing the space bar.

. Clicking in the scrub area above the tracks will make playback jump to that point.

The size of these jumps is quantized according to the Control Bar's Quantization
menu setting. While the mouse is held down over the scrub area, a portion of
the Arrangement the size of the chosen quantization setting will be repeatedly
played. With small quantization settings, or a setting of “None,” this allows you
to scrub through the music.

g 17 21 25 29 33 37 41 45 49
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4. The song position can be adjusted numerically using the Control Bar's Arrange-

ment Position fields.
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Arrangement Playback
Begins from the Insert
Marker.

Scrubbing Arrangement
Playback.

Setting the Play Position
in the Arrangement
Position Fields.
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The Arrangement Position fields show the song position in bars-beats-sixteenths.
To change the values:

e Click and drag up or down in any of these fields.
e Click and type a number, then hit Return].
e Click and decrement or increment the value with and (4.

5. Arrangement playback can be started at a particular point in one of your clips
using the scrub area in the Clip View (see Clip View).

6. Several Arrangement playback positions can be set using launchable locators
(see Launching the Arrangement with Locators).

Note that any computer keyboard key or MIDI message can be mapped to the transport
controls, as described in the respective chapter (see MIDI and Key Remote Control).

6.3 Launching the Arrangement with Locators
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Locators can be set at any point in the Arrangement. This can be done in real time during
playback or recording with the Set Locator button, and will be quantized according to the
global quantization value set in the Control Bar. Clicking the Set Locator button when the

Using Locators to
Launch Play in the
Arrangement.
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Arrangement is not playing will create a locator at the insert marker or selection start. You
can also create a locator using the context menu in the scrub area above the tracks or via the
Insert menu. Note that the position of a new locator is quantized according to the Control
Bar's Quantization menu setting.

@ (Se(®)|
| ¥ 2 Chords 2 5

You can recall (jump to) locators by clicking on them, or with the Previous and Next Locator
buttons on either side of the Set button. Locators can also be recalled using MIDI/key map-
ping (see MIDI and Key Remote Control). Note that locator recall is subject to quantization.
Double-clicking a locator will select it and start Arrangement playback from that point.

After jumping to the first or last locator in the Arrangement, the Previous and Next Locator
buttons will jump to the Arrangement start or end, respectively.

Locators can be moved by clicking and dragging, or with the arrow keys on your computer
keyboard.

To name a locator, select it by clicking its triangular marker, and choose the Rename Edit
menu command (or use the (Ctl JR) (PC)/ (& % [R) (Mac) shortcut). Locators can be
removed with your computer's backspace or delete key, the Insert menu, or the Delete
Locator button.

Note that the locator context menu offers a quick way of looping playback (see The Ar-
rangement Loop) between two locators with its Loop To Next Locator command.

The Locator Controls.
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6.4 The Arrangement Loop

111—\_@_/— 4. 0.0

The Control Bar's Loop
Switch.

For Live to repeatedly play a section of the Arrangement, activate the Arrangement loop by
clicking on the Control Bar's Loop switch.

-\— 0d _,- The Loop Start Fields

(Left) and the Loop
Length Fields (Right).

You can set loop length numerically using the Control Bar fields: The left-hand set of fields
determines the loop start position, while the right-hand set determines loop length.

The Edit menu’s Loop Selection command accomplishes all of the above at once: It turns
the Arrangement loop on and sets the Arrangement loop brace to whatever timespan is
selected in the Arrangement.

uitarcho

" Daes

The Arrangement’s Loop
Brace.

The loop brace can be selected with the mouse and manipulated with commands from the
computer keyboard:

. and nudge the loop brace to the left/right by the current grid setting (see
Using the Editing Grid).
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. and shift the loop brace left/right in steps the size of its length.

e The (PC)/ (Mac) modifier used with the arrow left and right keys shortens
or lengthens the loop by the current grid setting (see Using the Editing Grid).

e The (PC)/ (Mac) modifier with the arrow up and down keys doubles or
halves the loop length.

You can also drag the Arrangement’s loop brace: Dragging the left and right ends sets the
loop start and end points; dragging between the ends moves the loop without changing its
length.

6.5 Moving and Resizing Clips

A piece of audio or MIDI is represented in the Arrangement View by a clip sitting at some
song position in one of Live's tracks (see Tracks).

[rhodes | ¥ 3 Rhodes
NN NEEN ¥ 4Perc's
L w & Crash
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Dragging a clip moves it to another song position or track.
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shaker v 4 Perc's

Dragging a clip’s left or right edge changes the clip’s length.

Moving a Clip.

Changing a Clip’s
Length.
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6.6 Selecting Clips and Time

With the exception of moving and resizing clips, Arrangement editing in Live is selection-
based: You select something using the mouse, then execute a menu command (e.g., Cut,
Copy, Paste, Duplicate) on the selection. This editing method lends itself to an efficient
division of labor between the two hands: One hand operates the mouse or trackpad, while
the other hand issues the keyboard shortcuts for the menu commands. The menu eventually
is only used as a reference for looking up the keyboard shortcuts.

Here is how selection works:

Clicking a clip selects the clip;

Clicking into the Arrangement background selects a point in time, represented by a
flashing insert mark;

Clicking and dragging selects a timespan.

To access the time within a clip for editing, “unfold” its track by clicking the triangular
button next to the track name.

melody var A& 1 Audio
tUSIMbeat] A 2 AdeE

Notice that you can adjust the height of the unfolded track by dragging the split line
below the Unfold Track button. Clicking and dragging in the waveform display below
the clip’s horizontal strip allows you to select time within the clip. Note that you can
actually unfold all of your tracks at once by holding down the (PC) /
(Mac) modifier when clicking the Unfold Track button.

Adjusting an Unfolded
Track’s Height.
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e Clicking on the loop brace is a shortcut for executing the Edit menu’s Select Loop
command, which selects all material included within the loop.

¢ Holding Shift while clicking extends an existing selection in the same track or across
tracks.

Clicking the Loop Brace
to Select the Loop for
Editing.

6.7 Using the Editing Grid

To ease editing, the cursor will snap to grid lines that represent the meter subdivisions of
the song tempo. The grid can be set to be either zoom-adaptive or fixed.

You can set the width of both zoom-adaptive and fixed grid lines using the & (PC) /
crl |8 (Mac) context menu available in either the Arrangement View track area or the
Clip View display.

The following shortcuts to Options menu commands allow quickly working with the grid:

e Use [Cul 1] (PC)/ (& 1] (Mac) to narrow the grid, doubling the density of the

grid lines (e.g., from eighth notes to sixteenth notes).

e Use (PC)/ (Mac) to widen the grid, halving the density of the grid
lines (e.g., from eighth notes to quarter notes).
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e Use ([Cl ]3] (PC)/ (Mac) to toggle triplets mode; this would, for instance,
change the grid from eighth notes to eighth note triplets.

e Use (Ctl 4] (PC)/ (G (4] (Mac) to turn grid snapping on or off. When the grid is

off, the cursor does not snap to meter subdivisions.

e Use (PC)/ (Mac) to toggle fixed and adaptive grid modes.

The current spacing between adjacent grid lines is displayed in the lower right corner of the
Arrangement View or Clip View.

6.8 Using the ...Time Commands

Whereas the standard commands like Cut, Copy and Paste only affect the current selection,
their ”... Time" counterparts act upon all tracks by inserting and deleting time.

e Cut Time cuts a selection of time from the Arrangement, thereby moving any audio
or MIDI on either side of the cut area closer together in the timeline. This command
reduces the length of your Arrangement by whatever amount of time you have cut.
Note that the Cut Time command affects all tracks, not only the selected ones.

A Gap Between Clips
Has Been Deleted by
First Selecting it, Then
Executing the Delete

Time Command.

e Paste Time places copied time into the Arrangement, thereby increasing its overall
duration by the length of time you have copied.
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e Duplicate Time places a copy of the selected timespan into the Arrangement, thereby

increasing its overall duration by the length of the selection.

Delete Time deletes a selection of time from the Arrangement, thereby moving any
audio or MIDI on either side of the deleted area closer together in the timeline. This
command reduces the length of your Arrangement by the amount of time you have
deleted. Note that the Delete Time command affects all tracks, not only the selected
ones.

Insert Silence inserts as much empty time as is currently selected into the Arrangement,
before the selection.

6.9 Splitting Clips

The Split command can divide a clip or isolate part of it.

To split a clip in two halves,

1.
2.

3.

unfold the track;

in the waveform or MIDI display, click at the position where you want the clip to
be split;

execute the Split command.

To isolate a part of a clip,

1.
2.

unfold the track;

in the waveform or MIDI display, drag a selection over the part of the clip you
want to isolate;

execute the Split command to divide the original clip into three pieces.
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e — The Result of Splitting a
= = Clip.

6.10 Consolidating Clips

The Consolidate command replaces the material in the Arrangement View selection with
one new clip per track. This is very useful for creating structure.

Consolidating Several
Clips Into a New Clip.




6.10. CONSOLIDATING CLIPS 77

Suppose you have, by editing or improvising, come up with a layout of clips that sound
good in Arrangement Loop Mode (see The Arrangement Loop). Selecting that part of
the Arrangement, for instance by using the Edit menu’s Select Loop command, and then
executing the Consolidate command creates a new clip that can be treated as a loop. You
can now, for instance, drag the clip edges to create more repetitions. You might also want
to drag the new loop via the Session View selector into a Session View slot for real-time
arrangement purposes.

When operating on audio clips, Consolidate actually creates a new sample for every track
in the selection. The new samples are essentially recordings of the time-warping engine’s
audio output, prior to processing in the track’s effects chain and mixer. Hence, the new
sample incorporates the effects of in-clip attenuation, time-warping and pitch shifting, and
of the respective clip envelopes (see Clip Envelopes); however, it does not incorporate the
effects. To create a new sample from the post-effects signal, please use the Render to Disk
command (see Exporting Audio).

The new samples can be found in the “Sounds” folder, a disk location specific to the Live
Set in which you are working. Please see the relevant section of this manual (see The Sounds
Folder and Self-Containing) for more information.



Chapter 7

Session View

In Live’s Arrangement View (see Arrangement View), as in all traditional sequencing pro-
grams, everything happens along a fixed song timeline. For a number of applications, this
is a limiting paradigm:

e When playing live, or when DJing, the order of pieces, the length of each piece and
the order of parts within each piece is generally not known in advance.

e In the theatre, sound has to react to what happens on stage.

e When working along with a piece of music or a film score, it can be more efficient and
inspirational to start with an improvisation, which is later refined into the final product.

This is exactly what Live's unique Session View is for.

78
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7.1 Session View Clips
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The Controls for a
(| Session View Clip.

1. Each clip in the Session View has a triangular button at the left edge. Click the
button with the mouse to “launch” clip playback at any time, or pre-select a clip
by clicking on its name, and launch it using the computer’s key. You can
then move on to the neighboring clips using the arrow keys. Please refer the
manual section on clip launch settings (see The Launch Box) for details on how
to customize this behavior.

2. Click on a square Clip Stop button to stop a running clip, either in one of the
track’s slots, or in the Track Status field below the Session grid.

Clips can be controlled remotely (see MIDI and Key Remote Control) with the computer
keyboard or a MIDI controller. They can even be mapped to MIDI note ranges so that they
play chromatically.

Clips can be played at any time and in any order. The layout of clips does not predetermine
their temporal succession; the Session grid offers random access to the clips it contains.

Notice that, even if you stop playback for a Session View clip, the Play button in the Control
Bar will remain highlighted, and the Arrangement Position fields will continue running.
These fields keep a continuous flow of musical time going, so that you can always know your
position in song time during a live performance or while recording into the Arrangement
(see Recording Sessions into the Arrangement), regardless of what your individual Session
clips are doing.
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You can always return the Arrangement Position fields to 1.1.1 and stop playback for the
entire Live Set by pressing the Control Bar’s Stop button twice.

. 52. 1. 4 ovr 1=
" EI. ovr |ESE) Bar <[ The Arrangement
Position Fields and the

Stop Button.

7.2 Tracks and Scenes

Each vertical column, or track (see Tracks), can play only one clip at a time. It therefore
makes sense to put a set of clips that are supposed to be played alternatively in the same
columns: parts of a song, variations of a drum loop, etc.
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For convenient access to more clips at once, you can resize Session View tracks by clicking
and dragging at the edges of their title bars. Tracks can be narrowed this way so that only
Clip Launch buttons and essential track controls are visibile.
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The horizontal rows are called scenes. The Scene Launch buttons are located in the rightmost
column, which represents the Master track (see Return Tracks and the Master Track). To
launch every clip in a row simultaneously, click on the associated Scene Launch button. This
can be very useful in organizing the live performance of a song with multiple parts.

The scene below a launched scene will automatically be selected as the next to be launched
unless the Select Next Scene on Launch option in the Misc Preferences is set to "Off.”
This allows you to trigger scenes from top to bottom without having to select them first.
Computer keys or a MIDI controller can be used to launch scenes and scroll between them
(see Relative Session View Navigation).

Scenes can be renamed using the Edit menu’s Rename command. One can quickly rename
several scenes by executing the Rename command and using the computer's Tab key to
move from one scene to the next.

Each scene can actually store a tempo setting as part of its name, so that it changes the
project tempo upon launch; this is accomplished by selecting the scene and renaming it
with a viable tempo (e.g., “"96 BPM"). Any tempo can be used, as long as it is within the
range allowed by Live's Tempo control (20-999 BPM).

1 Audic 2 Audio 3 MIDJ 4 MIDJ Masrter

A Session View Scene.

This Scene Will Change
the Tempo to 96 BPM.
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7.3 The Track Status Fields

You can tell a track’s status by looking at the Track Status field just above the active track’s
mixer controls:

'CRX X
MMl
The pie-chart icon represents a looping Session clip (see Sample Loop/Region and Display).

The number to the right of the circle is the loop length in beats, and the number at the left
represents how many times the loop has been played since its launch.

Audio Fram Audio F

The progress-bar icon represents a one-shot (non-looping) Session clip. The value displays
the remaining play time in minutes:seconds.

|

worFrom MIDI From

A microphone icon appears in an audio track that is set to monitor its input (see Monitoring).
A keyboard icon appears in a MIDI track under these same circumstances.

|

Audio From Audio F

A Track Playing a
Looping Session Clip...

... A One-shot Session
Clip...

... Monitoring the
Input...

... Playing the
Arrangement.
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If the track is playing clips from the Arrangement, a miniature display representing the
Arrangement clips being played appears.

7.4 Setting Up the Session View Grid

Clips arrive in the Session View by being imported from the File Browsers (see Adding Clips
from the Browser) or through recording (see Recording New Clips).
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If you are dragging multiple clips into the Session View, Live defaults to arrange them
vertically, in one track. Hold down (PC)/ (Mac) prior to dropping them so as
to lay the clips out in one scene.

Clips can be moved around the Session grid by drag-and-drop. To move several clips
at once, select them by using the (& ]- or [Cul ] (PC)/ (Mac)-modifier before
dragging. You can also click into an empty slot and “rubber-band” select from there. Scenes
can be reordered by drag-and-drop as well.

Dropping Multiple Clips
Into the Session View.
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7.4.1 Select on Launch

By default, clicking a Session View clip’s Launch button also selects the clip, since you will
typically want the Clip View to show the newly launched clip. However, some power-users
don’t want the current focus (e.g., a return track’s devices) to disappear just because a clip
has been launched, especially when starting a clip in order to try it with the return track
device settings. Turn off the Select on Launch option from the Misc Preferences if you prefer
the view to remain as is when you launch clips or scenes.

7.4.2 Removing Clip Stop Buttons

1 Audio 2 Audio 3 Audio 4 MIDyJ

Ji
! IQ

You can add and remove Clip Stop buttons from the grid using the Edit menu’s Add/Remove
Stop Button command. This is useful for pre-configuring the scene launch behavior: If, for
instance, you don’t want scene 3 to affect track 4, remove the scene 3/ track 4 Stop button.

7.4.3 Editing Scenes

There are a number of useful commands in the Edit and Insert menus that apply to scenes:

e Cut Scenes cuts out scenes with selected slots from the Session View, thereby reducing
the total number of scenes. Please note that the Cut Scenes command affects all tracks,
not only those containing selected slots.

Slots Without Clip Stop
Buttons.
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e Paste Scenes works like Paste, but inserts blank scenes before pasting. Live inserts
enough scenes to fit the material from the clipboard. The new scenes will be inserted
behind the current selection.

e Duplicate Scenes works like Duplicate, but inserts blank scenes before pasting. Live
inserts enough scenes to fit the material from the clipboard.

e Delete Scenes deletes all scenes with selected slots from the Session View, thereby
reducing the total number of scenes. Please note that the Delete Scenes command
affects all tracks, not only those containing selected slots.

e Insert Scene inserts an empty scene below the current selection.

e Capture and Insert Scene inserts a new scene below the current selection, places
copies of the clips that are currently running in the new scene and launches the new
scene immediately with no audible interruption. This command is very helpful when
developing materials in the Session View. You can capture an interesting moment as
a new scene and move on, changing clip properties and trying clip combinations.

7.5 Recording Sessions into the Arrangement

Your Session View playing can be recorded into the Arrangement, allowing for an improvi-
sational approach to composing songs and scores.
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Button.
When the Record button is on, Live logs all of your actions into the Arrangement:

e the clips launched;

e changes of those clips’ properties (see Clip View);

e changes of the mixer and the devices' controls, also known as automation (see Record-
ing Automation).

To finish recording, press the Record button again, or stop playback.

B % (5]

Q The Arrangement

Selector.

To view the results of your recording, bring up the Arrangement View. As you can see, Live
has copied the clips you launched during recording into the Arrangement, in the appropriate
tracks and the correct song positions. Notice that your recording has not created new audio
data, only clips.

The Session clips and the Arrangement clips in one track are mutually exclusive: Only one
can play at a time. When a Session clip is launched, Live stops playing back the Arrangement
in favor of the Session clip. Clicking a Clip Stop button causes the Arrangement playback
to stop, which produces silence.
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The Back to
1 Bass 2 Chords 3 Rhodes 4 Perc’s Arrangement Button

Arrangement playback does not resume until you explicitly tell Live to resume by clicking
the “Back to Arrangement” button, which lights up to remind you that what you hear differs
from the Arrangement.

8

. 7] The Stop All Clips
: m | Button.

To disable all Arrangement clips simultaneously, click on the Stop All Clips button in the

Master Track Status field. The clips in the Arrangement and in the Session View exist

independently from one another, which makes it easy to improvise into the Arrangement
over and over again until it's right.

Furthermore, you can move clips not only within the Session grid, but also from the Session
View to the Arrangement and vice versa by using Copy and Paste, or by dragging clips over

the @ or @ selectors.

When pasting material from the Arrangement into the Session View, Live attempts to pre-
serve the temporal structure of the clips by laying them out in a matching top-to-bottom
order. Moving through the scenes from the top down, you can reconstruct the original ar-
rangement. This is useful for taking a composed piece of music back to the improvisational
stage.



Chapter 8
Clip View

The Clip View is where clip properties can be set and adjusted.

Y0 T Clicking the Clip
Overview Opens the

The Clip View is opened by clicking on the Clip Overview or double-clicking a clip in the
Session or Arrangement View.

88
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In the Session View, clicking on a Track Status Field opens the Clip View for editing the clip
that is currently running in the track.

The properties of more than one clip can be edited collectively in the Clip View as a multi-
selection. To create a multi-selection, click and drag to highlight the clips, or select one clip
and use the (Cul | (PC)/ (Mac) or modifiers to add to your selection. The
properties available in the Clip View for a multi-selection depend on the contents of the
clips; generally only properties which the clips have in common are shown.

2 Chords 3 Rhodes 4 Perc's 5 Beats
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Controls such as sliders and knobs behave slightly differently when they are part of a multi-
selection. If the clips in a multi-selection have differing values for any particular knob or
slider parameter (clip transposition, for example), the range of these values will be displayed
and can be adjusted with the control. Dragging the knob or slider to its absolute maximum

or minimum value will make the clips’ settings thereafter identical, adjustable as a single
value.

MIDI clips and audio clips in Live have different sets of properties and, consequently, do
not share the same set of Clip View controls. The two types of clips do have the following
in common:

Clicking a Session View
Track Status Field Opens
the Clip View.

Creating a Clip
Multi-Selection.
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e The Clip box contains basic clip settings.

e The Envelopes box and the Envelope Editor manage the clip’s envelopes, which are
used to modulate the effects, mixer, and clip or MIDI controls. Clip envelopes and
their associated Clip View components are covered in detail in a separate manual
chapter (see Clip Envelopes).

e The Launch box controls clip launch behavior and, as such, only appears for Session
View clips. Setting Session View clip launch properties is covered in detail in a separate
manual chapter (see Launching Clips).

Audio clips have these additional Clip View controls:

e The Sample Display toggles with the Envelope Editor on the right-hand side of the
Clip View, and controls Live's sample-warping capabilities (see Time-Warping Samples)
and clip playback settings (see Sample Loop/Region and Display).

e The Sample box contains settings pertaining to how the clip plays its sample and
displays it in the Sample Display.
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MIDI clips have these additional Clip View controls:

e The MIDI Editor toggles with the Envelope Editor on the right-hand side of the Clip

1-Auwdio

The Clip View for an

Audio Clip.
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View, and allows editing and creating MIDI notes and velocities (see Editing MIDI
Notes and Velocities).

e The Notes box contains settings pertaining to how Live plays a MIDI clip and what it
displays in the MIDI Editor.
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To make best use of the screen real estate, you can show or hide the Launch, Envelopes,
and Sample or MIDI boxes using the Clip View Box selector in the Clips box. You can also
toggle between the Sample Display/MIDI Editor and the Envelope Editor by clicking in the
title bars of the Sample/Notes box and the Envelopes box, respectively.
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Clip.
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8.1 The Clip Box
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The Clip Box.

8.1.1 Clip Activator Switch

Using this switch, you can deactivate a clip so that it does not play when launched in the
Session View or during Arrangement playback. Clips can also be activated/deactivated
directly from the Session or Arrangement View with their (3 (PC) / 8 (Mac) context
menus.

8.1.2 Clip Name and Color

The Clip Name field allows naming the clip. By default, a clip’s name matches the name of
the file it references but, in general, the clip name is independent from the file name.

Renaming an audio clip does not rename the referenced sample file. To rename a file, select
it in Live's File Browsers, and then choose the Edit menu’s Rename command.

The Clip Color chooser allows choosing a clip color.
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8.1.3 Clip Signature

Using the Clip Signature fields, you can specify the signature of an audio clip’s sample. This
setting is relevant only for display; it does not affect sample playback.

8.1.4 Groove

The Clip Groove chooser selects the type of groove used for the clip. “Swing 8,” for
example, applies an 8th-note groove.

AP 1 | .-j-. EX *

The Global Groove control defines the amount of the groove for every clip in the Live Set.

So, how does it work? Imagine a simple one-bar MIDI clip that has a time signature of 4/4.
Our MIDI clip is made up of 8th notes — eight of them — that play either on or between each
of the four beats. With a Clip Groove setting of Swing 8, the timing of our one-bar clip
becomes a bit like a rubber-band that is pinned down at each beat but flexible in between.
The 8th notes that fall between beats can shift slightly forward. With a Global Groove setting
of 50, for example, the notes will wait until 2/3 of the way through the beat to play, where
an 8th-note triplet would normally fall.

16th- and 32nd-note swing works similarly, but on a smaller scale: Every other note shifts
forward, toward the nearest 16th- or 32nd-note triplet position.

Returning to our rubber-band analogy, we can see that Swing 8 can actually affect more
than just 8th notes. Actually, any notes that do not lie directly on a beat will be affected
when the rubber-band is stretched — including 16th and 32nd notes. By the same token,
Swing 16 (where our rubber-band is anchored to positions just an 8th note apart) can affect
32nd notes.

The Control Bar’s Global
Groove Control.
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Groove can be applied to both MIDI clips and audio clips. Applying groove to audio clips
does require that the Warp switch be activated and a Warp Mode (see Adjusting for Good
Stretching Quality) other than Re-Pitch selected. If an audio clip is in Beats Mode, the
Transients setting must be greater than or equal to the Clip Groove chooser’s swing setting
(e.g., with a Transients setting of 1/16, Swing 8 and Swing 16 can be used, but not Swing
32).

Because of this feature’s dependency on note timing, we recommend that you quantize
(see Arranging and Quantizing Notes) MIDI clips prior to applying groove — provided you
want predictable results. For audio clips, any swing contained within the original sample
can be removed by appropriately setting Warp Markers (see Manipulating Grooves) prior to
applying the “artificial” swing of the Groove setting.

8.1.5 Clip Offset and Nudging

To jump within a playing clip in increments the size of the global quantization period, you
can use the Nudge buttons in the Clip box.

ey

These buttons can also be mapped to keys or MIDI controllers (see MIDI and Key Remote
Control). In MIDI Map mode, a scrub control will appear between the Nudge buttons and

Using the Nudge
Buttons to Jump
Through a Clip.
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can be assigned to a rotary encoder wheel for continuous scrubbing.

o
r
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With quantization set to values less than one bar, it is easy to offset clip playback from Live’s
master clock by launching clips, using the Nudge buttons or scrubbing within the clip (see
Playing and Scrubbing Clips).

When clip play is offset from global time in this manner, a little dot will illuminate in the
Sample Display or MIDI Editor to display the offset start position.

The Scrub Control in
MIDI Map Mode.

Clip Offset from Global
Time as Shown in the
Clip’s Display.
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Clip Launch

Using the Keep and
Revert Buttons to
Manage Meter Offset.

The current offset as indicated by the dot can be made permanent by moving the start
marker to the dot’s position - and this is exactly what the Keep button, found just beneath
the Nudge buttons, does. Or, the current offset can be undone using the Revert button.

8.2 The Sample Box

8.2.1 Warp Controls

Sample +*

The Clip Warp Controls.
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When the Warp switch is off, Live plays the sample at its original, “normal” tempo, irrespec-
tive of the current Live Set tempo. This is useful for samples that have no inherent rhythmic
structure: percussion hits, atmospheres, sound effects, spoken word and the like. Turn
the Warp switch on to play rhythmically structured samples (such as sample loops, music
recordings, complete music pieces, etc.) in sync with the current song tempo.

To verify this, note that a warped sample’s speed follows the tempo as you change the
Control Bar's Tempo control.

Live offers a number of controls to adjust the time-warping engine for optimal stretching
quality (see Adjusting for Good Stretching Quality). For accurate warping, Live needs to
know the sample’s metrical structure. For properly prepared loops, tempo and duration
are calculated automatically; most of the time this is accurate enough that the sample is
immediately ready for use in Live. For other samples, you may have to provide some hints
(see Time-Warping Samples).

The Control Bar’s Tempo
Control.
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8.2.2 Sample Loop/Region and Display

Zooming and Scrolling
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The Clip Zoom/Scroll
M T-Audio

Area.

Zooming and scrolling in the Sample Display work much like they do in the Arrangement
View (see Navigation). Using the zoom/scroll area in the top half of the waveform, you can
click and drag vertically to smoothly change the zoom level, and horizontally to scroll the

display.

0-00 020 040

= The Clp Overview

The Clip Overview provides additional zoom/scrolling functionality. It always shows the
complete clip, from start to end. The black rectangular outline represents the part of the
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clip that is currently displayed. You can click within the outline and drag horizontally or
vertically to scroll or zoom.

To have the Sample Display follow the play position and scroll automatically, turn on the
Follow switch, or use the Follow command from the Options menu.
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The Follow Switch.

Playing and Scrubbing Clips

The section of the sample that plays when a clip is launched is set with the clip’s region and
loop controls (see Looping Clips). An unlooped clip will play from its start marker to its end
marker or until it is stopped.
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The Clip Start and End

Markers.

These markers can be clicked and dragged to new positions in the Sample Display, or they
can be moved with the and keys. To move the entire clip region (i.e., both the start
and end markers), select the start marker, hold down (£ 7, and use the arrow keys.
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Using Clip Start and End
Controls to Change Clip
Length.

You can also adjust the clip start and end numerically using the respective value fields to
the left of the Sample Display. For warped clips, these fields display values as bars-beats-
sixteenths; for unwarped clips, the display is in minutes-seconds-milliseconds. Notice that
you can use the “Set” buttons here to place the markers during playback. Setting markers

this way is quantized according to global quantization.

Clicking in the scrub area in the lower half of the waveform or above the beat-time ruler will

make clip playback jump to that point.

The Clip Scrub Area.
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The size of this jump is quantized by the global quantization setting, which can be quickly
changed using the (Ctl_J{6) (PC)/ (& ¥6) (Mac), (7], B), @) and (0] shortcuts. While
the mouse is held down over the scrub area, a portion of the clip the size of the chosen
quantization setting will be repeatedly played. With small quantization settings, or a setting
of “None,” this allows you to scrub through the music.

Looping Clips

To have the clip play as a (potentially infinite) loop, turn on the Loop switch. Note that
the Warp switch must be activated before the Loop switch is accessible, as unwarped clips
cannot be looped.

You can click and drag to change the position and length of the loop brace in the Sample
Display, or you can type exact values into the Loop Length and Position fields to the left of
the display.

Loop
Position (S&l)

[dfgd

Length (S&)

[0l o[ 57]

The loop brace can be selected with the mouse and its position changed with commands
from the computer keyboard:

. and nudge the loop brace to the left/right by the current grid setting (see
Using the Editing Grid).

The Clip Loop Controls.
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. and shift the loop brace left/right in steps the size of its length.

o [Ctl ]« (PC)/ (& I (Mac) shortens or lengthens the loop brace by the
current grid setting (see Using the Editing Grid).

. (PC)/ (Mac) doubles or halves the loop length.

Regardless of the position of the loop brace, clip play upon launch will begin at the position
marked by the start marker, which means you can set up the clip to run into a loop.
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The Loop Length and Position fields are equipped with Set buttons, which can be used to
create loops spontaneously during playback:

e Playing the clip and then clicking the Set Loop Position button moves the beginning
of loop to the current playback position (rounded to the global quantization setting)
and engages the loop. Then, clicking the Set Loop Length button moves the end of
the loop to the current playback position. This lets you capture the music in a loop on
the fly.

e While the loop is still off, you can click the Set Loop Length button to set the loop
to end at the current playback position without changing its preset length. This
simultaneously activates looping.

Setting the Clip to Run
Into a Loop.
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The Set buttons, the Loop switch, the loop brace and the start/end markers can all be
mapped to MIDI controls (see MIDI and Key Remote Control). You could, for example, use
a rotary encoder to move the loop through a sample in increments the size of the chosen
quantization interval.

8.2.3 Clip Pitch and Gain

Sample +

Transpose

The Transpose control shifts the clip pitch in semitones.
The Detune field fine-tunes the clip in cents (100 cents = one semitone).

The Clip Gain slider, calibrated in dB, changes the clip gain.

8.2.4 Destructive Sample Editing

Sample

The Clip Pitch and Gain
Controls.

The Launch Sample
Ediitor Button.
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The Launch Sample Editor button opens the sample in a sample editing application, as
specified in the Misc Preferences. To process a sample in an external program, you will have
to stop Live's playback. Upon returning to Live, the edited version of the sample will be
played back. The current set of Warp Markers is retained only if the sample length remains
the same as before. Remember that changes to one sample may affect other clips playing
the same sample.

8.2.5 Replacing the Clip’s Sample

To replace the sample referenced by the clip with a different sample, drop the new sample
directly from the File Browser into the Clip View. Clip settings like pitch and volume will
be retained. The Warp Markers will be retained only if the new sample has the exact same
length as the old sample.

Tip: When bringing multitrack audio from another program into Live for remixing, it is
convenient to set Warp Markers for only one of the composite samples and copy the same
set of Warp Markers to the other tracks. This can be easily done provided the individual
samples have the exact same length (which usually is the case if they all have been exported
from several tracks in one go): Pick the sample with the clearest rhythmical pronunciation and
set the Warp Markers for this sample as described elsewhere (see Time-Warping Samples).
Next, make enough copies of this clip to hold all the individual samples, and drop the
samples from the Browser into the clips. The Warp Markers will be retained, because the
samples all have the same length.

Sample

The Replace Sample button is for replacing a sample throughout the entire Live Set. All clips
that reference the “old” sample will reference the “new” sample, which is selected using a

The Replace Sample
Button.
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file-chooser dialog. Live retains the clip properties; the Warp Markers (see Time-Warping
Samples) are kept if the new sample has the same or a greater length as the old sample
and discarded otherwise. This function is also useful for locating missing samples that are
marked “offline” (see Offline and Lost Files).

8.2.6 Saving Default Clip Settings with the Sample

Sampile

The Save Default Clip button saves the current clip’s settings with the sample. Once saved,
Live will restore the current clip settings whenever you drop the sample into a Live Set. This
is especially useful with regards to the Warp Markers, which have to be set correctly for
Live to play long files in sync. Note that you can use the Save button without affecting any
existing clips; Save just saves default settings for future clips using this sample.

The clip data becomes part of the analysis file (see Analysis Files (.asd)) that accompanies
the sample.

Note that storing default clip settings with the sample is different from saving the clip as a
Live Clip (see Live Clips), which also saves devices and device settings.

The Save Default Clip
Button.



8.2. THE SAMPLE BOX 106

8.2.7 High Quality Interpolation

Sample

I.‘ S |[RAM The High Quality Switch.

If the High Quality switch is on, Live uses an advanced sample-rate conversion algorithm that
provides better sound quality at the expense of a higher CPU load (see Managing the CPU
Load). Samples processed with the Hi-Q algorithm generate less distortion, particularly
at high frequencies, when transposing a sample and/or matching an imported sample’s
sampling rate to the system’s sampling rate. Note: This feature involves only sample rate
conversion, not the time-stretching quality. There are dedicated controls for adjusting the
stretching properties (see Adjusting for Good Stretching Quality).

8.2.8 Clip Start and End Fades

Sample

s The Clip Fade Switch.

The Clip Fade switch, when enabled, applies a short fade to the clip start and end to avoid
clicks at the clip edges. The length of the fade is signal-dependent and ranges from 0-4
milliseconds.
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8.2.9 Clip RAM Mode

Sample

Al

If the RAM Mode switch is on, Live is loading the audio referenced by the clip into the
computer’s memory rather than reading it from disk in real time. RAM Mode can help with
these problems:

e Your computer’s hard disk is too slow to deliver audio for as many tracks as desired
in real time. For more information on disk-related problems, please refer to the
respective section (see Managing the Disk Load).

e You are experiencing audio dropouts when playing clips in Legato Mode (see Legato
Mode).

Use RAM Mode with care, as RAM is usually a scarce resource. Your computer is using the
hard disk for swapping out RAM contents that have not been used in a while. The more
clips you are running in RAM Mode, the higher the likelihood for them to be swapped
out. Live can handle disk overloads more gracefully than swapped-out audio arriving late:
Disk overloads result in unwanted mutes, whereas RAM overload results in both mutes and
rhythmical “hiccups.”

The RAM Mode Switch.



8.2. THE SAMPLE BOX 108

8.2.10 Reversing Samples

Sample

b

This function creates a new sample by reversing the sample referenced by the current
clip. It then reapplies the old clip’s settings (according to some rules that we will explainin a
moment), and replaces the original sample with the reversal in the Clip View. The new sample
is stored in your temporary recording folder until you save your Live Set, at which point it is
moved to your Sounds folder (see The Sounds Folder and Self-Containing). The reversed
sample has an “R” appended to the end of its name so that it is easily distinguishable from
the original.

There are a few rules for the reversing process. First, any Warp Markers (see Time-Warping
Samples) will remain fixed to their positions in the sample. This means that a Warp Marker on
the downbeat of the second bar of a clip will end up on the downbeat of the second-to-last
bar after reversal. Clip loop/region settings are similarly flipped. Second, clip envelopes
(see Clip Envelopes) remain fixed to their position in time. Therefore, a mixer volume
envelope that lowers the volume of the first half of a clip will continue to do exactly that
after reversal.

The reversal process is quite fast (about as fast as copying), but for very long samples it might
take a little time. When this is the case, the Status Bar in the lower portion of the Live screen
will give you a progress display, and further actions in the program will be temporarily locked
(though running clips will continue to play). You can play the reversed clip and perform other
actions in the program as soon as Live begins to draw the new waveform into the Sample
Display. Once a sample is reversed, a link to the reversed sample will be maintained until the
you quit the program, and reversing the same clip again (or a copy) will be instantaneous.

It is not recommended that you reverse clips in a live performance situation, as a slight glitch

The Reverse Button.
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can sometimes occur while Live reapplies the warp and loop settings.

8.3 The Notes Box
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The Notes Box.

8.3.1 Tempo Controls

The “Orig. BPM" field displays Live’s interpretation of the tempo at which the clip’s MIDI
was recorded. When dragging up or down in the Original BPM field, or clicking the :2 and
*2 buttons, you will see that the notes in the MIDI Editor are correspondingly stretched
or compressed. This is useful for aligning notes that you have recorded without a tempo
reference, like Live's metronome (see Recording in Sync).

8.3.2 Bank and Program Change

Live can send MIDI bank/program change messages to external devices. According to the
settings in these controls, launching a clip also sends its bank/program change message. If
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you are using Live to send MIDI to your synth, this means that each MIDI clip in your Live
Set can play a different sound on your synth. Live offers messages for 128 banks with 128
sub-banks, each of which has 128 programs. Please see the documentation that came with
your synthesizer to determine how many of these messages it can use. If you do not want
your clip to send program or bank change messages, simply set the bank/program choosers
to “None.”

8.3.3 MIDI Loop/Region

These controls manage how the contents of a MIDI clip are played and shown in the MIDI
Editor. They work the same way as those for audio clips (see Sample Loop/Region and
Display).

In the MIDI Editor, the zoom/scroll area is located above the beat-time ruler, the scrub area
just below.

8.4 Clip Defaults and Update Rate

You can change the rate at which Live applies your Clip View settings to a running clip. Clip
View changes will be quantized by the rate selected from the Clip Update Rate chooser in
the Misc Preferences.

Certain clip settings, such as Launch Mode and Warp Mode, can be set up as defaults for
all new clips. This is done in the the Default Preferences.



Chapter 9

Tempo Control and Warping

Unlike music stored on tape or in a traditional digital audio workstation, the music in Live
remains “elastic” at all times. Live is capable of time-warping samples while streaming them
from disk so as to synchronize them to the current project tempo. This happens without
affecting the pitch, which can be changed independently. Mixing and matching audio from
different origins is therefore extremely easy.

9.1 Tempo
9.1.1 Setting the Tempo
AP | + 3 k- O | EX b

111

The Control Bar’s Tempo
Field.
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The Control Bar's Tempo field allows you to change the playback tempo of your Live Set
at any time, in real time. You can even automate the tempo (see Editing the Tempo
Automation) to create smooth or sudden tempo changes along the song timeline.

You can have an external sequencer (or drum machine) play along with Live or have Live play
along with the sequencer. The respective settings are made in the MIDI Preferences, and
the EXT switch next to the tempo control is activated to have Live follow an external MIDI
clock source. Please refer to the section on synchronization (see Synchronizing via MIDI) for
details.

9.1.2 Tapping the Tempo

. - : . . — -

You can use Live's Tap Tempo function to set the tempo at any time. As you click the Control
Bar's Tap Tempo button once every beat, the tempo of the Live Set will follow your tapping.

Il MiD 3%

It's better to assign the Tap button to a computer key than using the mouse. Click on the
Control Bar's KEY switch to enter Key Map Mode; then select the Tap button; press the key
you would like to use for tapping; click the KEY switch again to leave Key Map Mode. The
assignment will take effect immediately. The Tap button can also be assigned to a MIDI
note or controller, like a foot switch, in a similar fashion (see MIDI and Key Remote Control).
Although Live responds to your tapping immediately, it does apply some degree of inertia
to prevent sluggish behavior in the software. The more taps Live receives in a row, the more
precisely it will be able to conclude the desired tempo.

The Tap Button.

The Key Map Mode
Switch.
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You can also use tapping to count in: If you are working in a 4:4 signature, it takes four taps
to start song playback at the tapped tempo.

9.2 Time-Warping Samples

Live's ability to play any sample in sync with a chosen tempo is a unique and important
feature. In addition, you can “warp” the rhythmic flow of a piece, changing its “feel,” or
even move notes to other meter positions.

Think of a sample as a rubber-band that you want to pin to a (musical time) ruler. In Live,
the pins are called Warp Markers. A Warp Marker forces the software to arrive at a specific
point in the sample at a specific musical time. You can use any number of Warp Markers to
create an arbitrary mapping of the piece’s inherent rhythm to a musical meter.

Warp Markers are set in the Clip View's Sample Display by double-clicking any of the gray
grid markers. They can then be dragged or moved with the arrow keys to different positions
in the clip. Warp Markers are deleted with the keyboard’s Backspace or Delete key.

Double-Clicking a Grid

Marker Creates a Warp
Marker.

When working with your sample, you can have Live scroll the Sample Display to follow
playback. Use the Control Bar's Follow switch to activate this feature. It also might be
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helpful to vertically resize the Sample Display by dragging on the split line between the Clip
View and the Session View track area.

: 2/ B @ | OvR | S« | 72T &

In the following sections, we will look at a couple of applications for time-warping samples.
Warping is, of course, an optional feature, and you have several different options for de-
activating warping, as described in the respective section in this chapter (see Deactivating
Warping).

Note: For a tip on how to apply the same set of Warp Markers to several multitrack samples,
please see here (see Replacing the Clip’s Sample).

Of course, your Warp Markers will be saved with the Live Set. In addition, you probably
want to save them with the sample, so that they are reconstructed the next time you drag
the file into Live. To do this, click the Clip View’s Save button (see Analysis Files (.asd)).

9.2.1 Syncing Straight Loops

When you import a sample that represents a well-cut musical loop of 1,2,4 or 8 bars in
length, Live usually makes the correct assumptions to play the loop in sync with the chosen
tempo. It places two Warp Markers, one at the sample’s beginning and one at the end.

The Follow Switch in the
Control Bar.
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1.1.3 12 123 13 1.33 14 143

A One-Bar Loop as It
Appears in the Clip
View, by Default.

The “Orig. BPM" field displays Live’s guess of the loop’s tempo; if you happen to know the
tempo of the loop, you can type it in here. Sometimes Live's guess of the original tempo
is wrong by half or double. If so, correct this by clicking on the buttons labeled *2 and
:2, respectively. The sample plays at double speed when you press :2 because you are
changing Live’s interpretation of the sample’s tempo, which serves as a point of reference
for determining the required time-stretch factor.

9.2.2 Syncing Uncut Loops

When importing a loop that has not been edited into a well-cut loop, Live will play it out of
sync. Suppose there is a portion of silence at the sample beginning, prior to the first beat.
You can easily correct this by moving the Warp Marker labeled with a “1” to the first beat’s
onset. Likewise, you can eliminate silence after the actual loop end by moving the Warp
Marker at the sample’s right edge.
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9.2.3 Syncing Odd-Length Loops

If you import a sample that contains a seven-bar loop, Live initially assumes the loop is eight
bars long (or four, depending on its length) and plays it out of sync. For correct playback,
the last marker needs to show a eight, not a nine. To achieve this do the following:

1. Double-click on the last Warp Marker to delete it.
2. Double-click on the eight to create a new Warp Marker.
3. Drag the new Warp Marker to the sample end.

If Live’s initial guess had been a four-bar loop, the eight would not have been accessible. In
that case, you could initially drag the Warp Marker at the end toward the left until the eight
became visible.

Theoretically this should have done the job for our seven-bar loop. Practically, though, it is
very likely that moving the markers led to a change of the loop start and end points. This
is because the loop is tied to the meter grid and therefore moves with the Warp Markers,
which define the meter grid. Live makes sure the loop fits in the sample, and therefore has
to change its length if required by a Warp Marker change.

Setting the Warp
Markers for a Badly Cut
Loop.
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9.2.4 Manipulating Grooves

You can now create any number of Warp Markers by double-clicking on one of the gray
grid markers. Drag in a “straight” looped sample, set a few Warp Markers, and move them
around to see what happens. Warp Markers really serve two purposes:

1. to provide a “correct” interpretation of the flow of musical time in the sample;
2. to mess up the flow of time in the sample.

If a single event in a percussion loop comes late, just pin it to the Warp Marker, which shows
the beat position at which you actually want to hear that event. You may want to pin the
adjacent beat positions as well, to avoid affecting neighboring regions in the sample.

12 78 7 |23 3 32 33 34 P

“Removing” a sample’s natural groove by applying Warp Markers is an interesting creative
method, particularly in conjunction with Live's ability to impose an artifical groove onto clips
in real time (see Groove).

Using Warp Markers to
Manipulate the Groove.
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9.2.5 Syncing Longer Pieces

Live's Auto-Warp algorithm makes longer samples and entire songs readily available for
integration into your project. You can use the Browser (see Adding Clips from the Browser)
to import long samples or MP3, Ogg Vorbis, Ogg FLAC and FLAC files.

When you drag a file into Live that is too long to justify the assumption that it is a loop or a
one-shot, Live will auto-warp the clip by default (though this can be changed in the Default
Preferences (see Deactivating Warping)).

Note that, for the auto-warp mechanism to work, files which are being imported into the
program for the first time will need to undergo a first-time analysis process (see Analysis
Files (.asd)) and will not be immediately available for playing or editing. As explained in the
section in this manual on analysis files, analysis can be batch-processed with the 3 (PC) /
8 (Mac) context menu'’s Analyze Audio command. Once analysis is finished, you can
view the results of Auto-Warp's assumptions about the file.
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As long as Auto-Warp made the correct set of informed guesses, the clip will be ready to
play in perfect sync with Live's project tempo. However, if Auto-Warp does not quite do
what you want, you can control its results. The remainder of this section will focus on various
ways of guiding Live’s auto-warping. Remember that the metronome in the Control Bar will

Auto-Warp’s Results in
the Clip View.
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probably come in handy as you warp longer pieces.
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The Metronome Switch.

It might happen that Auto-Warp guesses the tempo correctly but gets the downbeat wrong.
To remedy this, you can do the following:

e Zoom in and drag the 1.1.1 marker to the desired position;

o Use the start marker's @ (PC)/ ® (Mac) context menu to select the Set 1.1.1
Here command.

Set 1.1.1 Hera

Warp From Here
Warp From Here (Start Al 129.00 BPM)
Warp From Here (Straight)

Warp 129.00 BPM From Here

Warp Ag 256-Bar Loop

o
Wobritl

Using the Context Menu
to Direct Auto-Warp.

Directing Auto-Warp is also relatively simple when you have imported a perfectly cut loop.
You can tell Auto-Warp to work accordingly using the Warp As ...-Bar Loop command. Live
will propose a loop length that makes the most sense given the current project tempo.
Decreasing the project tempo can, for instance, lead Live to assume the loop is 8 bars at 90
BPM instead of 16 bars at 180 BPM.

Sometimes more detailed control of Auto-Warp is necessary. The best way to go about
warping a clip that requires more detailed attention is in sections, working gradually from
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left to right. You can set a Warp Marker by double-clicking one of the gray grid markers to
the right of each correctly warped section, “pinning” it into place. The shortcuts for working
with the clip loop brace and start/end markers (see Sample Loop/Region and Display) can
speed up this process considerably. You might also find it helpful to select multiple Warp
Markers for moving by appending to your selected Warp Marker with the or (Cul
(PC) / (Mac) modifiers held down.

The four “Warp From Here” commands provide various ways of resetting Warp Markers to
the right of the selected grid or Warp Marker, leaving Warp Markers to the left untouched.
These commands are also available from the start marker.

o Warp From Here runs the Auto-Warp algorithm on the material to the right of the
selected marker.

e Warp From Here (Start At ...) directs Auto-Warp to use the project tempo as a starting
point for tempo tracking. The strategy here is as follows:

1. Deactivate the Warp switch for the clip and play it (or the section in question)
unwarped;

2. Use the Control Bar's Tap Tempo button to tap along and set the project
tempo to match that of the clip;

3. Turn warping on again and use the Warp From Here (Start At ...) command
to tell Auto-Warp to use your tapped tempo and warp from there.

e Warp From Here (Straight) tells Auto-Warp that this is a clip with no tempo variations,
i.e., an electronically produced piece. Auto-Warp will therefore set a single Warp
Marker according to its guess about the original file’s tempo.

e Warp ... BPM From Here will also set only a single Warp Marker, but in this case, Auto-
Warp is forced to interpret the piece as exactly matching the project tempo. This is
useful in cases when you happen to know the exact BPM value of an electronically
produced piece and can type it into the Control Bar before warping.
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Of course, your Warp Markers will be saved with the Live Set. In addition, you probably
want to save them with the sample, so that they are reconstructed the next time you drag
the file into Live. To do this, click the Clip View's Save button (see Analysis Files (.asd)).

Note that, if a sample has a saved set of Warp Markers (see Saving Default Clip Settings
with the Sample), Auto-Warp will have no effect. When this is the case, you can use any of
the O (PC)/ (Ctl_ 18 (Mac) context menu commands described in this section to initiate
auto-warping.

9.3 Adjusting for Good Stretching Quality

Live offers a number of time-stretching methods to accommodate all sorts of audio material.
The time-stretching method, and additional controls for each method, are set up in the Clip
View's “Warp” box.

The Warp Modes are different varieties of granular resynthesis techniques. Granular resyn-
thesis achieves time compression and expansion by repeating and skipping over parts of
the sample (the “grains”). The Warp Modes differ by the selection of grains, as well as by
the details of overlapping and crossfading between grains.

Let's investigate which Warp Modes work best for different types of signals and how to
adjust the warping controls for “clean” stretching. It's also fun to “misuse” these controls
to achieve interesting artifacts instead of correct stretching.

9.3.1 Beats Mode

Beats Mode works best for material where rhythm is predominate (e.g., drum loops as well
as most pieces of electronic dance music). The granulation process is optimized to preserve
transients (attacks, note onsets) in the audio material.
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Use the Transients control to guide Live's assumptions about where to find transients in
the waveform. If there is no rhythmical activity at odd 16th notes, choose 8th, etc. For
some interesting rhythmic artifacts, choose large transient values in conjunction with pitch
transposition.

9.3.2 Tones Mode

Tones Mode serves well for stretching material with a more or less clear pitch structure, such
as vocals, monophonic instruments and basslines.

Grain Size provides rough control over the average grain size used. The actual grain size
is determined in a signal-dependent way. For signals with a clear sense of pitch contour, a
small grain size works best. Larger grain sizes help avoid artifacts that can occur when the
pitch contour is unclear, but the tradeoff can be audible repetitions.

9.3.3 Texture Mode

Texture Mode works well for sound textures with an ambiguous pitch contour (e.g., poly-
phonic orchestral music, all sorts of noise, atmospheric pads, etc.). Italso offers rich potential
for manipulating all kinds of sounds in a creative way.

The Grain Size control determines the grain size used; unlike in Tones Mode, this is a setting
that Live will use unaltered, without factoring in the signal’s characteristics.

Fluctuation introduces randomness into the process. Larger values give more randomness.

9.3.4 Re-Pitch Mode

In Re-Pitch Mode, Live doesn’t really time-stretch or compress the music; instead, it adjusts
the playback rate to create the desired amount of stretching. In other words, to speed
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up playback by a factor of 2, it's transposed up an octave. This is like the “DJ stretching
method” of using variable-speed turntables to sync two records, or what happens to samples
in samplers when they're transposed.

The Transpose and Detune controls have no effect in Re-Pitch Mode.

9.3.5 Complex Mode

Complex Mode is a warping method specifically designed to accommodate composite
signals that combine the characteristics covered by other Warp Modes; it works well for
warping entire songs, which usually contain beats, tones and textures.

Complex Mode is a rather CPU-intensive function, using approximately ten times the CPU
resources required by the other Warp Modes. As such, you may want to freeze tracks (see
Track Freeze) where Complex Mode is in use or record (see Recording New Clips) the results
as a new clip to use as a substitute.

9.4 Deactivating Warping

You can direct Live's assumptions about new samples using the Default Preferences. If the
Auto-Warp Long Samples preference is on, Live assumes that long samples contain music
that should be played in sync with the project tempo. If you would rather have Live default
to playing long samples as they are, disengage this preference.

Regardless of how Live interprets new samples by default, you can always override these
decisions on a per-clip basis by toggling the Clip View’s Warp switch.
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Editing MIDI Notes and Velocities

A MIDI clip in Live contains notes and controller data for playing a MIDI instrument. This
instrument can be a virtual instrument in a MIDI track’s device chain (see Working with
Instruments and Effects) or an external synth fed via the track’s output routing (see Routing
and 1/O). The MIDI clip (see MIDI Clips and MIDI Files) provides the device with a musical
score to play, specifying note pitch, length, position and dynamics (referred to as velocity in
the MIDI lexicon). MIDI is composed and edited in Live’s MIDI Editor.

10.1 Creating an Empty MIDI Clip

MIDI clips are created
e by means of recording (see Recording New Clips);

e or by double-clicking an empty Session slot in a MIDI track;

124
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e or by selecting an empty Session slot in a MIDI track and choosing the Insert menu’s
Insert MIDI Clip command;

e or, in the Arrangement View, by selecting a timespan in a MIDI track and choosing the
Insert menu’s Insert MIDI Clip command.

10.2 The MIDI Editor

To bring up the MIDI Editor, double-click a MIDI clip to open the Clip View. You can use the
Clip View Box selector to make sure the Notes box (see The Notes Box) is showing, then
click in the title bar of the Notes box to bring up the MIDI Editor on the right-hand side of
the screen.

Clip Nofes -+

The MIDI Editor.

The MIDI Editor is comprised of two editing windows: the upper Note Editor and the lower
Velocity Editor. You can resize the Velocity Editor by dragging on the split line that runs
between it and the Note Editor. You can also show and hide the Velocity Editor using the
triangular button on the left-hand side of the split line.
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Switch to Draw Mode by activating the Control Bar's Draw Mode switch. You can now draw
MIDI notes into the Note Editor with the mouse. Deactivating Draw Mode allows notes to
be selected and moved around by clicking and dragging, either vertically to change their
transposition, or horizontally to change their position in time.

Provided your MIDI track’s device chain contains an instrument (see Working with Instruments
and Effects), activating the Preview switch in the MIDI Editor allows you to hear notes as you
select and move them.

Note velocity is adjusted in the Velocity Editor, by clicking and dragging on the associated
markers. You can also use Draw Mode in the Velocity Editor: It will draw identical velocities
for all notes within a grid “tile.”

After drawing a few notes and moving them around, you will probably want to know how to
get around in the Note Editor. So, before we get into detailed editing information, we will
first explain MIDI Editor navigation.

The Control Bar's Draw
Mode Switch.

Previewing MIDI Notes.



10.3. MIDI EDITOR NAVIGATION AND TRANSPORT 127

10.3 MIDI Editor Navigation and Transport

Notes + F 1 2 3 4

: Note Scale Position Is
} Shown Vertically and
- Beat-Time Horizontally.

The MIDI Editor has both vertical and horizontal navigation. Along the horizontal axis lies
a time ruler, which shows note position along a musical timeline. The vertical axis contains
both the note ruler, displaying octaves CO-C10, and a representation of a piano keyboard
(the piano roll). Note that if the Preview switch at the top of the piano roll is activated, you
can listen to the results of your piano roll playing.
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. To smoothly change the time-zoom level, click and drag vertically in the time

ruler. Drag horizontally in the time ruler to scroll from left to right.

Click and drag vertically in the note ruler to change which octaves are shown,
or drag horizontally to change the vertical zoom size of MIDI notes and the
keyboard.

Click and drag over one or more notes to define a selection. Then, double-click
on the note ruler to automatically zoom in on your selection. If no notes are
selected, double-clicking the note ruler will zoom in on the area from the lowest
to the highest note in the clip.

To zoom in and out around the current selection, use the computer keyboard'’s
+ and - keys.

The Clip Overview just beneath the MIDI Editor can also be used for navigation.
It always shows the complete contents of the selected MIDI clip. The black
rectangular outline represents the part of the clip that is currently displayed in
the Editor above. To scroll, click within the outline and drag left or right; to zoom
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MIDI Editor Navigation.
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in and out, drag up and down.

6. Change the length of what is shown in the Editor by dragging the left or right
edges of the outline in the Clip Overview.

7. To quickly change what is shown in the Editor, click on a section that you want
to examine in the Clip Overview, then drag downwards to zoom in, or scroll by
dragging left and right.

8. The Page Up and Page Down keys on your computer keyboard scroll the Note
Editor vertically. The (Ctrl (PC) / [& % (Mac) modifier will change this to
horizontal scrolling.

F 3 2/ B|®|OvR | S+ | 1527 &

The Control Bar's Follow

Switch.
The area displayed in the Note Editor can be set to scroll with playback using the Follow
switch from the Control Bar.
]
|
=
|
e The MIDI Clip Scrub
=
— Area.

You can click in the scrub area just below the beat-time ruler to start playback from that
point, rounded by the global quantization setting. Learning about the loop/region controls
(see MIDI Loop/Region) and associated shortcuts can also be helpful in getting around in
the MIDI Editor and playing selections quickly and easily.

As you work with MIDI, you may find yourself needing extra screen space. You can click and
drag vertically on the window split between the Session or Arrangement View and the Clip
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View to enlarge the MIDI Editor.
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10.4 Editing MIDI

10.4.1 Non-Destructive Editing

130

You can always return your MIDI clip to its previous state by using the Edit menu’s Undo
command. Furthermore, if the MIDI clip being edited originated in a MIDI file on your hard
drive, none of your editing will alter the original MIDI file, as Live incorporates its contents

into your Live Set when importing.

10.4.2 Folding and Looping

An important feature of the MIDI Editor is the Fold button, located in the upper left corner.
Activating this button will immediately hide all rows, or key tracks, that do not contain
MIDI notes. This is very useful when working with percussion kits, for example, which are
oftentimes mapped out along a keyboard in sections corresponding to percussion type

Enlarge the MIDI Editor
by Dragging the
Window Split Between
Session and Clip Views.



10.4. EDITING MIDI 131

(e.g., snares grouped together two octaves down from hi-hat cymbals, etc.). When working
with a MIDI file created by such a mapping, sometimes only one or two of each type of
percussion sound is used, and it becomes unnecessary to view the entire keyboard range.

L
L
-_— o
= 3 | =3 =
When editing MIDI, you might find that you want to change which part of the clip you are
listening to, or loop the clip in order to listen to it repeatedly. You can use the loop/region
markers (see Sample Loop/Region and Display) for this.

10.4.3 Grid Snapping

Most functions in the MIDI Editor are subject to grid snapping (see Using the Editing Grid).
You can hold down the (PC) / (Mac) modifier while performing an action to

The Fold Button Extracts
Key Tracks Containing
Notes.

Use the Loop/Region
Markers to Select a
Specific Region of the
Clip to Play.



10.4. EDITING MIDI 132

bypass grid snapping.

Note movements will also snap to an “offset,” which is based on the original placement of
the note relative to the grid. This is useful for preserving a groove or loose playing style that
you do not necessarily want to “set straight.”

10.4.4 Arranging and Quantizing Notes

As we have seen, notes in the MIDI Editor can be moved both horizontally (changing their
position in time) and vertically (changing their transposition). They can be moved either by
clicking and dragging, or with the arrow keys on your computer keyboard; in either case,
they are subject to grid and offset snapping. If you are playing the clip while you move
notes, you can listen to them play in their new assignments as you drag them, without
waiting until you have released the mouse button.

Multiple notes can be selected and moved in unison: “Rubber-band” select more than one
note with one mouse motion by clicking in empty space, then dragging diagonally upward
or downward to enclose the notes in the dotted line that appears.

You can use the modifier to click and add individual notes or additional “rubber-
band"” selections to your current selection. You can also remove a single note from your
selection by holding down and clicking on it. Holding and clicking on the
piano roll selects all notes in a single key track.

There are two options for quantizing MIDI notes in Live. As previously mentioned (see Grid
Snapping), you can move notes so that they snap to the visible grid lines. Alternatively, you
can select a note or notes and choose “Quantize” from the Edit menu, or use the
(PC)/ [& U] (Mac) hotkey. This brings up a dialog box with several quantization options.
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Quantize To:

Adjust Note:

Using the options presented here, you can select a meter value for quantization and set
either the note start or end (or both) to be quantized. Quantizing the note end will stretch
the note so that it ends at the chosen meter subdivision. You can also quantize notes without
giving them that “quantized” feel using the Amount control, which will move notes only by
a percentage of the set quantization value.

10.4.5 Creating and Editing Notes

Selecting a note (or notes) makes it subject to commands from the Edit menu, such as Copy
and Paste. You can use the (PC) / (Mac) modifier to click and drag a copy of

a note to a new location.

The Edit menu’s Select Loop command selects all notes that begin within the loop brace.
The Select Loop command can also be executed without the menu by simply clicking the
loop brace. This command can speed up editing when coupled with the loop brace’s
shortcuts (see Sample Loop/Region and Display). Let's say you have arranged a nice 1-bar
loop in the Note editor, and you want to duplicate it a couple of times. You can click the
loop brace to select the notes that begin within the loop, execute the Edit menu’s Copy

Quantizing MIDI Notes.
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command, shift the loop to the right by one loop length with (#], and execute the Edit
menu’s Paste command.

N
143 [17.4 18 [18.2 [18.3
=
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Copying (Above) and
Pasting (Below) a Loop.

As we have already seen, creating new MIDI notes is as simple as activating Draw Mode
and drawing them into the Note Editor. MIDI notes can also be added and deleted by
double-clicking when Draw Mode is inactive.

Vertical movements in Draw Mode correspond to velocity changes. This means that, with
one horizontal motion and one vertical motion, you can draw multiple notes and their
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velocities without releasing the mouse button. If you change velocity with this vertical
movement, Live will remember the change and use your new velocity on any notes that you
draw afterward.

You may sometimes, by dragging or by drawing, place a new note on top of one that already
exists. If the new note overlaps with the beginning of the original note, the original note will
vanish. The original note is invisible, but still exists, and will reappear intact if the new note
is moved away again. If the new note overlaps with the “tail” of the original, the original
note's length will change so that it lasts just until the new note's beginning. This, too, is
not an irreversible action, and the old note length will be restored if the new clip is again
moved.

10.4.6 Changing Note Length

Clicking and dragging on a note’s left or right edges changes its length. Note length can
only be changed when Draw Mode is inactive, and will be quantized unless the (PC)
/ (Mac) modifier is held down while dragging.

16 [16.2

Changing Note Length.

Tip: To set a group of notes to the same length, select them all, grab the end of the longest
one, drag them all down to zero length and then extend them.
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10.4.7 Editing Velocities

To change velocity for a MIDI note, click and drag on the associated marker in the Velocity
Editor. (To help you locate the velocity marker belonging to a MIDI note that may be stacked
vertically with others, Live highlights the velocity marker for whichever note your mouse is
hovering over.) Velocity changes will be shown numerically in a small display in the time
ruler.

e R s [ s =

As in the Note Editor, you can select multiple velocity markers to change by clicking with
the modifier held down.

Tip: To set a group of notes so that they all have the same velocity, select their markers in
the Velocity Editor, drag them up to maximum velocity and then decrease velocity to the
desired value.

As we saw earlier, Draw Mode allows drawing identical velocities for all notes within a grid
tile. Velocity drawing can be limited to only those notes that are currently selected if the
modifier is held. To draw markers individually (as you would want to with a crescendo,
for instance) deactivate grid snapping with the (PC)/ (Mac) shortcut, or
simply hold down the (PC)/ (Mac) modifier.

Changing Note Velocity.
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Crescendo (Below).
Tip: To draw a velocity ramp with notes that are all in the same key track, press and
click on the piano roll to select all notes within the desired key track, make sure Draw Mode



10.4. EDITING MIDI 138

is activated and draw the ramp into the Velocity Editor while holding the modifier,
so that you affect only the selected notes.

Notes in the Note Editor display their velocity in their coloring — light notes play softly,
and vice versa. To change the velocity of notes without the Velocity Editor open, click any

selected note and drag vertically while pressing the the (PC)/ (Mac) modifier.

10.4.8 Deactivating Notes

To deactivate, or mute, a note (or notes) in the MIDI Editor, select itand (3 (PC)/ g
(Mac) to access the context menu. The Deactivate Note(s) command will mute the note,
making it appear gray in the display. To reactivate notes, use the context menu's Activate
Note(s) command.



Chapter 11
Launching Clips

The Live Session View is set apart by the fact that it gives you, the musician, an spontaneous
environment that encourages performance and improvisation. An important part of how
you take advantage of the Session View lies within how you configure your various Session
View clips. This chapter explains the group of settings used to define how each Session
View clip behaves when triggered, or “launched.”

11.1 The Launch Box

Remember that clips in the Session View are launched by their Clip Launch buttons (see
Session View Clips) or remote control (see MIDI and Key Remote Control). Clip launch
settings are made in the Launch box. The Launch box only applies to Session View clips,
as Arrangement View clips are not launched but played according to their positions in the
Arrangement.

139
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To view the Launch box, open the Clip View (see Clip View) of a Session View clip by
double-clicking the clip, then activating the leftmost Clip View Box selector panel.

Clip Launch Sampie +

: .. : p— Use the Clip View Box
000 : i ; 7 Selector to Bring up the
Launch Box.

Note that you can edit the launch settings of more than one clip at the same time by first
selecting the clips and then opening the Clip View.

11.2 Launch Modes

Clip Launch Sample
WY MP Fan g Launch Mode | L yP FAN aif (4 Warp
44.1KHZ 16 Bit 1 Ch | Orig. BPM The Clip Launch Mode
Signature (s il Edit ' (Repl Save Chooser.

The Launch Mode chooser offers a number of options for how clips behave with respect to
mouse clicks, computer keyboard actions or MIDI notes (see MID| and Key Remote Control):

e Trigger: down starts the clip; up is ignored.
e Gate: down starts the clip; up stops the clip.
¢ Toggle: down starts the clip; up is ignored. The clip will stop on the next down.
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e Repeat: As long as the mouse switch/key is held, the clip is triggered repeatedly at
the clip quantization rate.

11.3 Clip-Level Quantization

Launch Sample
aunch Mode  OLYMP FAN aif (s
44 1 kHz 16 Bit 1 Ch
Legalc Edit ) (Repl) (Save
Quantization | [H-0| [Fade [RAM

Ve R T /T

The Clip Quantization
| Chooser.

The Clip Quantization chooser lets you adjust an onset timing correction for clip triggering.
To disable clip quantization, choose “None.”

To use the Control Bar's Global Quantization setting, choose “Global.” Global quantization

can be quickly changed using the (Ctl J[6] (PC)/ (& %6 (Mac), 7, B, @] and [0]

shortcuts.

Note that any setting other than “Global” or “None"” will quantize the clip’s launch when it
is triggered by Follow Actions (see Follow Actions).



11.4. VELOCITY 142

11.4 Velocity

Clip Launch Sample
IWLYMP FAM | Launch Mode | OLYMP FAN.aif (48

Trigne 44.1 kHz 16 Bit 1 Ch

4 |I| 4 Juantization Hi-Q | |[Fade RAM
vel[ 0.0% |
wowmwn . (1)

The Velocity Amount control allows you to adjust the effect of MIDI note velocity on the
clip’s volume: If set to zero, there is no influence; at 100 percent, the softest notes play the
clip silently. For more on playing clips via MIDI, see the respective section (see MIDI Remote
Control).

11.5 Legato Mode

Clip Launch Sampie
WYMP FaM aunch Mode HYMP FAN . aif (4
Tricacped 44 1 kKHz 16 Bit 1 Ch
4 il 4 Quantizaton | H-Q | [Fade] [RAM

Suppose you have gathered, in one track, a number of looping clips, and you now want to
toggle among them without losing the sync. For this you could use a large quantization
setting (one bar or greater), however, this might limit your musical expression.

Another option, which works even with quantization turned off, is to engage Legato Mode
for the respective clips. When a clip in Legato Mode is launched, it takes over the play

The Velocity Amount
Field.

The Legato Mode
Switch.
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position from whatever clip was played in that track before. Hence, you can toggle clips at
any moment and rate without ever losing the sync.

Legato Mode is very useful for creating breaks, as you can momentarily play alternative
loops and jump back to what was playing in the track before.

Unless all the clips involved play the same sample (differing by clip settings only), you
might hear dropouts when launching clips in Legato Mode. This happens because you are
unexpectedly jumping to a point in the sample that Live has had no chance to pre-load from
disk in advance. You can remedy this situation by engaging Clip RAM Mode (see Clip RAM
Mode) for the clips in question.

11.6 Follow Actions

Follow Actions allow creating chains of clips that can trigger each other in an orderly or
random way (or both). A clip’s Follow Action defines what happens to other clips in the
same group after the clip plays. A group is defined by clips arranged in successive slots of
the same track. Tracks can have an unlimited number of groups, separated by empty slots.

Clip Launch Sample +*
CSAMPL aunch Mode | BICSAMPL.AIF (B Warp Loop
Trigge 29.4 kHz 16 Bit 2 Ch Irig. EPM Pos +

Signalure Legalo

'I 4 I} 4 Juantization &
— [Fomow Action .I__I:I_: - N
S_ACala| o: 6 -
i :El ] ¢l 0.00 dB
3

The Follow Action
Controls.
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1. The Follow Action Time control defines when the Follow Action takes place in
bars-beats-sixteenths from the point in the clip where play starts. The default for
this setting is one bar.

2. The Follow Action choosers allow selecting two different Follow Actions, A and
B.

3. The Chance A and Chance B controls set the likelihood of each of the two
Follow Actions occurring. If a clip has Chance A set to 1 and Chance B set to
0, Follow Action A will occur every time the clip is launched. As we can see
from this example, a Chance setting of 0 means that an action will never happen.
Changing Chance B to 10 in this scenario makes Follow Action A occur much
less often — approximately once out of every ten clip launches.

There are eight Follow Actions available:
» "Play Clip Again” restarts the clip.

# "Play Next Clip” triggers the next clip down in the group. If a clip with this setting is last
in a group, this Follow Action triggers the first clip.

4+ "Play Previous Clip” triggers the previous clip (the one above the current one).
# "Play Any Clip" plays any clip in the group.

m "Stop” simply stops the clip after it has played for the chosen Follow Action Time. Note
that this overrides clip loop/region settings.

= "Play First Clip” launches the first (top) clip in a group.
= "Play Last Clip” launches the last (bottom) clip in a group.
There is also the possibility to choose no Follow Action by leaving the chooser blank.

Note that a Follow Action happens exactly after the duration that is specified by the Follow
Action Time controls unless clip quantization is set to a value other than “None” or “Global.”
Follow Actions circumvent global quantization but not clip quantization.
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So, why do you need these things? Music is repetition and change. Music based on loops
or short melodic fragments has a tendency to sound static. Follow Actions allow you to
create structures that will repeat but can also be surprising. Remember that you can always
record (see Recording New Clips) the results of your experiments, so this can provide a good
source for new material.

In the following sections we will look at some practical examples and ideas for Follow
Actions.

11.6.1 Looping Parts of a Clip

Let's say that you want to play a longer clip, but then you want only the last eight bars to
loop. You can set this up using Follow Actions:

1. Drag the clip into the Arrangement View and make sure that the Clip View's Loop
switch is not activated. Use the Edit menu’s Split command (see Splitting Clips)
to split the clip between the non-looping and looping parts.

2. Click and drag the resulting two clips into the Session View by letting the mouse
cursor hover over the Session View selector. Drop the two clips into a track. They
now form a Follow Action group.

2 Audio 3 Audio 4 MIDI
5 m m

[5] LM“'A' [5]
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= Follow Action
500 @
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Creating a Group With
the Two Clips.
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3. Set up Follow Actions for the first clip. You will want to make Follow Action Time
equal to the clip’s length. Set the Follow Action A chooser to “Play Next Clip,”
with a Chance setting of 1, leaving Follow Action B alone. Now this clip is set
up to advance to the looping clip after it plays.

4. Activate the Loop switch for the second clip.

The first clip will now proceed to the second after it has played in its entirety; the second
clip will simply play in a loop until it is stopped.

11.6.2 Creating Cycles

One of the most obvious possibilities that Follow Actions open up is using a group of
samples to form a musical cycle. If we organize several clips as a group and use the “Play
Next Clip” Follow Action with each clip, they will play one after the other ad infinitum, or
until we tell them to stop.

Cycles can be peppered with occasional rearrangements through the addition of other
Follow Actions, such as “Play Any Clip,” with smaller relative Chance settings.

11.6.3 Temporarily Looping Clips

There are some interesting applications of Follow Actions when it comes to creating tem-
porary musical loops.

The default setting for Follow Action is actually a 1:0 chance that “Nothing” happens after
the Follow Action Time, which means that there is effectively no Follow Action. But now,
imagine a group consisting of one single clip. Follow Action A is set to “Play Clip Again,”
with a Chance of 8. Follow Action B is set to “None,” with a Chance of 1. The clip uses
a long sample, and Follow Time is set to one bar. Clicking on the clip will play the first
bar, after which it will be very likely that it will play the first bar again. However, after a few
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repetitions, it will eventually come to Action B — “Nothing” — and continue playing the rest
of the sample.

Or, a clip can be played from its start to a specific point, when its Follow Action tells it to
“Play Next Clip.” The same file can be used in the next clip in the group, but this one can
be set to loop. This second clip can have any manner of Follow Action settings, so that it
might then play forever, for a specified time or until random chance leads to the next clip in
the group.

11.6.4 Adding Variations in Sync

Paired with clip envelopes (see Clip Envelopes) and warping (see Time-Warping Samples),
Follow Actions can be used to create all sorts of interesting variations within a group of
similar clips. You could, for example, use Follow Actions to randomly trigger clips with
different MIDI-controller clip envelopes, so that fine variations in pitch bend or modulation
of an instrument or synth could occur as the clips in a group interacted. Audio clips could
morph between different effect or clip transposition settings.

Using Follow Actions and Legato Mode together provides a powerful way of gradually
changing a melody or beat. Imagine that you have several identical clips of a melody that
form a group, and they are set up to play in Legato Mode (see Legato Mode). Whenever
their Follow Actions tell them to move on to another clip in the group, the melody will not
change, as Legato Mode will sync the new play position with the old one in beat-time. The
settings and clip envelopes of each clip (or even the actual notes contained in a MIDI clip)
can then be slowly adjusted, so that the melody goes through a gradual metamorphosis.

11.6.5 Mixing up Melodies and Beats

You can let Follow Actions perform unpredictable remixes and solos for you: Use a clip
containing a beat or melody, and copy it so that there are several instances of it forming a
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group. Alternatively, you can use several different beats or melodies that you want to mix
together. The start and end (see Sample Loop/Region and Display) for each clip can be set
differently, as can clip envelopes (see Clip Envelopes) and other clip settings. As long as
Follow Action Time in each clip is equal to the length of the clip that you want to play, you
can set up two Follow Actions with different Chance values in each clip, launch a clip, and
surprise yourself.

11.6.6 Creating Nonrepetitive Structures

Follow Actions are great when it comes to sound installations, as they allow you to create
structures that play for weeks or months and never exactly repeat. You can set the Follow
Action Time controls in a series of clips to odd intervals, and the clips will interact with each
other so that they never quite play in the same order or musical position. Remember that
each clip can have two different Follow Actions with corresponding Chance settings... have
fun!



Chapter 12

Routing and I/O

In the context of Live, “routing” is the setup of the tracks’ signal sources and destinations
(i.e., their inputs and outputs). Routing happens in the mixer’s track In/Out section, which
offers, for every track, choosers to select a signal source and destination. The mixer's In/Out

o

section is Live's “patchbay.”

You can check the “In/Out” View menu entry to access the In/Out section in the Session or
Arrangement View. Note that, in the Arrangement View, unfolding and resizing the track
makes the complete In/Out section available; in the Session View, the In/Out section can
also be shown or hidden from the mixer with the Mixer Section selector on the far right-hand
side of the screen.
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For every track (except the Master), the In/Out section has the same layout:

e The upper chooser pair (“Audio/MIDI From”) selects the track’s input. Audio tracks
have an audio input, and MIDI tracks have a MIDI input. Return tracks receive their
input from the respective sends (see Return Tracks and the Master Track).

e The "Monitor” radio button selects the monitor mode, or the conditions under which
the track’s input is heard through the track.

e The lower chooser pair (“Audio/MIDI To") selects the track’s output. All tracks have
audio outputs, except for MIDI tracks without instruments. Remember that instruments
convert MIDI to audio (see Devices and the Mixer).

Within a chooser pair, the upper chooser selects the signal category (“Ext.,” for instance,
for external connections via an audio or MIDl interface), and is called the Input/Output Type
chooser. If this signal type offers sub-selections or channels, they are available from the
lower chooser, or the Input/Output Channel chooser. In our “Ext.” example, these would
be the individual audio/MIDI inputs and outputs.
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12.1 Monitoring

1

“Monitoring,” in the context of Live, means passing a track’s input signal on to the track’s
output. Suppose you have set up an audio track to receive its input signal from a guitar.
Monitoring then means that the signal from your live guitar playing actually reaches the
track’s output, via the track’s device chain. If the track’s output is set to “Master,” you can
hear the guitar signal, processed by whatever effects are used, and delayed by whatever
latency the audio hardware interface incurs, over your speakers.

The In/Out section offers, for every audio track and MIDI track, a Monitor radio button with
the following three options:

e The default Auto-monitoring setting does the right thing for most straightforward
recording applications: Monitoring is on when the track is armed (record-enabled)
(see Recording New Clips), but monitoring is inhibited as long as the track is playing
clips.

- 1
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e To permanently monitor the track’s input, regardless of whether the track is armed or
clips are playing, choose In. This setting effectively turns the track into what is called
an "Aux” on some systems: The track is not used for recording but for bringing in a
signal from elsewhere (for instance, a ReWire slave program). With this setting, output
from the clips is suppressed. An “In” monitoring setting can be easily recognized even
when the In/Out section is hidden by the orange color of the track’s Activator switch.

¢ Monitoring can be turned off altogether by choosing the Off option. This is useful

Audio and MIDI Track
Arm Buttons.
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when recording acoustic instruments which are monitored “through the air,” when
using an external mixing console for monitoring or when using an audio hardware
interface with a “direct monitoring” option that bypasses the computer so as to avoid
latency. Generally, it is preferable to work with an audio interface that allows for
negligible latencies (a few milliseconds). If you are recording into Live with monitoring
setto "Off,” you may want to make the Audio Preferences’ Overall Latency adjustment,
which is described in the built-in program tutorial on setting up the Audio Preferences.

12.2 External Audio In/Out

An audio interface’s inputs are selected by choosing “Ext. In” from the Input Type chooser of
an audio track. The Input Channel chooser then offers the individual input channels. Entries
in this chooser each have meters next to their names to help you identify signal presence
and overload (when the meter flashes red). Setting up the audio interface’s outputs works
the same way via the output chooser pair.

The list of available inputs and outputs depends on the Audio Preferences, which can be
reached via the Input and Output Channel choosers “Configure...” option. Note that
the Audio Preferences also provide access to the Channel Configuration dialogs, which
determine which inputs and outputs are used, and whether they are available to Live as
mono or stereo pairs. Essentially, the Channel Configuration dialog tells Live what it needs
to know about how the computer is connected to the other audio components in your
studio.

12.2.1 Mono/Stereo Conversions

When a mono signal is chosen as an audio track’s input, the track will record mono samples;
otherwise it will record stereo samples. Signals in the track’s device chain are always stereo,
even when the track’s input is mono or when the track plays mono samples.
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Mono is turned into stereo simply by using the identical signal for left and right channels.
When a track is routed into a mono output, the left and right signals are added together
and attenuated by 6 dB to avoid clipping.

12.3 External MIDI In/Out

MIDI from the outside world is routed into Live just like audio. From the Input Type chooser
of a MIDI track, you can either select a specific MIDI input device or “All Ins,” which is the
merged input of all external MIDI devices. The Input Channel chooser offers the individual
input channels of the selected MIDI device and the merged signal of all channels, “All.” As
is the case with audio inputs, the Input Channel chooser also has meters next to every entry
to represent activity on the respective in channel.

12.3.1 The Preferences’ Active MIDI Device List

Audio MIDISyne Plug-In Defaults Misc Products

Sync | Remote

Track
[ On |

Output Sync Remote

o
“on |
o

The MIDI Device List in
the Preferences.
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You can configure which MIDI devices are made available to Live using the Active Devices
section in the MIDI Preferences. This section lists all available input and output MIDI
devices. For Live's tracks to receive/send MIDI from/to a specific MIDI device, make sure
the corresponding switch in the “Track” column is set to On. You can use any number of
MIDI devices for track MIDI input/output; the mixer’s In/Out section allows you to individually
address them.

12.3.2 Playing MIDI With the Computer Keyboard

The computer keyboard can be used as a pseudo-device for generating MIDI notes from
computer keyboard strokes. Using this pseudo-device, you can generate MIDI even without
a “real” MIDI input device. To turn the computer MIDI keyboard on, use the Control
Bar's Computer MIDI Keyboard button, or the (PC)/ (Mac)

shortcut to the Options menu entry.

'M—r MID

The center row of letter keys on the keyboard will play notes corresponding to the white keys
on a piano, beginning on the left with the note C5. The black keys on a piano correspond to
the upper row of computer keys. The four leftmost letters on the lower row of the keyboard
are used to transpose the note range and to set velocity. The results of changing these
values are displayed in the Status Bar at the bottom of the Live screen.

As it happens, when the computer keyboard is set to send notes between C3 and C4, the
keys are mapped to MIDI notes such that the center row of the keyboard (ASDF...) addresses
the Impulse percussion sampler’s sample slots (see Impulse). This means that you can play
and record drum patterns right off the computer keyboard.

| “steal”

Note that when the computer MIDI keyboard is activated, it wil keys that may have

Activating the Computer
MIDI Keyboard.



12.3. EXTERNAL MIDI IN/OUT 155

otherwise been assigned to remote-control (see Keyboard Remote Control) elements of the
Live interface. To prevent this, you can turn the computer MIDI keyboard off when it is not
needed.

12.3.3 Connecting External Synthesizers

Routing MIDI to an external synthesizer is straightforward: The Output Type chooser is set
to whatever MIDI port the synthesizer is connected to; the Output Channel chooser is used
to select which MIDI channel to send on.

Important: If you are using a keyboard synthesizer both as a master keyboard to play into
Live and as a sound generator, then please make sure to check the synthesizer's “Local
Off” function. Every synthesizer has this function, which effectively separates the keyboard
from the sound generator, allowing you to treat both components as if they were separate
devices. This allows you to use Live as the hub of your MIDI studio, which receives MIDI
from the keyboard and dispatches the incoming MIDI, as well as the MIDI from the clips, as
appropriate.

12.3.4 MIDI In/Out Indicators

Live's Control Bar contains three pairs of indicator “LEDs"” that tell you about incoming and
outgoing MIDI. These indicators tell you not only about the presence of signals, but also
about their use. In every pair, the upper indicator flashes when a MIDI message is received,
and the lower indicator flashes when a MIDI message is sent.

T ] pxﬁ > 1/ H|® ovR | =+ |Bar & 1 1|~ |32 |— u.—rﬁu-

The three indicator pairs represent:

1. MIDI Clock and Timecode signals that are used for synchronizing Live with other
sequencers (see Synchronizing via MIDI);

The Control Bar’s MIDI
Indicators.
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2. MIDI messages that are used for remote-controlling Live's user-interface elements
(see MIDI and Key Remote Control);

3. MIDI messages coming from and going to Live's MIDI tracks.

MIDI messages that are mapped to remote-control Live's user-interface elements are “eaten
up” by the remote-control assignment and will not be passed on to the MIDI tracks. This is
a common cause of confusion that can be easily resolved by looking at the indicators.

12.4 Master and Cue Outs

The Master track (see Return Tracks and the Master Track) is the default destination for audio
signals. The Master track, in turn, is routed to the external audio outputs.

The Cue/Preview Out can be independently routed to allow, for instance, for previewing
samples and cueing tracks via headphones (see Soloing and Cueing).

12.5 ReWire Slave Routing

Live can send MIDI to, and receive audio from, any ReWire slave application installed on
the same computer.
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MIDI From
[Anng

[Reason
[NN-XT 1

|| [Masier

The following example shows how to send MIDI from one of Live's MIDI tracks into an
instrument within Propellerhead’s Reason, and then route the audio result back into an
audio track:

1.

o

First, start Live.

. Then, start Reason and set up the Reason rack as desired.

2
3.
4

Select “Reason” from the MIDI track’s Output Type chooser.

. The Output Channel chooser presents you with a list of the instruments that you

currently have in your Reason rack; select the instrument you want to address.
Select “Reason” from the audio track’s Input Type chooser.

From the audio track’s Input Channel chooser, select the audio channel that
corresponds to the instrument to which you are sending MIDI.

. Set the audio track’s Monitor radio button to “In.”

An Audio Track
Receiving Audio From
and a MIDI Track
Sending MIDI to Reason.
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8. Select “All Ins” from the MIDI track’s Input Type chooser.
9. Arm the MIDI track.

Now, any MIDI that you are playing into Live will arrive in Reason, which will generate the
corresponding audio back into the audio track, ready for further processing in Live's mixer
and effects. If you want to continue work on the project without reopening Reason, simply
record Reason'’s audio by arming the audio track and engaging Record Mode.

12.6 Resampling

Live's Master output can be routed into an individual audio track and recorded, or resampled.
Resampling can be a fun and useful tool, as it lets you create samples from what is currently
happening in a Live Set that can then be immediately integrated. It can be used to record
tracks that include processor-intensive devices, so as to delete the devices, or for quickly
previewing before rendering to disk (see Exporting Audio).

The “Resampling” option in any audio track’s Input Type chooser will route the Master
output to that track. You can then decide on what exactly you will be resampling and mute,
solo or otherwise adjust the tracks that are feeding the Master output. You will probably
want to use the Master Volume meter to make sure that your level is as high as possible
without clipping (indicated by red in the meter). Then you can arm the track and record into
any of its empty clip slots (see Recording Into Session Slots). Note that the recording track’s
own output will be suppressed while resampling is taking place, and will not be included in
the recording.

Samples created by resampling will be stored in the Live Set’s Sounds folder (see The Sounds
Folder and Self-Containing).
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12.7 Internal Routings

Live allows for inter-track routings. These routings, albeit potentially confusing, enable many
valuable creative and technical options. Inter-track routing can work two ways:

1. Track A is set up to send its output signal to Track B. This is possible because
every track that can receive an output signal of the appropriate type from Track
A shows up in its Output Type chooser.

2. Track B is set up to receive its input signal from Track A. This works because every
track that delivers a signal of the appropriate type appears in Track B’s Input Type

chooser.
1 Track A 2 Track B 3 Audio
! Track A 2 Track B 3 Audio
Audio From Audio From Audio From

Audio Fram

Audio From udie From

] 1-Track A w |l oo
Monitor Monitor ] Il Track Cul
Ol WO |[Aato] (O Manitor it

O Off On | Auto| (O

udio To Audio To In| | Auto| |
Audio To Audio To Audio To
== == == Two Ways to Route Track
[ | ] J ] | A into Track B.

Both approaches result in Track A's output being fed into Track B. Approach 1 leaves Track
B's in/out settings alone, and we can, at any time, add more tracks that feed their output
into Track B. This is the method of choice for “many-to-one” routings such as submixes or
several MIDI tracks playing the same instrument.

Approach 2, on the other hand, leaves Track A unaffected except for Track B tapping its
output. We can easily add more tracks like Track B that all tap Track A's output. Instrument
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layering is a good example of such a “one-to-many” routing setup.

The rest of this section presents internal routing examples in more detail.

12.7.1 Post-Effects Recording

Let's say that you are feeding a guitar into Live, building up a song track by track, overlaying
take onto take. Itis certainly powerful to have a separate effects chain per track for applying
different effects to different takes — after the fact. You might, however, want to run the guitar
signal through effects (a noise gate or an amp model, for instance) before the recording
stage, and record the post-effects signal.

3 Audic 4 Guitar 3 Audic & Audio 7 Pad

Audio From Audio From Audio From Audio From WDl From
] [Ext. In w| [4-Guitar  =| [4-Guitar _ =||;
W0za < fii Track Out_|| i Track Oul ]Iy i chann |
Maonitor Maonitor Maonitor Montior
On| [Ato] [0f] [Onl[Auto] o] [On] [Aia] O |0, a5
Audic To Audio To Audio To Audio To DI To
§ ] [Master || [Master || [Master =1 =
1 | | |

1111}

OFEOTF OO
This is easily accomplished by devoting a special audio track for processing and monitoring
the incoming guitar signal. We call this track “Guitar” and drag the desired effects into its
device chain. We do not record directly into the Guitar track; instead we create a couple

more tracks to use for recording. Those tracks are all set up to receive their input from the
Guitar track.

As for monitoring, we set the Guitar track’s Monitor radio button to In, because we always
want to listen to our guitar through this track, no matter what else is going on in Live. The

An Example Setup for
Pre-Effects Recording.
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other tracks’ Monitor radio buttons are set to Off.

12.7.2 Recording MIDI as Audio

When working with MIDI and complex software instruments, it is sometimes more useful
to record the resulting audio than the incoming MIDI. A single MIDI note can prompt, for
example, Native Instruments’ Absynth to produce something that sounds more like a piece
of music than a single tone. This output lends itself more to representation as an audio
waveform than a single note in a MIDI clip, particularly when comparing the editing options.

E‘I’aka 1 Stri| 0
o

]
O 423 ||@ |

Audio From | MIDI From
[3-Apgynin 2| [Computer ke
[l Track Out_]I[T_Anchanns]
Maonitar Manitor
(o] ] o
Audio To Audio To
[raaster || [Masier <

Recording the Output of
a Complex Instrument in
Audio Tracks.

A setup similar to the one described above (see Post-Effects Recording) accomplishes the
task. We have one MIDI track hosting the virtual instrument, and we use additional audio
tracks to record the audio result of playing the instrument.
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12.7.3 Creating Submixes

1 Snare 2 Bass 3 Hi-Hats 4 Submix 5 Auvdio
[rake1 | [ vake 5
[ JoLvme Fa
| I |
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Suppose we have the individual drums of a drum kit coming in on separate tracks for
multitrack recording. In the mix, we can easily change the volumes of the individual drums,
but adjusting the volume of the entire drum kit against the rest of the music is less convenient.
Therefore, we add a new audio track to submix the individual drums. The drum tracks are

all set to output to the submix track, which outputs to the Master. The submix track gives
us a handy volume control for the entire drum kit.

b | |0
& () |0
o |8 ;| | B

12.7.4 Several MIDI Tracks Playing the Same Instrument

Consider a MIDI track containing a virtual instrument — a Simpler (see Simpler) playing a pad
sound, for example. We have already recorded MIDI clips into this track when we realize
that we would like to add an independent, parallel take for the same instrument. So we add

Submixing the Individual
Drums of a Drum Kit.
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another MIDI track. We could now drag another Simpler into the new track, but we would
really like to reuse the Simpler from the pad track, so that changing the pad’s sound affects
the notes from both tracks.

& Pad 9 Pad 2
I

MIDI From MIDI From
] [aning =||[anIng |

E [fAnChann=| £ Al Channw]

Feeding an Additional
MIDI Track Into an
Existing MIDI Track to
Reuse its Instrument.

This is accomplished by setting the new MIDI track’s Output Type chooser to “Pad.” Note
that the Output Channel chooser now offers a selection of destinations: We can either feed
the new track’s output into the input of the pad track, or we can directly address the Simpler.
The “Track In” option in the Output Channel represents the pad track’s input signal (the
signal to be recorded), which is not what we want. We instead select “Simpler Ch. 1" to
send the new track’s MIDI directly to the Simpler, bypassing the recording and monitoring
stage. With this setup, we can choose to record new takes on either track and they will all
play the same pad sound.
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9 Pad 2
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We might be bothered by the fact that muting the pad track (by turning off its Activator
switch) also mutes the other MIDI track. To be precise, the other track keeps playing, but its
MIDI is played by an instrument that is out of the mix. This can be easily remedied by cutting
the clips from the pad track and pasting them into a third track that can be independently
muted (and that can hold its own MIDI effects). The original pad track now acts as a mere
instrument container. As we are not recording new clips into this track, we can set its Input
Type chooser to “No Input,” which makes its Arm button disappear and helps to avoid
confusion when the mixer’s In/Out section is hidden.

12.7.5 Tapping Individual Outs From an Instrument

Some software instruments, like Live's Impulse percussion sampler (see Impulse), offer mul-
tiple audio outputs for the signals they produce. By default, Impulse mixes the output of its
eight sample slots internally and delivers the mix at the instrument’s audio out. Any audio
effects following Impulse in the same track process the composite signal. Sometimes it is
desirable to take an individual drum sound out of the mix for individual effects processing
and mixing. This is possible because Impulse offers its sample slots as audio sources to
other tracks.

The Instrument Has
Been Isolated in a
Dedicated Track.
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We simply create an audio track and select from its Input Type chooser the track with the
Impulse. The Input Channel chooser now offers, in addition to “Track Out” (the audio signal
at the end of the track’s device chain), Impulse’s eight individual outputs, labeled according
to the sample used in each slot. Notice that routing an individual output from Impulse
into another track automatically takes this signal out of Impulse’s own internal mix. This
convenience is not standard behavior of most plug-in instruments, however.

® | | B
LI LTLTIT Y]]

12.7.6 Using Multi-Timbral Plug-In Instruments

Many plug-in instruments support multi-timbral operation. A multi-timbral instrument is like
several instruments in one, with each component “part” (or whatever term the manufacturer
uses) receiving MIDI on a separate MIDI channel. Usually, the multi-timbral instrument

Using Impulse’s
Individual Outs to
Separately Process
Sample Slots.
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offers individual outputs so that the parts can be separately routed into the mixer. Or, the
instrument might offer a submixer of its own.

Audio From Audio From MIDI From MIDI From MIDI From
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l if if j[z-ror =il = From the Parts of a
Multi-Timbral
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Sending MIDI to a multi-timbral instrument is a variation of a case described above (see
Several MIDI Tracks Playing the Same Instrument). One MIDI track hosts the multi-timbral
instrument, and additional MIDI tracks are used to feed its individual parts. Each additional
MIDI track has its Output Type chooser pointed to the track that contains the instrument,
and its Output Channel chooser referencing the target MIDI channel. Additional audio
tracks can then be used to tap the instrument’s individual outputs, as described earlier (see
Tapping Individual Outs From an Instrument).

12.7.7 Feeding Sidechain Inputs

Some effects have so-called “sidechain inputs.” A vocoder, for instance, imposes spectral
characteristics taken from one signal (say, spoken word) onto another signal, for instance a
string pad. The vocoder is inserted as an audio effect into the string track. It has a sidechain
input for the speech signal, which has to be delivered from another track. So, we create an
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additional audio track named “Speech” and set its Output Type chooser to the “Strings”
track. From the Output Channel chooser, we select the vocoder’s sidechain input.

1 Speech 2 Strings 3 Mo 4 MiDi
| |!- s Lrll'.'u” |:-‘--'|||;| A |
l | |

Audio From | Audio From  Lyp) from MIDI From
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[Ow] e ][O ol .

AudioTo  |AudioTo oo —=
[Master =i ;
| |

Routing a Speech Signal
Into a Vocoder’s
9 [not supporiad Sidechain Input.

Some vocoder plug-ins include a built-in synthesizer to generate the “carrier” signal. In
this case, the only difference from the above procedure is that the vocoder instrument is
dragged into a MIDI track. Feeding the side-chain audio input works as described above.

12.7.8 Layering Instruments

Suppose that we have a MIDI track containing an instrument playing a string sound, which
we would like to “lubricate” by adding a brass sound playing the same notes. This can be
easily done by adding a MIDI track that contains an instrument playing the brass sound and
setting its Input Type chooser to tap the string track’s output signal.
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Using an Auxiliary MIDI
Track to Layer
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Perhaps you wonder why this works, given that the string track’s output is audio and not
MIDI. When routing MIDI in from another track, we are tapping the MIDI at the latest possible
stage, which is just before the instrument.



Chapter 13

Mixing

13.1 The Live Mixer

Live includes a mixer section that is accessible from two views:

169
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The Arrangement View
Mixer.

In the Arrangement View, the mixer appears as a horizontal strip to the right of the track
area. To display all mixer controls for a track, unfold the track using the triangular button
next to its name, and adjust its height accordingly.

12

Stop Clips

(T) i (T) i (r) i
[s] [s]

EE

The Session View Mixer.

The Session View is a standard vertical mixer layout. You'll likely find the Session View
mixer more intuitive than the Arrangement mixer, which comes in handy when you work
with automation (see Automation and Editing Envelopes). Note that the Tab key toggles
between the Arrangement and Session Views.

The View menu options listed below show or hide mixer components. You can use different
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mixer view setups in the Session View and in the Arrangement View:
e In/Out
e Sends
e Returns
o Mixer

e Track Delays

Crossfader

The Mixer Section selector on the right-hand side of the screen makes it possible to quickly
show or hide different mixer components.

Stop Clips

[}
00096

Cua Out
il 17
Master Out

The Mixer Section
Selector.

Let's look at the mixer controls:
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1. The Meter shows the track’s RMS (average) and peak output level. While moni-
toring, however, it shows the input level.

2. The Volume control adjusts the track’s output level.

3. The Pan control positions the track’s output in the stereo field. To reset the pan
control to center, click on the little triangle.

4. To mute the track’s output, turn off the Track Activator switch.

5. The Solo switch solos the track by muting all other tracks, but can also be used for
cueing (see Soloing and Cueing). Tracks can only be soloed one at a time unless
the Exclusive Solo option in the Misc Preferences is deactivated. Alternatively,
you can hold down the (PC) / (Mac) modifier to solo more than
one track.

6. If the Arm Recording button is on, the track is record-enabled (see Recording
New Clips). Tracks can only be armed one at a time unless the Exclusive Arm
option in the Misc Preferences is deactivated. Alternatively, you can hold down

the (Cul ] (PC)/ (Mac) modifier to arm more than one track.

13.2 Audio and MIDI Tracks

Audio and MIDI tracks in Live are for hosting and playing clips, as explained earlier (see
Tracks).

You can add new audio and MIDI tracks to your Live Set's mixer at any time using the
appropriate Insert menu commands.

Tracks can also be created by double-clicking or pressing Return] on files in the Browser to
load them, or by dragging objects from the Browser into the space to the right of Session
View tracks or below Arrangement View tracks. Devices or files loaded into Live in this



13.3. RETURN TRACKS AND THE MASTER TRACK 173

manner will create tracks of the appropriate type (e.g., a MIDI track will be created if a MIDI
file or effect is dragged in).

A track is represented by its track title bar. You can click on a track title bar to select the
track and then execute an Edit menu command, such as “Rename,” on the track. One can
quickly rename a series of tracks by executing this command and then using the Tab key to
move from title bar to title bar.

3 mioil 4 MiDi | F

|

You can drag tracks by their title bars to rearrange them, or click and drag on their edges to
change their width (in the Session View) or height (in the Arrangement View).

|| 1 Audio 2 Audio

Tracks are deleted using the Edit menu’s Delete command.

13.3 Return Tracks and the Master Track

In addition to tracks that play clips, a Live Set has a Master track and up to twelve return
tracks; these cannot play clips, but allow for more flexible signal processing and routing.

The return tracks and the Master track occupy the right-hand side of the Session mixer view
and the bottom end of the Arrangement View.

Note that you can hide and show the return tracks using the Returns command in the View
menu.

Iu

Like the “normal” clip tracks, the returns and the Master can host any number of effects
(see Working with Instruments and Effects). However, whereas a clip track’s effect processes
only the audio within that track, return tracks can process audio sent to them from numerous
tracks.

Tracks are Represented
by Track Title Bars.
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For example, suppose you want to create rhythmic echoes with a delay effect. If you drag
the effect into a clip track, only clips playing in this track will be echoed. Placing this effect
in a return track lets it receive audio from any number of tracks and add echoes to them.

Seﬂds 6) Sends Sanda Seﬂds

(Wn '(17 i mll

A clip track’s Send control regulates how much of the clip track’s output feeds the associated
return track’s input. What's more, even the return track’s own output can be routed to its
input, allowing you to create feedback. Please use this feature with care, as runaway
feedback can boost the level dramatically and unexpectedly.

Every return track has a Pre/Post toggle that determines if the signal a clip track sends to
it is tapped before or after the mixer stage (i.e., the pan, volume and track-active controls).
The “Pre” setting allows you to create an auxiliary mix that is processed in the return track,
independently of the main mix. As the return track can be routed to a separate output
(see Routing and 1/0), this can be used to set up a separate monitor mix for an individual
musician in a band.

The Master track is the default destination for the signals from all other tracks. Drag effects
here to process the mixed signal before it goes to the master output. Effects in the Master
track usually provide mastering-related functions, such as compression and/or EQ.

You can create multiple return tracks using the Insert menu’s Insert Return Track command,
but by definition, there is only one Master track.

The Send Controls and
Pre/Post Toggle.
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13.4 Using Live's Crossfader

Live includes a crossfader that can create smooth transitions between clips playing on
different tracks. Live's crossfader works like a typical DJ-mixer crossfader, except that it
allows crossfading not only two, but any number of tracks — including the returns.

The crossfader is accessed via the Session View mixer.

M

o7
L 2|

The crossfader is a horizontal slider that can be mapped to any continuous MIDI controller
(absolute or incremental) (see MIDI and Key Remote Control). In addition to the crossfader’s
central slider, its absolute left and right positions are separately available for MIDI or key-
board mapping. There are two special scenarios for remote control with respect to the
crossfader:

o A key mapped to any one of the three assignable crossfader positions (left, center or
right) will toggle the crossfader’s absolute left and right positions.

¢ Mapping to two of the three fields allows for a “snapping back” behavior when one
of the assigned keys is held down and the other is pressed and released.

The Crossfader.
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Each track has two Crossfade Assign buttons, A and B. The track can have three states with
respect to the crossfader:

e If neither Assign button is on, the crossfader does not affect the track at all.

e If Alis on, the track will be played unattenuated as long as the crossfader is in the left
half of its value range. As the crossfader moves toward the right across the center
position, the track fades out. At the crossfader’s rightmost position, the track is muted.

o Likewise, if B is on, the track’s volume will be affected only as the crossfader moves
left across its center position.

It is important to understand that the Crossfade Assign buttons do not affect the signal
routing: The crossfader merely influences the signal volume at each track’s gain stage. The
track can be routed to an individual output bus regardless of its crossfade assignment. In
studio parlance, you can think of the crossfader as an on-the-fly VCA group.

As with almost everything in Live, your crossfading maneuvers can be recorded into the
Arrangement (see Automation and Editing Envelopes) for later in-depth editing. To edit each
track’s crossfade assignment, please choose “Mixer” from the Envelope Device chooser and
“X-Fade Assign” from the Control chooser. The crossfader’s automation curve is accessible
when “Mixer” is chosen from the Master track’s Device chooser and “Crossfade” is selected
from its Control chooser.

A Track’s Crossfade
Assign Buttons.
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13.5 Soloing and Cueing

By default, soloing a track simply mutes all other tracks. The signal from the soloed tracks
is heard through their respective outputs, with the pan setting of each track preserved.
Soloing a clip track leaves the return tracks unaffected (solo in place). Soloing a return track
affects all other tracks.

Live allows you to replace the standard soloing operation with a cueing operation that lets
you preview tracks as though you were cueing a record on a DJ mixer. This allows choosing
clips and adjusting effects without the audience hearing, before bringing tracks into the mix.

In order to set Live up for cueing, you must be using an audio interface with at least four
dedicated outputs (or two dedicated stereo outputs). The respective settings are accessible
in the Session View mixer. Make sure you have “Mixer” and “In/Out” checked from the
View menu.

4 5 3

MID| From MIDI From

Maonitor
On| |Auto
MIDI To

SepessSsIReeN

1. The Master Out chooser selects the output on your interface to be used as the
main output.

The Cueing-Related
Session Mixer Controls.
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2. The Cue Out chooser selects the output on your hardware interface to be used
for cueing. This has to be set to an output other than that selected for the Master.
If the desired outputs don't show up in these choosers, please check the Audio
Preferences.

3. Activate cueing by setting the Solo/Cue Mode switch to “Cue.”

4. The tracks’ Solo switches are now replaced by Cue switches with headphone
icons. When a track’s Cue switch is pressed, that track’s output signal will be
heard through the output selected in the Cue Out chooser. Note that the Track
Activator switch on the same track still controls whether or not the track is heard
at the Master output.

5. The Cue Volume control adjusts the volume of the cueing output.

Note that when cueing is set up and activated, the output of audio files that you are
previewing in the Browser is also heard through the Cue Out.

13.6 Track Delays

A Track Delay control is available for every track in Live. The control allows delaying or pre-
delaying the output of tracks in milliseconds in order to compensate for human, acoustic,
hardware and other real-world delays.

This section of the interface can be shown or hidden using its respective Mixer Section
selector.
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We do not recommend changing track delays on stage, as it could result in undesirable
clicks or pops in the audio signal. Micro-offsets in Session View clips can be achieved using
the nudge buttons in the Clip View (see Clip Offset and Nudging), however track delays can
be used in the Arrangement View for such offsets.

Note that delay compensation for plug-ins and Live devices (see Device Delay Compensation)
is a separate feature, and is automatic by default. Unusually high Track Delay settings or
reported latencies from plug-ins may cause noticeable sluggishness in the software. If you
are having latency-related difficulties while recording and playing back instruments, you
may want to try turning off device delay compensation, however this is not normally rec-
ommended. You may also find that adjusting the individual track delays is useful in these
cases. Note that the Track Delay controls are unavailable when device delay compensation
is deactivated.

The Track Delay Control
and Selector.



Chapter 14

Recording New Clips

This chapter is about recording new clips from audio and MIDI input signals. Note that this
is a different kind of recording than the capturing of Session clips into the Arrangement (see
Recording Sessions into the Arrangement).

For successful audio recording, please make sure the audio preferences are set up properly.
For more on this, please see the built-in program lesson on setting up Audio Preferences.
Also, keep in mind that devices such as microphones, guitars and turntables do not operate
at line level, meaning that they will need to have their levels boosted before they can be
recorded. For these devices, you must therefore use either an audio interface with a preamp,
or an external preamp.

180
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14.1 Choosing an Input

A track will record whatever input source is shown in its In/Out section, which appears when
the View menu’s “In/Out” option is checked. (In the Arrangement View, unfold and resize
the track in order to completely see the In/Out section.)
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Audio tracks default to recording a stereo signal from the external input pair “1/2.” MIDI
tracks default to recording all MIDI that is coming in through the active external input
devices (see The Preferences’ Active MIDI Device List). The computer keyboard is, by
default, activated as a pseudo-MIDI input device (see Playing MIDI With the Computer
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Ll
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The Track In/Out Section
in the Arrangement
(Top) and Session View
(Bottom).
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Keyboard), allowing you to record MIDI even if no MIDI-controller hardware is currently
available.

For every track, you can choose an input source other than the default: any mono or stereo
external input, a specific MIDI channel from a specific MIDI-in device, audio from ReWire
slave programs or a signal coming from another track. The Routing chapter (see Routing
and 1/O) describes these options in detail.

14.2 Arming (Record-Enabling) Tracks
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To select a track for recording, click on its Arm button. It doesn’t matter if you click a track’s
Arm button in the Session View or in the Arrangement View, since the two share the same
set of tracks (see Tracks).

By default, armed tracks are monitored, meaning that their input is passed through their de-
vice chain and to the output, so that you can listen to what is being recorded. This behavior
is called “auto-monitoring” and you can change it to fit your needs (see Monitoring).

Clicking one track’s Arm button unarms all other tracks unless the (Ctl | (PC)/ (Mac)
modifier is held. Arming a track selects the track so you can readily access its devices in the
Track View (see Working with Instruments and Effects).

Track Arm Buttons in the
Session (Left) and
Arrangement (Right)
Mixers.
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14.3 Recording

Recording can be done in both the Session and the Arrangement Views. If you want to
record onto more than one track simultaneously and/or prefer viewing the recording linearly
and in-progress, the Arrangement View may be the better choice. If you want to break your
recording seamlessly into multiple clips or record while you are also launching clips in Live,
use the Session View.

14.3.1 Recording Into the Arrangement

EXT b 9. 4 =+ |Bar &
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1. Recording commences when the Control Bar's Record button is activated and
the Play button is pressed.

2. Recording creates new clips in all tracks that have their Arm button on.

Recording Into the
Arrangement.
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3. When the Overdub switch is on, the new clips contain a mix of the signal already
in the track and the new input signal. The Overdub option only applies to MIDI
tracks.

4. To prevent recording prior to a punch-in point, activate the Punch-In switch. This
is useful for protecting the parts of a track that you do not want to record over
and allows you to set up a pre-roll or “warm-up” time. The punch-in point is
identical to the Arrangement Loop’s start position.

5. Likewise, to prevent recording after the punch-out point, activate the Punch-Out
switch. The punch-out point is identical to the Arrangement Loop’s end position.

6. When you are recording into the Arrangement Loop (see The Arrangement
Loop), Live retains the audio recorded during each pass.

You can later “unroll” a loop recording, either by repeatedly using the Edit menu’s Undo
command or graphically in the Clip View: After loop recording, double-click on the new clip.
In the Clip View's Sample Display, you can see a long sample containing all audio recorded
during the loop-recording process. The Clip View's loop brace (see Sample Loop/Region
and Display) defines the audio taken in the last pass; moving the markers left lets you
audition the audio from previous passes.

14.3.2 Recording Into Session Slots

You can record new clips, on the fly, into any Session slots.



14.3. RECORDING 185

4 3 2
o® | EXT » 7. 3. B nie
|
1 Audio 2 Audio 3 MIDi 4 MiDi
I:rﬁ-u@1ii]| Tragk 3 |u3mu Swee
[ [re-ag@iis [ [rram 1 | | Emic) Take |
[2]

s @
2lel

(B ;| (B
LLLLLLL L L L L L L

Recording a New Clip
Into the Session View.

1. Set the Global Quantization chooser to any value other than “None” to obtain
correctly cut clips.

2. Activate the Arm button for the tracks onto which you want to record. Clip
Record buttons will appear in the empty slots of the armed tracks.

3. Click on any of the Clip Record buttons to commence recording. A new clip
will appear in the slot with a red Clip Launch button that shows it is currently
recording. To go from recording immediately into loop playback, press the clip’s
Launch button.

4. Alternatively, you can click a Clip Stop button or the Stop button in the Control
Bar to stop recording, leaving the new clip silent.

Note that, by default, launching a Session View scene (see Tracks and Scenes) will not
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activate recording in empty record-enabled slots belonging to that scene. However, you
can use the Start Recording on Scene Launch option from the Misc Preferences to tell Live
that you do want empty scene slots to record under these circumstances.

14.3.3 Overdub Recording MIDI Patterns

Live makes pattern-oriented recording of drums and the like quite easy. Using Live's Impulse
(see Impulse) instrument and the following technique, you can successively build up drum
patterns while listening to the result. Or, using an instrument such as Simpler (see Simpler),
which allows for chromatic playing, you can build up melodies or harmonies, note by note.

1. Set the Global Quantization chooser to one bar.

2. To automatically quantize the notes you are about to record, choose an appro-
priate value for Record Quantization (see Recording Quantized MIDI Notes).

3. Double-click any of the Session View slots in the desired MIDI track (the one
containing the Impulse or other instrument). A new, empty clip will appear in the
slot. The new clip will default to a loop length of one bar, but you can change
that by double-clicking the clip and changing its loop properties (see The Notes
Box).

4. Arm the track.
5. Launch the clip.

6. The notes you play are added into the looping clip, and you can observe your
recording in the Clip View.

7. By default, the Control Bar's Overdub switch is activated, so that you can build
your pattern layer by layer. However, if you would like to pause recording for a
moment to rehearse, you can deactivate the Overdub switch. The contents of
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the clip will continue to play, but you can play along without being recorded.
When you are ready to record again, simply turn on the Overdub switch.

8. Stop recording by pressing a Clip Stop button or the Stop button in the Control
Bar.

Note that holding [Alt (PC)/ (Mac) while double-clicking the empty slot to create
a new clip will implicitly arm the track and launch the clip.

At any time while overdub recording is going on, you can use the Undo command to remove
the last take, or even draw, move or delete notes in the Clip View's Note Editor.

Note that you can also add notes to existing Session clips while the Overdub switch is on.

14.4 Recording in Sync

Live keeps the audio and MIDI you have recorded in sync, even when you later decide on a
different song tempo. In fact, Live allows you to change the tempo at any time before, after
and even during recording. You could, for instance, cheat a bit by turning down the tempo
to record a technically difficult part, and pull it up again afterwards.

It is important to record in sync to make sure everything will later play in sync.

ar 11 |—>= 3 1. 1. 1|0 |®

The easiest way to record in sync is to play along with or to use the built-in metronome,
which is activated via its Control Bar switch and will begin ticking when the Play button is
pressed or a clip is launched.

The Metronome Switch.
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To adjust the metronome volume, use the mixer’s Preview Volume knob.

Notice that Live's metrical interpretation of the audio being played can be edited, at any
time, using the Warp Markers (see Time-Warping Samples). Warp Markers can be used to fix
timing errors and to change the groove or feel of your recordings. Using Warp Markers, you
can fix things in your recordings that would otherwise require complicated editing or could
not be done at all. Likewise, the metrical interpretation of recorded MIDI can be changed
after recording, using the MIDI clip’s Original BPM controls (see The Notes Box).

14.5 Recording Quantized MIDI Notes

If you will be recording MIDI, you have the option of automatically quantizing MIDI notes
while recording. The Record Quantization chooser in the Edit menu allows selecting the
meter subdivisions with which your recorded notes will align. When recording into Session
slots (see Recording Into Session Slots) or into the Arrangement (see Recording Into the
Arrangement), record quantization is an independent step in Live’s Undo history. This
means that if, for example, you recorded with Record Quantization set to “Eighth Note
Triplet Quantization” and then changed your mind, using the Edit menu’s Undo command
would undo only the quantization and leave your recording otherwise intact.

For Session and Arrangement recording, the Record Quantization setting cannot be changed
mid-recording.

The Preview Volume
Knob.
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When overdub recording (see Overdub Recording MIDI Patterns) with the Clip View Loop
activated, changes to the Record Quantization take effect immediately, and they cannot be
separately undone with the Edit menu command.

Recorded MIDI notes can also be quantized post-recording with the Edit menu’s Quantize
command, as described in the chapter on editing MIDI (see Arranging and Quantizing
Notes).

14.6 Recording with Count-in

A count-in for recording can be set in Live's Misc Preferences. When the Count-In preference
is set to any value other than “None,” Live will not begin recording until the count-in is
complete. The Arrangement Position fields in the Control Bar display the count-in in orange
as bars-beats-sixteenths.

The count-in runs from negative bars-beats-sixteenths (beginning at -2.1.1., for example,
with a Count-In setting of 2 bars) up to 1.1.1., at which point recording commences.

Note that count-in recording does not apply when Live is synced to external MIDI devices
or being used as a ReWire slave (see Synchronization and ReWire).

14.7 Setting up File Types

The following Misc Preferences are relevant to the sample files that are created by recording:

The Count-In is
Displayed in the Control
Bar.
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¢ The sample file type you would like Live to create can be chosen from the Record File
Type chooser in the Misc Preferences.

e The bit depth of the sample file you will create by recording can be chosen from the
Record Bit Depth chooser in the Misc Preferences.

e The Audio Record Folder selected in the Misc Preferences is the disk location where
Live will put the samples you record into an unnamed Live Set. When the Live Set is
saved, Live will attempt to move (space permitting) all samples from the temporary
record folder to the saved Live Set’s Sounds folder (see The Sounds Folder and Self-
Containing).

You can save time by setting up reasonable defaults for the clips you are recording in the
Defaults Preferences tab. In particular, it is smart to indicate the rough category of sound
to be recorded by choosing the appropriate default Warp Mode. If you decide later on
a different song tempo, the program will automatically maintain good sound quality (see
Adjusting for Good Stretching Quality), usually without further adjustment.

14.8 Using Remote Control for Recording

Using Key Map Mode and MIDI Map Mode (see MIDI and Key Remote Control), you can
operate Live's recording functions without using the mouse.

You can map the Control Bar's Record and transport controls as well as the track Arm buttons.
For recording into the Session slots, you can map the individual slots as well as the relative
navigation controls to initiate recording remotely; for instance:

2 Audia 3 MiIDi Master

[[Trrain | [CYwini Take | 2

2 i ] Stop Clips

[ L] L] m

The Scene Up/Down
Buttons.
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One key is used to jump to the next scene...
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.. and another key to start and end recording in the respective track.
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A Track Launch Button.



Chapter 15

Working with Instruments and
Effects

Every track in Live can host a number of devices. These devices can be of three different
sorts:

e MIDI effects act upon MIDI signals and can only be placed in MIDI tracks.

e Audio effects act upon audio signals and can be placed in audio tracks. They can also
be placed in MIDI tracks as long as they are “downstream” from an instrument.

e Instruments are devices that reside in MIDI tracks, receive MIDI and output audio.

192
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The Track View is where you insert, view and adjust the devices for the selected track. To
select a track and open the Track View to access its devices, double-click the track’s name.
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The Track View appears in the bottom area of the Live screen.
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Devices in the Track
View.
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15.1 Using the Live Devices
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Click on the Live Device Browser selector to access the palette of Live's built-in devices. You
will notice that MIDI effects, audio effects and instruments each have their own folders in
the Browser.

To place one instance of a device in a track, click on the desired device and drag it into the
Track View of an appropriate track. You can also select a track by clicking on its title bar,
then double-click or press [Return] on a device in the Browser to add it to the selected track.

Note: If you are using an external input signal to feed your Live track using the default
settings, you will need to activate the track’s Arm button in the mixer in order to hear the
input through the devices in your track’s device chain. This is how you would play live
instruments through effects on a track, for example, or use a MIDI keyboard's input to play
a track’s instrument. Note that you can easily move from this setup into recording new
clips (see Recording New Clips) for further use in Live. If you have alternative monitoring
preferences, please see the appropriate manual section (see Monitoring) for information on
how to make these settings.

The Live Device Browser
Selector.
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Play with the device’s controls to change the result, or get more “hands-on” by assigning
device controls to MIDI or key remote control (see MIDI and Key Remote Control). To learn
what a device does and how to operate it, consult the Live Audio Effect Reference chapter
(see Live Audio Effect Reference), Live MIDI Effect Reference chapter (see Live MIDI Effect
Reference) or the Live Instrument Reference chapter (see Live Instrument Reference).

To add another device to the track, simply drag it there or double-click its name to append
it to the device chain. Signal processing travels from left to right on the track.

e You can drop audio effects in at any point in an audio track’s device chain, keeping
in mind that the order of effects determines the resulting sound, as effects on the left
will pass altered signals on to those on the right.

¢ The above also applies to a MIDI track’s device chain.

e If you drop an instrument into a MIDI track’s device chain, signals following (to the
right of) the instrument are now audio signals, available only to audio effects. Signals
preceding (to the left of) the instrument are available only to MIDI effects. This means
that it is possible to have a MIDI track device chain consisting of all three types of
devices: first a MIDI effect, then an instrument, and finally an audio effect.

MIDI and Audio Track
Arm Buttons
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To remove a device from the chain, click on the name and either press your computer’s
Delete or Backspace key, or select Delete from the Edit menu. To change the order of
devices, drag a device by its name and drop it between any of the other devices in the Track
View, or drag it onto another track in the mixer to place the device in that track. Generally,
devices can be placed, reordered and deleted without interrupting the audio stream.

1] 3 ]

1 uto Filter

Devices can be turned on and off using their Activator switches. Turning a device off is like
temporarily deleting it: The signal remains unprocessed, and the device does not consume
CPU cycles. Live devices generally do not load down the CPU unless they are active. For
more information, please refer to the CPU load section (see Managing the CPU Load). Note
that the Freeze Track command mentioned in the CPU load section is especially helpful
when working with CPU-intensive devices.

Devices in Live's tracks have input and output level meters. These meters facilitate finding
a problematic device in the device chain: Low or absent signals will be apparent in the level
meters between devices, and relevant device settings can then be adjusted, or the device
can be turned off or removed. Note that no clipping can occur between devices because

A MIDI Track’s Device
Chain Can Contain All
Three Device Types.

A Device Activator
Switch.
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there is practically unlimited headroom. Clipping can occur when an overly strong signal is
sent to a physical output or written to a sample.

Further information about track types in Live can be found in the Routing and I/O chapter
(see Routing and 1/0), including information on using return tracks to distribute the effect
of a single Live device amongst several tracks. After reading about using devices in Live, it
might also be interesting look into clip envelopes (see Clip Envelopes), which can modulate
individual device settings on a per-clip basis.

15.1.1 Live Device Presets

Every Live device can store and retrieve particular sets of parameter values as presets.

Browsing and Loading Presets

Presets for Live instruments and effects are managed through the Live Device Browser. Each
device in the Browser appears as a folder that can be opened to reveal its presets.
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You can browse and load presets quickly with the computer keyboard:
e Scroll up and down using the and keys.
¢ Close and open device folders using the and keys.

o Use O (PC)/ ® (Mac) to access the context menu, and then select the Close
All Folders option to show only top-level folders. Double-clicking the Device Browser
icon will also close all sub-level folders.

e Press to load a device or preset.

The Browse Presets
Button.
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Clicking the Browse Presets button will temporarily link the Browser to a device, bringing
up the relevant presets in the Browser. With the device and Browser linked in this manner,
you can quickly browse, load and audition different presets. You can even load a different
device to replace the current one by selecting one of the new device’s presets from the
Browser and pressing Return]. To load a device's default factory settings, select the parent
folder of its presets (i.e., the one with the device’s name) from the Device Browser.

The link between the Device Browser and the device will be broken when a different Live
view is selected, or when the Browse Presets button is again pressed.

Note that although importing via the Browser is the recommended method, presets can
also be dropped directly into Live from the Explorer (Windows) / Finder (Mac).

Saving and Organizing Presets

You can create and save any number of your own presets in the Device Browser.

EQ Four '

n -6 n
|| 180 L o || The Preset Save Button.
Click the Preset Save button to save a new preset. You can then confirm Live's suggested

name or type in one of your own.

Note that a preset with unsaved changes is shown in the Device Browser with an asterisk
next to its name.

Presets can be organized in the Browser in a manner similar to files (see File Maintenance in
the Browser):
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e They can be put in sub-folders with the aid of the @ (PC)/ [Ctrl ] (Mac) context
menu's Create Folder command.

e Presets can be moved to different folders within their device's folder by dragging and
dropping, or by copying/cutting and pasting.

e Presets can be renamed using the Edit menu’s Rename command or the (Ctl ]R]

(PC)/ (& ®WR]) (Mac) shortcut.

o To delete a preset, select it and press your computer’s [Delete] key, or use the respective
Edit menu command.

Searching for Presets

Live's search function is available in the Device Browser to help with finding presets by name.

AP |1 1 1 4 o® | EX 2

Clicking the Search button in the upper right corner of the Device Browser or using the

cul J&  JF)(PC)/ & ®/[&  JF) (Mac) shortcut will open the Browser's Search Mode.

Live will search for the contents typed in the Search field throughout the Device Browser.
After entering search criteria, begin the search by pressing on your computer key-
board.

You can abort an in-progress search with the Exit Search button located to the right of the
Search field. A second click on this button closes Search Mode, returning the Browser to

Opening Search Mode
in the Device Browser.
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Browse Mode. Beginning a new search aborts any current searches by default.
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A useful feature of Live's Browser search function is the Locate In Browser button, found to
the right of the Search field. After finding a particular preset in Search Mode, you can select
it and click this button to open the preset in Browse Mode, where its location in the folder
hierarchy will be displayed.
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15.1.2 Device Groups

Device groups allow you to save powerful multi-device creations, effectively adding all the
capabilities of Live’s MIDI and audio effects to Simpler, Impulse and Operator presets.

To create a device group, multi-select any number of devices in the Track View by (& -
clicking on their title bars. Then, select the Edit menu’s Group Devices command, use the
(PC) / (Mac) shortcut, or select “Group Devices” from the @ (PC)/
® (Mac) context menu. The devices will “melt” into one new device.

Exiting Search Mode.

The Locate In Browser
Button.
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The entire device group, along with its component device settings, can be stored as a preset
by clicking its Preset Save button and typing a new name in the Device Browser. Groups
containing an instrument are stored with the respective instrument in the Device Browser;
groups without an instrument appear in the “MIDI Effect Groups” or “Audio Effect Groups”
folders.

Device groups can be browsed, loaded, organized, searched and used just like single-device
presets (see Live Device Presets).

Devices can be ungrouped via the Ungroup Edit menu command, (PC)/
(Mac) shortcut or respective & (PC)/ ® (Mac) context menu command.

15.2 Using Plug-Ins

The collection of devices that you use in Live can be extended with plug-ins. Live supports
Steinberg Media’s VST Plug-ins and Apple Computer’s Audio Units Plug-ins (Mac OS X only).

A Device Group in the
Track View.
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Working with VST and Audio Units Plug-ins is very much like working with Live devices. VST
and Audio Units instruments can only be placed in Live MIDI tracks and, like Live instruments,
they will receive MIDI and output audio signals. Plug-in audio effects can only be placed in
audio tracks or following instruments. Please see the section on working with Live devices
(see Using the Live Devices) for general information about working with devices in Live.
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Audio Units and VST Plug-ins are browsed and imported using the Plug-In Device Browser,
which is accessed via its selector. Plug-in instruments can be differentiated from plug-in
effects in the Browser, as they appear with a keyboard icon.

The Browser’s search functionality is only available for Audio Units Plug-ins, as is loading
presets directly from Track View devices via the Browse button. In some instances, factory
presets for Audio Units will only appear in the Browser once the device has been placed in
a track and its Browse button activated.

Note: The first time you start Live, no plug-ins will appear in the Plug-In Device Browser,
as you must first “activate” your plug-in sources. Activating your plug-in sources tells Live
which plug-ins you want to use and where they are located on your computer. Information
on activating (and deactivating) plug-in sources can be found later in this chapter, by plug-in
type, in the sections on the VST Plug-in folder (see The VST Plug-In Folder) and Audio Units
Plug-ins (see Audio Units Plug-Ins).

The Plug-In Device
Browser and Selector.
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If you install/de-install a plug-in while the program is running, Live will not detect your
changes or implement them in the Plug-In Device Browser until the next time you start the
program. Use the Re-Scan button in the Plug-In Preferences to re-scan your plug-ins while
Live is running, so that newly installed devices become immediately available in the Plug-In
Device Browser.

Hint: You can also use Re-Scan if you believe that your plug-in database has somehow
become corrupted. Holding down the (PC) / (At~ (Mac) modifier while pressing
Re-Scan will delete your plug-in database altogether and run a clean scan of your plug-ins.

15.2.1 Plug-Ins in the Track View
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Once a plug-in is dragged from the Browser into a track, it will show up in the track’s Track
View. The original plug-in panel graphics will be replaced with a Live panel, which will
usually represent all of the plug-in parameters accurately and completely, unless they are
simply too numerous or are not modifiable in real time. When this is the case, the plug-in’s
original editor panel can be opened in a separate window (see Showing Plug-In Panels in
Separate Windows).

A VST Plug-In in the
Track View.
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You can view or hide the VST Plug-in's parameters by toggling the triangle-shaped button
in the plug-in’s title bar.

The X-Y control field can be used to control two plug-in parameters at once and is therefore
especially well-suited for live control. To assign any two plug-in parameters to the Live panel
X-Y field, use the drop-down menus directly beneath it.

Once a plug-in is placed in a track, you can use it just like a Live device:

You can edit all of its parameters and drag it to different locations in the device chain
or to other tracks, according to the rules of audio effects and instruments.

e You can map MIDI-controller messages to its parameters (see MIDI and Key Remote
Control).

e You can modulate its continuous parameters with clip envelopes (see Clip Envelopes).

e You can also use the multiple I/O features of some plug-ins by assigning them as
sources or targets in the routing setup of tracks. See the chapter on routing (see
Routing and I/0) for details.

The Plug-In Unfold
Button.
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15.2.2 Showing Plug-In Panels in Separate Windows

i e S
The Plug-In Edit button opens a floating window that shows the original VST or Audio Units

Plug-in panel. Changing parameters on the floating window has the same effect as changing
them in the Live panel, and vice versa.

There are a few important Plug-In Preference settings for working with plug-in edit windows:

o If activated, the Auto-Open Plug-In Windows Preference assures that plug-in edit
windows open automatically when plug-ins are loaded into tracks from the Browser.

e If the Multiple Plug-In Windows option in the Plug-In Preferences is activated, you can
open any number of plug-in windows at once. Even with this option off, you can hold
down the [Ctl | (PC)/ (& & (Mac) modifier when opening a new plug-in window to
keep the previous window(s) from closing.

e Using the Auto-Hide Plug-In Windows preference, you can choose to have Live display
only those plug-in windows belonging to the track that is currently selected.

You can use the View menu’s Show/Hide Plug-In Windows command or the (Ctl_)(P] (PC)
/ (& B)P) (Mac) shortcut to hide and show your open plug-in windows. Notice that the
name of the track to which the plug-in belongs is displayed in the title bar of the plug-in
editor window.

Macintosh only: The floating VST Plug-in editor windows do not receive computer key
strokes. If it is necessary to type into the plug-in window, for instance for entering a serial
number or unlock code, hold down while clicking the Plug-In Edit button. The editor
window will then appear as a “normal” application window, rather than as a floating window,

The Plug-In Edit Button.
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and receive your typing. Note that this functionality is intended only as a workaround for a
plug-in limitation. We recommend closing the window after you have finished typing, then
reopening it normally before working with the plug-in parameters.

15.2.3 Plug-In Performance Options

The Plug-In Preferences contain a Performance setting for balancing plug-in latency and
performance. Here, you can set the number of samples processed at any one time by the
plug-in. Higher settings may result in a noticeable performance increase but will also result
in higher latencies.

With the “As Audio Buffer” setting selected, the plug-in will calculate the exact number of
samples per millisecond as the computer’s sound card. This setting usually means that very
few dropouts or performance problems will occur, especially with DSP cards.

The size of the computer’s sound card buffer (i.e., the number of samples it calculates per
millisecond) can be set using the Audio Preferences Buffer Size setting.

15.3 VST Plug-Ins

15.3.1 The VST Plug-In Folder

When you start Live for the first time, you will need to activate your VST Plug-in sources
before working with VST Plug-ins. Depending on your computer platform, you may also
have to tell Live about the location of the VST Plug-in folder containing the devices you
want to use. In order to set up your VST sources, press the “Activate” button in the Plug-In
Device Browser, or go to the Plug-In Preferences via the Options menu (or the Live menu in
Mac OS X). There you will find the “Active Sources” section.
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For Windows, proceed as follows:

1. Use the VST Plug-In Custom Folder entry to tell Live about the location of your
VST Plug-ins: Click the Browse button to open a folder-search dialog for locating
and selecting the appropriate folder.

2. Once you have selected a VST Custom Folder and Live has scanned it, the path
will be displayed. Note that, on Windows, Live may have found a path in the
registry without the need for browsing.

3. Make sure that the Use VST Plug-In Custom Folder option is set to “On,” so
that your selected folder is an active source for VST Plug-ins in Live. Note that
you can choose not to use your VST Plug-ins in Live by turning off the Use VST
Plug-In Custom Folder option.

208

Setting up VST Plug-In
Sources for Windows.
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Set up your VST Plug-ins under Mac OS X by doing the following:

1. Your VST Plug-ins will normally be installed in the following folder in your home
and local directories: /Library/Audio/Plug-Ins/VST. You can turn Live's use of
these plug-ins on or off with the Use VST Plug-ins in System Folders option.

2. You may have an alternative folder in which you store your VST Plug-ins (perhaps
those that you use only with Live). You can use VST Plug-ins in this folder in addi-
tion to, or instead of, those in the System folders. To tell Live about the location
of this folder, click the Browse button next to the VST Plug-In Custom Folder

entry to open a folder-search dialog for locating and selecting the appropriate
folder.

3. Note that you can turn off your VST Plug-ins in this folder using the Use VST
Plug-In Custom folder option.

Once you have configured your Plug-In Preferences, the Plug-In Device Browser will display
all plug-ins it finds in the selected VST Plug-in folder(s) as well as any sub-folders.

Itis also possible to use VST Plug-ins stored in different folders on your computer. To do this,
create a Mac OS or Windows alias of the folder where additional VST Plug-ins are stored,
and then place the alias in the VST Plug-In Custom folder (or in the VST Plug-In System
folder on Mac OS X) selected in Live’s Plug-In Preferences. The alias can point to a different

Setting up VST Plug-In
Sources for Mac OS X.
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partition or hard drive on your computer. Live will scan the set VST Plug-in folder as well as
any alias folders contained therein.

Some VST Plug-ins contain errors or are incompatible with Live. During the scanning process,
these may cause the program to crash. When you re-launching Live, a dialog will appear
to inform you about which plug-in caused the problem. Depending on what Live detects
about the plug-in, you may be given the choice between performing another scan or
making the problematic plug-in unavailable. If you choose to re-scan and they crash the
program a second time, Live will automatically make them unavailable, meaning that they
will not appear in the Plug-In Device Browser and will not be re-scanned again until they are
reinstalled.

15.3.2 VST Programs and Banks

Every VST Plug-in instance “owns” a bank of programs. A program is meant to contain one
complete set of values for the plug-in's controls.

U DR | B |

® & VirSynCUBE
WarpVox {hg -

- — The VST Plug-In

A Program Chooser.

To select a program from the plug-in's bank, use the chooser below the title bar. The number
of programs per bank is fixed. You are always working “in” the currently selected program,
that is, all changes to the plug-in's controls become part of the selected program.

Note that VST programs are different from Live device presets LiveDevicePresets (see Live
Device Presets): Whereas the presets for a Live device are shared among all instances and
Live Sets, the VST programs “belong” to this specific instance of the VST Plug-in.
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To rename the current program, select the VST program chooser and execute the Edit
menu’s Rename Plug-In Preset command. Then type in a new program name and confirm
by pressing Return.

e e el
1 2 3

® & VirSynCUBE

VST programs and banks can be imported from files. Clicking the VST Program Load button
brings up a standard file-open dialog for locating the desired file.

Windows only: Please select from the File Type menu whether you want to locate VST
Device Program files or VST Device Bank files.

To save the currently selected program as a file, click the VST Program/Bank Save button to
bring up a standard file-save dialog; select “VST Device Program” from the Format menu
(Macintosh) / from the File Type menu (Windows); select a folder and name. For saving the
entire bank as a file, proceed likewise but choose “VST Device Bank” as a file type/format.

Renaming a VST Plug-In
Program.

The VST Program/Bank
Load Button (Left) and

The VST Program/Bank
Save Button (Right).
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15.4 Audio Units Plug-Ins

Audio Units Plug-ins are only available in Mac OS X. In most respects, they operate just like
VST Plug-ins (see VST Plug-Ins).
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The first time you open Live, Audio Units Plug-ins will not appear in the Plug-In Device
Browser. In order to activate your Audio Units as a plug-in source, please press the “Activate”
button in the Plug-In Device Browser, or go to the Plug-In Preferences via the Live menu.
There you will find the “Active Sources” section. Turning on the Use Audio Units option
activates Audio Units Plug-ins so that they appear in Live’s Plug-In Device Browser.

Note that you can always turn this option off later if you decide not to use Audio Units.

An Audio Units Plug-In.
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Plug-Ins.

Audio Units Plug-ins sometimes have a feature that allows choosing between different
modes for the device. You might be able to choose, for example, between different levels
of quality in the rendering of a reverb. Choosers for these device modes can only be
accessed through the original plug-in panel, which is opened using the Plug-In Edit button.

Uﬂar:apass s W

e — Opening an Audio Units
Plug-In Window.

Audio Units have presets that function just like those for the Live effects (see Live Device
Presets). However, some AU presets cannot be dragged to different locations in the Browser,
as they are read-only.

Audio Units presets have an .aupreset extension and are stored in the following directory
according to their manufacturer's name:

[Home]/Library/Audio/Presets/[Manufacturer Name]/[Plug-in Name]
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15.5 Device Delay Compensation

Live automatically compensates for delays caused by Live and plug-in instruments and
effects, including those on the return tracks. These delays can arise from the time taken by
devices to process an input signal and output a result. The compensation algorithm keeps
all of Live's tracks in sync, regardless of what their devices are doing, while minimizing delay
between the player’s actions and the audible result.

Device delay compensation is on by default and does not normally have to be adjusted in
any way. However, Live Sets that were created with older versions of Live will open without
device delay compensation. To manually turn latency compensation on (or off), use the
Delay Compensation option in the Options menu.

Unusually high individual track delays (see Track Delays) or reported latencies from plug-
ins may cause noticeable sluggishness in the software. If you are having latency-related
difficulties while recording and playing back instruments, you may want to try turning off
device delay compensation, however this is not normally recommended. You may also find
that adjusting the individual track delays is useful in these cases.

Note that device delay compensation can, depending on the number of tracks and devices
in use, increase the CPU load.
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Automation and Editing Envelopes

Often, when working with Live's mixer and devices, you will want the controls’ movements
to become part of the music. The movement of a control across the song timeline is called
automation; a control whose value changes in the course of this timeline is automated.
Practically all mixer and device controls in Live can be automated, including the song
tempo.

16.1 Recording Automation

Creating automation is straightforward: All changes of a control that occur while the Control
Bar's Record switch is on become automation. Try recording automation for a control, for
instance a mixer volume slider. After recording, play back what you have just recorded
to see and hear the effect of the control movement. You will notice that a little LED has
appeared in the slider thumb to indicate that the control is now automated. Try recording

215
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automation for track panning and the Track Activator switch as well; their automation LEDs
appear in their upper left corners.

¥ 2 Chords

Irlr.lmlnnp & 3 Rhodes

Volume, Pan and the
Track Activator Switch
Have Been Automated.

16.2 Deleting Automation

To delete automation data, simply select an automated control by clicking on it, and choose
the Edit menu’s Delete Automation command. The automation LED disappears, and the
control's value stays constant across the entire song. Note that this will not work with
controls that are switches, like the Track Activator switch, because they cannot be selected by
clicking. You can only delete automation for switches by editing their breakpoint envelopes
(see Drawing and Editing Automation).

16.3 Overriding Automation

In practice, you will often want to try out new control moves without overwriting existing
automation data. Well, nothing is forever in the world of infinite Undo (see Non-Destructive
Editing), but it's easy to disable a control’s automation temporarily to avoid overwriting
existing data: If you change an automated control’s value while not in Record Mode, the
automation LED goes off to indicate the control’s automation is inactive. Any automation is
therefore overridden by the current manual setting.
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When one or more of the automated controls in your Live Set are not active, the Control
Bar’s Back to Arrangement button lights up. This button serves two purposes:

1. It reminds you that the current state of the controls differs from the state captured
in the Arrangement.

2. You can click on it to reactivate all automation and thereby return to the automa-
tion state as it is written “on tape.”

16.4 Drawing and Editing Automation

In the Arrangement View, automation curves can be viewed and edited as breakpoint
envelopes.

l[aruminon

An Automation
Envelope in the
s & ]l Arrangement View.
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1. To access a track’s envelope, “unfold” the track by clicking the triangular button
next to the track name.

2. Clicking on one of the track’s mixer or device controls will display this control’s
envelope.

3. The envelope appears “on top of” the audio waveform or MIDI display. Its
vertical axis represents the control value and the horizontal axis represents time.
For switches and radio buttons, the value axis is discontinuous.

4. The Automation Device chooser either selects the track mixer, one of the track’s
devices or “None” to hide the envelope. It also provides you with an overview

of what devices actually have automation by showing an LED next to their labels.

5. The Automation Control chooser selects a control from the device chosen in the
Automation Device chooser. The labels of automated controls have an LED.

16.4.1 Drawing Envelopes

With Draw Mode enabled, you can click and drag to “draw” an envelope curve.

To toggle Draw Mode, select “Draw Mode” from the Options menu, click on the Control

Bar's Draw Mode switch, or press (PC)/ (Mac).

The Draw Mode Switch.
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Drawing an Envelope.

Drawing creates steps as wide as the visible grid, which you can modify using a number of
handy shortcuts (see Using the Editing Grid). For freehand drawing, you can hide the grid
using the Snap to Grid Options menu entry or the (Ctl J{4] (PC)/ (G &)[4) (Mac) shortcut.

16.4.2 Editing Breakpoints

With Draw Mode off, the envelope display looks and works differently. The line segments
and the breakpoints connecting them become draggable objects. Clicking and dragging in
the envelope’s background defines a selection. Here is what you can do:

e Double-click at a position on a line segment to create a new breakpoint there.
e Double-click on a breakpoint to delete it.

e Click and drag a breakpoint to move it to the desired location. If the breakpoint you
are dragging is in the current selection, all other breakpoints in the selection will follow
the movement.
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Your movement is constrained by the neighboring breakpoints unless you hold down
the modifier while dragging, which will eliminate breakpoints as you wipe over
them. Holding down the (PC)/ (Mac) modifier while dragging switches

to a finer resolution.

e Click and drag a line segment between two breakpoints to move it vertically, without
affecting the breakpoint's horizontal position. If the line segment is in the current
selection, the envelope is moved vertically across the selected timespan. Live inserts
breakpoints at the selection’s edges to make sure the move only affects the selected
part of the envelope.

16.4.3 Locking Envelopes

When moving clips, Live normally moves all automation with the clip. Sometimes, you
might want to lock the envelopes to the song position rather than to the clips, and the
Arrangement View's Lock Envelopes switch does just that.

To Move all Breakpoints
Within the Selection,
Drag Any One of Them.

Dragging an Envelope
Line Segment Moves the
Segment Vertically.
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You can also choose to lock envelopes from the Options menu.
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Irlr miloop A 3 Rhodes

16.4.4 Edit Menu Commands

There are a number of useful Edit menu commands for editing envelopes.

To cut or copy automation from a track, independent of the associated clip, use the Edit
menu’s Cut Envelope and Copy Envelope commands, respectively.

To simultaneously copy and paste a selection of envelope into a track’s “future,” use the
Duplicate Envelope command.

Note that Live allows you to copy and paste envelope movements not only from one point
in time to another, but also from one parameter to another. However, there is obviously no
meaningful conversion from a pan movement to, say, an equalizer frequency, and all Live
can do is somehow preserve the gesture.

16.4.5 Editing the Tempo Automation
The ability to dynamically stretch and compress audio to track any tempo or tempo variation
is one of Live’s specialties. In Live, the song tempo is just another automated control.

To edit the song tempo envelope, unfold the Master track, choose “Mixer” from the top
envelope chooser and “Song Tempo” from the bottom one.

The Lock Envelopes
Switch.
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030 040 0:50

When adjusting the tempo envelope, you might want to scale the value axis display, which
is the function of the two value boxes below the envelope choosers: The left box sets the
minimum, and the right box sets the maximum tempo displayed, in BPM.

Note that these two controls also determine the value range of a MIDI controller (see MIDI
Remote Control) assigned to the tempo.

The Tempo Envelope.



Chapter 17

Clip Envelopes

Every clip in Live can have its own clip envelopes. The aspects of a clip that are influenced by
clip envelopes change depending upon clip type and setup; clip envelopes can do anything
from representing MIDI-controller data to modulating device parameters. In this chapter,
we will first look at how all clip envelopes are drawn and edited, and then get into the details

of their various applications.

223
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17.1 The Clip Envelope Editor
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To work with clip envelopes, bring up the Clip View's “Envelopes” box by activating the
rightmost Clip View Box selector panel. The Envelopes box contains two choosers for
selecting an envelope to view and edit.
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The Clip View’s
Envelopes Box.

The top menu is the Device chooser, which selects a general category of controls with which
to work. Device chooser entries are different for different kinds of clips:
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e Audio clips have entries for “Clip” (the clip’s sample controls), every effect in the track’s
device chain and the mixer.

e MIDI clips have entries for “MIDI Ctrl” (MIDI-controller data) and every device in the
track’s device chain.

The bottom menu, the Control chooser, selects among the controls of the item chosen in
the top menu. In both the Device and the Control chooser, you can easily identify the items
that have a non-neutral clip envelope by a little LED appearing next to their names.

The “quick-chooser” buttons below the menus select commonly edited controls.

Clicking the menus or the quick-chooser buttons brings up the Envelope Editor showing
the selected envelope, instead of the Sample Display or MIDI Editor. You can toggle the
display by clicking on the title bars of the “Sample”/ “Notes” and “Envelopes” boxes.

The techniques for drawing and editing clip envelopes are the same as those for automation
envelopes in the Arrangement View (see Drawing and Editing Automation).

If you create a nice section of envelope that you want to have repeat several times, try the
following:

1. Enclose the desired selection in the loop brace, and click the brace so that it is
selected. This will execute the Edit menu’s Select Loop command, which selects
all material in the loop.

2. Copy the envelope with [Ctl][C] (PC)/ (& &(C] (Mac).
3. Shift the loop brace to the right by one loop length with (#].
4. Paste the envelope with (PC)/ (Mac).

Note that you can use the arrow keys to quickly manipulate the loop brace and start/end
markers (see Loop Brace and Start/End Markers) in other useful ways to expedite clip
envelope editing tasks.
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To delete a clip envelope (i.e., to set it back to its default value), first go to Edit / Select All,
then to Edit / Delete.

Let us now look at some uses of clip envelopes.

17.2 Audio Clip Envelopes

Clip envelopes extend Live's “elastic” approach to audio and, in conjunction with Live's
audio effects, turn Live into a mighty sound-design tool. Using clip envelopes with audio
clips, you can create an abundance of interesting variations from the same clip in real time
— anything from subtle corrections to entirely new and unrelated sounds.

17.2.1 Clip Envelopes are Non-Destructive

Using clip envelopes, you can create new sounds from a sample without actually affecting
the sample on disk. Because Live calculates the envelope modulations in real time, you can
have hundreds of clips in a Live Set that all sound different, but use the same sample.

You can, of course, export a newly created sound by rendering (see Exporting Audio),
or by resampling (see Recording New Clips). In the Arrangement View, you can use the
Consolidate command (see Consolidating Clips) to create new samples.

17.2.2 Changing Pitch and Tuning per Note

Drop a sample loop from the Browser into Live and play it. Click on the “Transpose”
envelope quick-chooser button. You can now alter the pitch transposition of individual
notes in the sample as you listen to it.
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The fast way to do this is by enabling Draw Mode (see Drawing Envelopes) and drawing
steps along the grid. Deactivate Draw Mode to edit breakpoints and line segments. This is
useful for smoothing the coarse steps by horizontally displacing breakpoints.

1 12 3 4 15

b

1]

The Transposition
Envelope with Steps
(Top) and Ramps
(Bottom).

Note that the warp settings determine how accurately Live’s time-warping engine tracks
the envelope shape. To obtain a more immediate response, reduce the Grain Size value in
Tones and Texture Mode or choose a smaller value for the Transients control in Beats Mode.

To correct the tuning of individual notes in the sample, hold down the (PC)/
(Mac) modifier while drawing or moving breakpoints to obtain a finer resolution.
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To scroll the display, hold down the (PC)/ Alt =] (Mac) modifier while
dragging.

Pitch is modulated in an additive way. The output of the transposition envelope is simply
added to the “Transpose” control’s value. The result of the modulation is clipped to stay in
the available range (-48..48 semitones in this case).

17.2.3 Muting or Attenuating Notes in a Sample

Click on the "Volume” envelope quick-chooser to access an audio clip’s volume envelope.
By drawing steps in Draw Mode or creating shapes with breakpoints, you can impose an
arbitrary volume shape onto the sample.

1.2 1.3 1.4
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The volume envelope’s output is interpreted as a relative percentage of the clip volume
slider’s current value. The result of the clip envelope’s modulation can therefore never
exceed the absolute volume setting, but the clip envelope can drag the audible volume
down to silence.

P R I U
0:00:500 0:01 0:01:500

Imposing a Volume
Envelope on a Sample.
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17.2.4 Scrambling Beats

One very creative use of clip envelopes is to modulate the sample offset. Sample offset
modulation makes the most sense for rhythmical samples, and is only available for clips that
are set up to run in the “Beats” Warp Mode.

Try sample offset modulation with a one-bar drum loop: Make sure “Beats” Mode is chosen;
in the Envelopes box, choose “Clip” from the Device chooser and “Sample Offset” from the
Control chooser. The Envelope Editor appears with a vertical grid overlay. In envelope Draw
Mode (see Drawing Envelopes), set steps to non-zero values to hear the loop scrambled.
What is going on?

Imagine the audio is read out by a tape head, the position of which is modulated by the
envelope. The higher a value the envelope delivers, the farther away the tape head is from
its center position. Positive envelope values move the head towards the “future,” negative
values move it towards the “past.” Fortunately, Live performs the modulation in beats rather
than centimeters: A vertical grid line is worth a sixteenth note of offset and the modulation
can reach from plus eight sixteenths to minus eight sixteenths.

Sample offset modulation is the tool of choice for quickly creating interesting variations of
beat loops. We discourage using this technique for “analytical” cut-and-splice tasks; they
are much easier to perform using Live's Arrangement View, and the results can easily be
consolidated into new clips (see Consolidating Clips).
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Some sample offset envelope gestures have a characteristic effect: a downward “escalator”
shape, for instance, effectively repeats the step at the envelope’s beginning. Similarly, a
smooth ramp with a downwards slope is slowing time and can create nice slurring effects
when the slope is not quite exactly 45 degrees; try this with a 1/32 Transients setting.

17.2.5 Using Clips as Templates

As you are making creative use of clip envelopes, the clips containing them develop a life
of their own, independent of the original sample. You might wonder at a point: What does
this clip sound like with a different sample? This is easy to find out by selecting the clip
so that it is displayed in the Clip View and dragging the desired sample from one of the
File Browsers, or the Session or Arrangement View, onto the Clip View. All clip settings,
including the envelopes, will remain unaltered; only the sample will be replaced.

Notice this procedure affects only the selected clip, whereas replacing a sample with the
Clip View's Replace button (see Replacing the Clip’s Sample) will affect all clips using that
sample.

Repeating Steps and
Slowing Time with the
Sample Offset Envelope.
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17.3 Mixer and Device Clip Envelopes

Clip envelopes can be used to modulate mixer and device controls. Since mixer and device
controls can also be controlled by the Arrangement’s automation envelopes (see Drawing
and Editing Automation), this is a potential source of confusion. However, clip envelopes
differ from automation envelopes in one important way: Whereas automation envelopes
define the value of a control at any given point in time, clip envelopes can only influence
this defined value. This difference allows the two types of envelopes to work together in
harmony when controlling the same parameter.

Imagine that you have recorded volume automation for an audio clip so that it gradually
fades out over four bars. What happens to your fade-out when you create a clip envelope
that gradually increases the mixer volume over four bars? At first, your fade-out will become
a crescendo, as the clip envelope gradually increases the volume within the range allowed
by the automation envelope. But, once the decreasing automated value meets with the
increasing clip envelope value, the fade-out will begin, as automation forces the absolute
control value (and the operable range of the clip envelope) down.

17.3.1 Modulating Mixer Volumes and Sends

Notice that there are actually two volume modulations: Clip Volume and Mixer Volume.
The latter is a modulation for the mixer’s gain stage and therefore affects the post-effect
signal. To prevent confusion, a small dot below the mixer’s volume slider thumb indicates
the actual, modulated volume setting.

Modulating the Mixer
Volume. The Little Dot
Below the Volume Slider
Thumb Represents the
Modulated Volume
Setting.
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As you raise and lower the Volume slider, you can observe the dot following your movement
in a relative fashion.

Modulating the track’s Send controls is just as easy. Again, the modulation is a relative
percentage: The clip envelope cannot open the send further than the Send knob, but it can
reduce the actual send value to minus infinite dB.

2D

17.3.2 Modulating Pan

The Pan envelope affects the mixer pan stage in a relative way: The pan knob's position
determines the intensity of the modulation. With the pan knob set to the center position,
modulation by the clip envelope can reach from hard left to hard right; the modulation
amount is automatically reduced as you move the pan knob towards the left or right. When
the pan knob is turned all the way to the left, for instance, the pan clip envelope has no
effect at all.

17.3.3 Modulating Device Controls

All devices in a clip’s track are listed in the upper clip envelope Device chooser. Modulating
the devices’ controls works just as you would expect. When modulating device controls, it
is important to keep the interaction of clip envelopes and device settings in mind: Unlike a
device preset (see Using the Live Devices), the clip envelope cannot define the values for
the devices' controls, it can only change them relative to their current setting.

Modulating a Send. The
Send Knob's Position
Ring Indicates the
Modulated Value.
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17.4 MIDI-Controller Clip Envelopes

Whether you are working with a new MIDI clip that was recorded (see Recording New Clips)
directly into Live, or one from your files, Live allows you to edit and create MIDI-controller
data for the clip in the form of clip envelopes.

Choose “"MIDI Ctrl” from a MIDI clip’s Device chooser and use the Control chooser below
it to select a specific MIDI controller. You can create new clip envelopes for any of the
listed controllers by drawing steps or using breakpoints. You can also edit clip envelope
representations of controller data that is imported as part of your MIDI files or is created
while recording new clips: Names of controllers that already have clip envelopes appear
with a little LED in the Control chooser.

Live supports most MIDI-controller numbers up to 119, accessible via the scroll bar on the
right-hand side of the menu. Note that devices to which you send your MIDI-controller
messages may not follow the conventions of MIDI-control channel assignments, so that
“Pitch Bend” or “Pan,” for example, will not always achieve the results that their names

imply.
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Many of the techniques described in the following section on unlinking a clip envelope (see
Unlinking Clip Envelopes From Clips) from its associated clip can be adapted for use with
MIDI-controller clip envelopes.

A MIDI-Controller Clip
Envelope.
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17.5 Unlinking Clip Envelopes From Clips

A clip envelope can have its own local loop/region settings. The ability to unlink the
envelope from its clip creates an abundance of exciting creative options, some of which we
will present in the rest of this chapter.

17.5.1 Programming a Fade-Out for a Live Set

Let us start with a straightforward example. Suppose you are setting up a Live Set and wish
to program a fade-out over eight bars to occur when a specific clip is launched - but all you
have is a one-bar loop.
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1. Choose the Clip Volume envelope, and unlink it from the sample.

The clip envelope’s loop braces now appear colored to indicate this envelope
now has its own local loop/region settings. The loop/region controls in the
Envelopes box “come to life.”

Using a Clip Envelope to
Create a Fade-Out Over
Several Repetitions of a
Loop.
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2. Make sure the clip envelope’s Loop switch is off. Notice the Sample box’s Loop
switch is not affected. The sample will keep looping although the envelope is
now playing as a “one-shot.”

3. Type "8" into the leftmost envelope loop-length value box.

4. Zoom the envelope display out all the way by clicking on the Envelope’s time
ruler and dragging upwards.

5. Insert a breakpoint at the region end and drag it to the bottom (zero percent).
Now, as you play the clip, you can hear the one-bar loop fading out over eight bars.

Please note: toggling Linked Mode changes the envelope data. Toggling back and forth
effectively deletes the envelope data. To return to the previous state, please use the Edit
menu’s Undo command.

17.5.2 Creating Long Loops from Short Loops

Let us take this a step further. For a different part of your set, you would like to use the
same one-bar loop - because it sounds great — but its repetition bores you. You would like
to somehow turn it into a longer loop.

We depart from the clip we just set up to fade out over eight bars. Activate the clip volume
envelope’s Loop switch. Now, as you play the clip, you can hear the eight-bar fade-out
repeating. You can draw or edit any envelope to superimpose onto the sample loop. This,
of course, not only works for volume but for any other control as well; how about a filter
sweep every four bars?

Note that you can create as much time as needed in the Envelope Editor, either by dragging
the loop braces beyond the view limit, or by entering values into the numeric region/loop
controls.
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You can choose an arbitrary loop length for each envelope, including odd lengths like 3.2.1.
It is not hard to imagine great complexity (and confusion!) arising from several odd-length
envelopes in one clip.

u [ L A Anmna e n o S

To keep this complexity under control, it is important to have a common point of reference.
The start marker identifies the point where sample or envelope playback depart from when
the clip starts.

Note that the start/end markers and loop brace are subject to quantization by the zoom-
adaptive grid (see Using the Editing Grid), as is envelope drawing (see Drawing Envelopes).

17.5.3 Imposing Rhythm Patterns onto Samples

So far, we have been talking about imposing long envelopes onto small loops. You can
also think of interesting applications that work the other way around. Consider a sample
of a song that is several minutes long. This sample could be played by a clip with a one-
bar volume envelope loop. The volume envelope loop now works as a pattern that is
repeatedly “punching” holes into the music so as to, perhaps, remove every third beat. You
can certainly think of other parameters that such a pattern could modulate in interesting
ways.

The Sample (Left) and
Envelope (Right) Start
Marker.
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17.5.4 Clip Envelopes as LFOs

If you are into sound synthesis, you may want to think of a clip envelope with a local loop
as an LFO. This LFO is running in sync with the project tempo, but it is also possible to set
up a loop period odd enough to render the envelope unsynchronized. By hiding the grid
(see Using the Editing Grid), you can adjust the clip envelope loop start and end points
completely independent of meter grid.



Chapter 18

Live Audio Effect Reference

Live comes with a selection of custom-designed, built-in audio effects. The “Working with
Instruments and Effects” chapter (see Working with Instruments and Effects) explains the
basics of using effects in Live.

238
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18.1 Auto Filter
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The Auto Filter effect provides classic analog filter emulation. It can be modulated by an
envelope follower and/or an LFO to create moving filter effects.

There are four different filter types: low-pass, high-pass, band-pass and notch. For each
type, the X-Y controller adjusts frequency (to adjust, click and drag on the X-axis) and Q
(also called resonance; to adjust, click and drag on the Y-axis). You can also click on the Freq
and Q numeric displays and type in exact values.

Low Q values create a broad filter curve, while higher values introduce a narrow, resonant
peak to the sound. With band-pass filtering, Q sets the bandwidth of the passed signal.

The Quantize Beat control applies quantized modulation to the filter frequency. With Quan-
tize Beat off, frequency modulation follows the control source. Turning this feature on
updates the filter modulation rhythmically with “stepped” changes that track the master
tempo. The numbered buttons represent 16th notes, so, for example, selecting “4” as a
beat value produces a modulation change once per beat.

The Envelope section controls how the envelope modulation affects the filter frequency.
The Amount control defines the extent to which the envelope affects the filter frequency,

The Auto Filter Effect.
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while the Attack control sets how the envelope responds to rising input signals. Low Attack
values cause a fast response to input levels; high values integrate any changes gradually,
creating a looser, slower response. Think of it as adding inertia to the response.

Lower Release values cause the envelope to respond more quickly to falling input signals.
Higher values extend the envelope’s decay.

The Auto Filter also contains a Low Frequency Oscillator to modulate filter frequency in a
periodic fashion. The respective Amount control sets how much the LFO affects the filter.

The Rate control specifies the LFO speed. It can be set in terms of hertz, or synced to the
project tempo and set in terms of meter subdivisions. The second option allows for creating
controlled rhythmic filtering.

Available LFO waveform shapes are sine (creates smooth modulations with rounded peaks
and valleys), square, triangle, sawtooth up, sawtooth down, and sample and hold (generates
random positive and negative modulation values) in mono and stereo.

There are two LFOs, one for each stereo channel. The Phase and Offset controls define the
relationship between these two LFOs.

Phase keeps both LFOs at the same frequency, but can set the two LFO waveforms “out of
phase” with each other, creating stereo movement. Set to “180", the LFO outputs are 180
degrees apart, so that when one LFO reaches its peak, the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each stereo channel is modulated
at a different frequency, as determined by the Spin amount.

For sample and hold, the Phase and Spin controls are not relevant and do not affect the
sound. Instead, the Auto Filter offers two kinds of sample and hold: The upper sample and
hold type available in the chooser provides independent random modulation generators for
the left and right channels (stereo), while the lower one modulates both channels with the
same signal (mono).
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18.2 Auto Pan
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Auto Pan offers LFO-driven manipulation of amplitude and panning for creating automatic
panning, tremolo and amplitude modulation, and beat-synchronized chopping effects.

Auto Pan’s LFOs modulate the amplitude of the left and right stereo channels with sine,
triangle, sawtooth down or random waveforms.

The Shape control pushes the waveform to its upper and lower limits, “hardening” its shape.
The waveform can be set to “Normal” or “Invert” (use “Invert” to, for example, create the
saw up waveform from the saw down waveform).

Auto Pan’s LFO speed is controlled with the Rate control, which can be set in terms of hertz.

Rate can also be synced with the project tempo and set in meter subdivisions (e.g., sixteenth
notes).

Though both LFOs run at the same frequency, the Phase control lends the sound stereo
movement by offsetting their waveforms relative to each other. Set this to “180”, and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum. Phase is particularly effective for creating vibrato effects.

The Offset control shifts the start point of each LFO along its waveform.

The Auto Pan Effect.
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The device's influence on incoming signals is set with the Amount control.

18.3 Beat Repeat
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Beat Repeat allows for the creation of controlled or randomized repetitions of an incoming
signal.

The Interval control defines how often Beat Repeat captures new material and begins re-
peating it. Interval is synced with and set in terms of the project tempo, with values ranging
from “1/32" to “4 Bars.” The Offset control shifts the point defined by Interval forward in
time. If Interval is set to “1 Bar,” for example, and Offset to “8/16"”, material will be captured
for repetition once per bar on the third beat (i.e., halfway, or eight-sixteenths of the way,
through the bar).

You can add randomness to the process using the Chance control, which defines the likeli-
hood of repetitions actually taking place when Interval and Offset “ask” for them. If Chance
is set to “100%", repetitions will always take place at the given Interval/Offset time; if set to
"0%", there will be no repetitions.

The Beat Repeat Effect.
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Gate defines the total length of all repetitions in sixteenth notes. If Gate is set to "4/16",
the repetitions will occur over the period of one beat, starting at the position defined by
Interval and Offset.

Activating the Repeat button bypasses all of the above controls, immediately capturing
material and repeating it until deactivated.

The Grid control defines the grid size — the size of each repeated slice. If set to “1/16", a
slice the size of one sixteenth note will be captured and repeated for the given Gate length
(or until Repeat is deactivated). Large grid values create ryhthmic loops, while small values
create sonic artifacts. The No Triplets button sets grid division as binary.

Grid size can be changed randomly using the Variation control. If Variation is set to “0”,
grid size is fixed. But when Variation is set to higher values, the grid fluctuates considerably
around the set Grid value. Variation has several different modes, available in the chooser
below: Trigger creates variations of the grid when repetitions are triggered; 1/4, 1/8 and
1/16 trigger variations in regular intervals; and Auto forces Beat Repeat to apply a new
random variation after each repetition — the most complex form of grid variation in Beat
Repeat (especially if triplets are also allowed).

Beat Repeat's repetitions can be pitched down for special sonic effects. Pitch is adjusted
through resampling in Beat Repeat, lengthening segments to pitch them down without again
compressing them to adjust for the length change. This means that the rythmical structure
can become quite ambiguous with higher Pitch values. The Pitch Decay control tapers the
pitch curve, making each repeated slice play lower than the previous one. Warning: This is
the most obscure parameter of Beat Repeat.

Beat Repeat includes a combined low-pass and high-pass filter for defining the passed
frequency range of the device. You can turn the filter on and off, and set the center
frequency and width of the passed frequency band, using the respective controls.

The original signal (which was received at Beat Repeat’s input) is mixed with Beat Repeat’s
repetitions according to one of three mix modes: Mix allows the origial signal to pass
through the device and have repetitions added to it; Insert mutes the original signal when
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repetitions are playing but passes it otherwise; and Gate passes only the repetitions, never
passing the original signal. Gate mode is especially useful when the effect is housed in a
return track.

You can set the output level of the device using the Volume control, and apply Decay to
create gradually fading repetitions.

18.4 Chorus
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The Chorus effect uses two parallel time-modulated delays to create chorus (thickening) and
flanging effects.

Each delay has its own delay time control, calibrated in milliseconds. Delay 1 has a high-pass
filter that can remove low frequencies from the delayed signal. Greater high-pass values let
only very high frequencies pass through to Delay 1.

Delay 2 can switch among three different modes. When off, only Delay 1 is audible. In Fix
Mode, only Delay 1's delay time will be modulated. When Mod is activated, Delay 2 will
receive the same modulation as Delay 1.

The Chorus Effect.
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To set both delay lines to Delay 1's delay time, turn on the link button ("= "). This is especially
useful if you want to change both delays with a single gesture.

The Modulation X-Y controller can impart “motion” to the sounds. To change the modula-
tion rate for the delay times, click and drag along the horizontal axis. To change the amount
of modulation, click and drag along the vertical axis.

You can also make changes by entering parameter values in the Amount and Rate fields be-
low the X-Y controller. The Amount value is in milliseconds, while the modulation frequency
rate is in Hertz.

Clicking the *20 switch multiplies the modulation frequency by 20 to achieve more extreme
sounds.

The Feedback control determines how much of the output signal feeds back into the input,
while the Polarity switch sets (surprisel) the polarity. Polarity changes have the most effect
with high amounts of feedback and short delay times.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
wet only if using the Chorus in a return channel.
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A Compressor reduces gain for signals above a user-settable threshold. Compression re-
duces the levels of peaks, opening up more headroom and allowing the overall signal level
to be turned up. This gives the signal a higher average level, resulting in a sound that is
subjectively louder and “punchier” than an uncompressed signal.

The two most important parameters are the Threshold and the compression Ratio:

The Threshold slider sets where compression begins. Signals below the threshold are not
processed. Signals above the threshold are attenuated by an amount specified by the Ratio
parameter, which sets the ratio between the input and output signal. For example, with a
compression ratio of 3:1, if a signal above the threshold increases by 3 dB, the compressor
output will increase by only 1 dB. If a signal above the threshold increases by 6 dB, then the
output will increase by only 2 dB.

The red gain-reduction meter shows how much the gain is being reduced at any given
moment. The more reduction, the more audible the effect; a gain reduction above 6 dB
or so might produce the desired loudness, but significantly alters the sound and is easily
capable of destroying its dynamic structure. This is something that cannot be undone in
later production steps. Keep this in mind especially when using a compressor, limiter or

The Compressor | Effect.
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sound loudness-maximizing tool in the master channel. Less is often more here.

Because compression reduces the volume of loud signals and opens up headroom, you can
use the Out(put) slider so that the peaks once again hit the maximum available headroom.
The Output meter shows the output signal’s level.

A second set of two essential parameters defines how fast a compressor reacts to input-level
changes: Attack time and Release time.

Attack defines how long it takes to reach maximum compression once a signal exceeds
the threshold, while Release sets how long it takes for the compressor to return to normal
operation after the signal falls below the threshold.

A slight amount of attack time (5-10 ms) allows peaks to come through unprocessed,
which helps preserve dynamics. If these peaks cause overloads, you can try shortening the
attack time, but extremely short times take the “life” out of the signal, and may lead to a
slight “buzziness” caused by distortion. Short release times can cause “pumping” as the
compressor tries to figure out whether to compress or not; while generally considered an
undesirable effect, some engineers use it on full drum kits to give unusual “sucking” effects.
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Compressor |l is a state of the art compression unit — the tool of choice for a wide range of
dynamic processing applications including limiting and loudness maximization. Compressor
II's design is a lot more sophisticated and capable than Compressor I's. It includes frequency-
selective compression using a sidechain EQ, variable look-ahead times and two response
modes, Peak and RMS. Compressor | is still a valuable sound design tool in spite of, or rather
because of, its simplicity and roughness, which can add interesting flavors to your sounds.

A compressor can only react to an input signal once it occurs. Since it also needs to apply
an attack/release envelope, the compression is always a bit too late. A digital compressor
can solve this problem by simply delaying the input signal a little bit. Compressor Il offers
three different predelay times: zero ms, one ms and ten ms. The results may sound pretty
different depending on this setting. Keep in mind that using ten ms of predelay makes the
output appear significantly later. You may have to delay other tracks with a Simple Delay in
order to stay in sync.

Comepressor Il can either react to short peaks within a signal or to something that is more
related to how people perceive loudness. The parameter for this is the “Peak/RMS” switch.
If you intend to use Compressor |l as a limiter in the master section, “Peak” is probably

The Compressor Il
Effect.
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better since it reacts more to the actual signal level, while “RMS” is usually more musical.
But as always if it comes to compression, trust your ears and not the meter!

The most exotic feature of Compressor Il is the sidechain EQ. The “sidechain” is the part of
the signal that is used to control the compressor. Normally the sidechain signal is the same
as the input signal. However, it can make sense to apply some filtering here. Imagine a bass
drum, a snare and some chords in the background. The bass drum has a pretty high level
and it will normally determine how the compressor reacts. If you now turn the side chain EQ
on and set its Frequency to 100 Hz and the Gain to -15 dB, the bass drum will not influence
the compression anymore and the behavior of the compressor will be very different. You
could also set the Frequency to around 1 kHz and turn up the gain to make the compressor
more responsive to the snare. Since the EQ is only in the sidechain and not part of the
normal signal path, it will not change the sound of the input signal. It only changes how the
compressor reacts to different frequencies of the input.

Unlike Compressor |, Compressor Il has a built-in compensation stage that counteracts the
gain loss due to the compression and makes it much easier to adjust the other parameters.

Careful adjustment of attack and release times is essential when it comes to compression of
rhythmical sources. If you are not used to working with compressors, play a drum loop and
spend some time adjusting Attack, Release, Threshold and Gain. It can be very exciting!
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If you have ever used a good DJ mixer you will know what this is: An EQ that allows you to
adjust the level of low, mid and high frequencies independently.

Each band can be adjusted from -infinite dB to +6 dB using the gain controls. This means
that you can completely remove, for example, the bass drum or bassline of a track, while
leaving the other frequencies untouched.

You can also turn on or off each band using the On/Off buttons located under the gain
controls. These buttons are especially handy if assigned to computer keys...

EQ Three gives you visual confirmation of the presence of a signal in each frequency band
using three green LEDs. Even if a band is turned off, you can see if there is something going
on in it. The internal threshold for the LEDs is set to -24 dB.

The frequency range of each band is defined via two crossover controls: FreglLo and FregHi.
If Freglo is set to 500 Hz and FreqHi to 2000 Hz, then the low band goes from 0 hz to 500
Hz, the mid band from 500 Hz to 2000 Hz and the high band from 2000 Hz up to what ever
your soundcard or sample rate supports.

A very important control is the 24 dB / 48 dB switch. It defines how sharp the filters are

The EQ Three Effect.
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cutting the signal at the crossover frequency. The higher setting results in more drastic
filtering, but needs more CPU.

Note: The filters in this device are optimized to sound more like a good, powerful analog
filter cascade than a clean digital filter. The 48 dB Mode especially does not provide a
perfect linear transfer quality, resulting in a slight coloration of the input signal even if all
controls are set to 0.00 dB. This is typical behavior for this kind of filter, and is part of EQ
Three's unique sound. If you need a more linear behavior choose 24 dB Mode or use the
EQ Four.

18.8 EQ Four

The EQ Four effect is an equalizer composed of four parametric filters. Equalizers are useful
for changing a sound’s timbre.

Filter One can switch among three responses: bell-curve (boosts or cuts over a range
of frequencies), low-shelf (boosts or cuts frequencies lower than the specified frequency)
or low-cut (cuts frequencies below the specified frequency). Filters Two and Three are
always bell-curves. Filter Four can switch among bell-curve, high-shelf (boosts or cuts

The EQ Four Effect.
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frequencies higher than the specified frequency) or high-cut (cuts frequencies above the
specified frequency) modes. Each filter band can be turned on or off independently. Turn
off bands that aren't in use to save CPU power.

To edit the filter curve, click and drag on one of the filter dots in the XY View. Horizontal
movement changes the filter frequency, while vertical movement adjusts the filter band’s
gain. To adjust the filter Q (also called resonance or bandwidth), hold down the [Alt ] (PC)
/ (Mac) modifier while dragging the mouse.

You can also use the numbered filter selector buttons to select a band for editing, then edit
parameter values with the Freq, Gain and Q dials (and/or type values into the number fields
below each dial).

To achieve really drastic filtering effects, assign the same parameters to two or more filters,
or use more than one EQ Four.

As boosting will increase levels and cutting will decrease levels, use the Gain slider to
optimize the output level for maximum level consistent with minimum distortion.

18.9 Erosion
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The Erosion Effect.
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The Erosion effect degrades the input signal by modulating a short delay with filtered noise
or a sine wave. This adds noisy artifacts or aliasing/downsampling-like distortions that sound
very “digital.”

To change the sine wave frequency or noise band center frequency, click and drag along
the X-axis in the XY field. The Y-axis controls the modulation amount. If you hold down the
(PC)/ (Mac) modifier key while clicking in the XY field, the Y-axis controls the
noise bandwidth.

The Frequency control determines the color, or quality, of the distortion. If the Mode control
is set to Noise, this works in conjunction with the Width control, which defines the noise
bandwidth. Lower values lead to more selective distortion frequencies, while higher values
affect the entire input signal. Width has no effect in Sine Mode.

Noise and Sine use a single modulation generator. However, Wide Noise has independent
noise generators for the left and right channels, which creates a subtle stereo enhancement.

18.10 Filter Delay
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The Filter Delay Effect.
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The Filter Delay provides three independent delay lines, each preceded by linked low-pass
and high-pass filters. This allows applying delay to only certain input signal frequencies, as
determined by the filter settings. The feedback from each of the three delays is also routed
back through the filters.

Each of the three delays can be switched on and off independently. The Filter Delay plug-in
assigns delay 1 to the input signal’s left channel, delay 2 to the left and right channels and
delay 3 to the right channel. The Pan controls at the right can override the delay channels’
outputs; otherwise each delay outputs on the channel from which it derives its input.

Each delay channel’s filter has an associated On switch, located to the left of each XY
controller. The XY controllers adjust the low- and high-pass filters simultaneously for each
delay. To edit filter bandwidth, click and drag on the vertical axis; click and drag on the
horizontal axis to set the filter band’s frequency.

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting “4" delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. With Sync Mode active, changing the Delay Time field
percentage value shortens and extends delay times by fractional amounts, thus producing
the “swing” type of timing effect found in drum machines.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the Delay Time field, or click in the field and type in a
value.

Feedback controls how much of the output signal returns to the delay line input. Very high
values can lead to runaway feedback and produce a loud oscillation — watch your ears and
speakers if you decide to check out extreme feedback settings!

Each delay channel has its own volume control, which can be turned up to +12 dB to
compensate for drastic filtering at the input.

The Dry control adjusts the unprocessed signal level. Set it to minimum if using the Delay
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in a return channel.
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The Flanger Effect.

Flanger uses two parallel time-modulated delays to create flanging effects.

Flanger's delays can be adjusted with the Delay Time control. The Feedback control sends
part of the output signal back through the device input, while the Polarity switch (“+" or
“-") sets the polarity. Delay Time and Feedback can be changed simultaneously using the
effect’s X-Y controller.

Periodic control of delay time is possible using the envelope section. You can increase or
decrease the envelope amount (or invert its shape with negative values), and then use the
Attack and Release controls to define envelope shape.

Flanger contains two LFOs to modulate delay time for the left and right stereo channels.
LFOs can have six possible waveform shapes: sine, square, triangle, sawtooth up, sawtooth
down and random. The extent of LFO influence on the delays is set with the Amount control.

Flanger's LFO speed is controlled with the Rate control, which can be set in terms of hertz.
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Rate can also be synced with the project tempo and set in meter subdivisions (e.g., sixteenth
notes).

The Phase control lends the sound stereo movement by setting the LFOs to run at the same
frequency, but offsetting their waveforms relative to each other. Set this to “180", and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each delay is modulated at a
different frequency, as determined by the Spin amount.

Adjusting the HiPass control will cut low frequencies from the delayed signal.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
"100%" if using Flanger in a return track.

18.12 Gate
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The Gate effect passes only signals whose level exceeds a user-specified Threshold. A gate
can eliminate low-level noise that occurs between sounds (e.g., hiss or hum), or shape a

The Gate Effect.
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sound by turning up the threshold to where it cuts off reverb or delay tails or truncates an
instrument’s natural decay.

The Threshold slider sets the gate’s sensitivity. If the gate is open and passing signal (i.e.,
the signal exceeds the gate threshold), the green LED lights.

The Floor parameter located above the threshold fader can allow attenuating signals below
the threshold rather than just cutting them off. If set to -inf dB, a closed gate will mute the
input signal. A setting of 0.00 dB means that even if the gate is closed, there is no effect
on the signal. Settings in between these two extremes attenuate the input to a greater or
lesser degree when the gate is closed.

The Attack time determines how long it takes for the gate to switch from closed to open
when a signal goes from below to above the threshold. Very short attack times can produce
sharp clicking sounds, while long times soften the sound’s attack.

When the signal goes from above to below the threshold, the Hold time kicks in. (Note
to tech heads: the gate has hysteresis, so the release occurs about 3 dB lower than the
threshold.) After the hold time expires, the gate closes over a period of time set by the
Release parameter.
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18.13 Grain Delay
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The Grain Delay effect slices the input signal into tiny particles (called “grains”) that are then
individually delayed and can also have different pitches compared to the original signal
source. Randomizing pitch and delay time can create complex masses of sound and rhythm
that seem to bear little relationship to the source. This can be very useful in creating new
sounds and textures, as well as getting rid of unwelcome house guests, or terrifying small
pets (just kidding!).

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting “4" delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. With Sync Mode active, changing the Delay Time field
percentage value shortens and extends delay times by fractional amounts, thus producing
the “swing” type of timing effect.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the Delay Time field, or click in the field and type in a
value.

You can route each parameter to the XY controller’s horizontal or vertical axis. To assign a

The Grain Delay Effect.
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parameter to the X-axis, choose it from the parameter row below the controller. To assign a
parameter to the Y-axis, use the parameter row on the left side.

The Feedback parameter sets how much of the output signal returns to the delay line input.
Very high values can lead to runaway feedback and produce a loud oscillation — watch your
ears and speakers if you decide to check out extreme feedback settings!

You can transpose the grain pitch with the Pitch parameter, which acts much like a crude
pitch shifter.

The Spray control adds random delay time changes. Low values smear the signal across
time, which adds “noisiness” to the sound. High Spray values completely break down the
structure of the source signal, introducing varying degrees of rhythmical chaos. This is the
recommended setting for anarchists.

The Random Pitch control adds random variations to each grain’s pitch. Low values create
a sort of mutant chorusing effect, while high values can make the original source pitch
completely unintelligible. This parameter can interact with the main Pitch control, thus
allowing degrees of stability and instability in a sound’s pitch structure.

The size and duration of each grain is a function of the Frequency parameter. The sound of
Pitch and Spray depends very much on this parameter.

Grain Delay now also has a dry/wet control; it can be routed to the vertical axis of the XY
controller.
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Phaser uses a series of all-pass filters to create a phase shift in the frequency spectrum of a
sound.

The Poles control creates notches in the frequency spectrum. The Feedback control can
then be used to invert the waveform and convert these notches into peaks (or poles). Filter
cutoff frequency is changed with the Frequency control, which can be adjusted in tandem
with Feedback using the effect's X-Y controller.

The device has two modes, Space and Earth, for changing the spacing of notches along the
spectrum, and hence the “color” of the sound. This effect can be further adjusted with the
Color control.

Periodic control of the filter frequency is possible using the envelope section. You can
increase or decrease the envelope amount (or invert its shape with negative values), and
then use the Attack and Release controls to define envelope shape.

Phaser contains two LFOs to modulate filter frequency for the left and right stereo channels.
LFOs can have six possible waveform shapes: sine, square, triangle, sawtooth up, sawtooth
down and random. The extent of LFO influence on the filter frequency is set with the

The Phaser Effect.
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Amount control.

LFO speed is controlled with the Rate control, which can be set in terms of hertz. Rate can
also be synced with the project tempo and set in meter subdivisions (e.g., sixteenth notes).

The Phase control lends the sound stereo movement by setting the LFOs to run at the same
frequency, but offsetting their waveforms relative to each other. Set this to “180", and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each filter frequency is then
modulated using a different LFO frequency, as determined by the Spin amount.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
“100%" if using Phaser in a return track.

18.15 Ping Pong Delay
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The Ping Pong Delay effect uses a single tapped delay line to create a delay that jumps
from the left to the right output.

The Ping Pong Delay
Effect.
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The delay is preceded by a low- and high-pass filter that can be controlled with an XY
controller. To define the filter bandwidth, click and drag on the vertical axis. To set the
position of the frequency band, click and drag on the horizontal axis.

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting “4" delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. This delay time represents the time it takes for the input
signal to appear at the left channel. The delay time between the input and the right channel
is twice as long.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the time field, or click in the field and type in a value.

The Feedback parameter controls how much of the right channel output signal returns to
the delay line input. The feedback loop also includes a filter that can color the feedback
sound, thus producing different timbres with successive echoes.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
full wet if using the Ping Pong Delay in a return channel.
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Saturator is a distortion effect that can add that missing dirt, punch or warmth to your sound.

Incoming signals are clipped to the Drive control’s setting in dB. Signal clipping has several
modes: Clip, Soft, Medium, Hard and Sine. In Clip mode, the signal is clipped completely
and immediately. Soft, Medium and Hard modes soften signal clipping to varying degrees.
Sine mode can be used for special effects.

The meter in the display will show how much Saturator is influencing a signal.

Activating the Color button enables two filters. The first of these, controlled with the Base
control, dictates how much the effect will be reduced or increased for very low frequencies.
The second filter, essentially an equalizer, is used for controlling higher frequencies. It is
shaped with the Freq (cutoff frequency), Width and Depth controls.

The Output control reduces or increases the level at the device output. The signal at the
device input can be amplified using the Drive control.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
full wet if using the Saturator in a return channel.

The Saturator Effect.
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18.17 Simple Delay
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The Simple Delay provides two independent delay lines, one for each channel (left and
right).

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting “4" delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. If the Sync switch is off, the delay time reverts to milliseconds.
In this case, to edit the delay time, click and drag up or down in the Delay Time field, or
click in the field and type in a value.

The Feedback parameter defines how much of each channel’s output signal feeds back into
the delay lines’ inputs. Internally there are two independent feedback loops, so a signal on
the left channel does not feed back into the right channel and vice versa.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
full wet if using the Simple Delay in a return channel.

The Simple Delay Effect.
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18.18 Vinyl Distortion
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The Vinyl Distortion effect emulates some of the typical distortions that occur on vinyl records
during playback. These distortions are caused by the geometric relationships between the
needle and the recorded groove. The effect also features a crackle generator for adding
noisy artifacts.

The Tracing Model section adds even harmonic distortion to the input signal. Adjust the
amount of distortion with the Drive knob, or click and drag vertically in the Tracing Model XY
window. To adjust the distortion’s frequency or “color,” drag horizontally in the XY window
or double-click on the Freq field and type in a value. Holding the (PC) /
(Mac) modifier while dragging vertically in the XY window changes the frequency band’s Q
(bandwidth).

The Pinch Effect section adds odd harmonics to the input signal. These distortions typically
occur 180 degrees out of phase, creating a richer stereo image. The Pinch Effect has the
same controls as the Tracing Model, but generates a rather different sound.

The Drive control increases or decreases the overall distortion amount created by both the
Tracing Model and Pinch.

The Vinyl Distortion
Effect.
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There are two distortion modes: soft and hard. The soft mode simulates the sound of a dub
plate, while hard mode is more like that of a standard vinyl record.

The stereo/mono switch determines whether the Pinch distortion occurs in stereo or mono.
Set it to stereo for realistic simulation of vinyl distortions.

The Crackle section adds noise to the signal, with noise density set by the Density control.
The Volume control adjusts the amount of gain applied to the noise.

18.19 Redux
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The Redux Effect.

Nostalgic for the famed low-resolution sound quality of the Ensonig Mirage, Fairlight CMI
or Commodore-64 computer? Redux returns us to the Dark Ages of digital by reducing a
signal’s sample rate and bit resolution.

The Downsample section has two parameters: “Downsample” and a downsample Mode
switch.

If the downsample dial is set to “1", every input sample passes to the output and the signal
does not change. If set to “2", only every second sample will be processed, so the result
sounds a bit more “digital.” The higher the number, the lower the resulting sample rate,
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and the more “deconstructed” the sound. Downsampling is like applying a mosaic effect
to an image: There's a loss of information and sharp edges occur between the blocks.

The Downsample Mode switch defines if the downsampling either interpolates over a smaller

range (“soft,” down to 20.0 samples) or does not interpolate over a larger range (“hard,”
down to 200 samples).

Bit Reduction is similar, but while downsampling superimposes a grid in time, bit reduction
does the same for amplitude.

If the Bit Reduction amplitude dial is set to 8, amplitude levels are quantized to 256 steps
(8 bit resolution). If set to 1, the result is pretty brutal: Each sample contains either a full
positive or full negative signal, with nothing in between.

Bit Reduction defines an input signal of 0dB as 16 bit. Signals above 0dB are clipped, and
the red overload LED will light up.

Turning off Bit Reduction results in modest CPU savings.

18.20 Resonators
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The Resonators Effect.
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This device consists of five parallel resonators that superimpose a tonal character on the
input source. It can produce sounds resembling anything from plucked strings to vocoder-
like effects. The resonators are tuned in semitones, providing a musical way of adjusting
them. The first resonator defines the root pitch and the four others are tuned relative to this
pitch in musical intervals.

The input signal passes first through a filter, and then into the resonators. There are four
input filter types to select from: low-pass, band-pass, high-pass and notch. The input filter
frequency can be adjusted with the Frequency parameter.

The first resonator is fed with both the left and right input channels, while the second and
fourth resonators are dedicated to the left channel, and the third and fifth to the right
channel.

The Note parameter defines the root pitch of all the resonators ranging from C1 to C5.
It can also be detuned in cents using the Fine parameter. The Decay parameter lets you
adjust the amount of time it takes for the resonators to be silent after getting an input signal.
The longer the decay time, the more tonal the result will be, similar to the behavior of an
undamped piano string. As with a real string, the decay time depends on the pitch, so low
notes will last longer than higher ones. The Const switch holds the decay time constant
regardless of the actual pitch.

Resonators provides two different resonation modes. Mode A provides a more realistic
sounding resonation, while Mode B offers an effect that is especially interesting when
Resonator I's Note parameter is set to lower pitches.

The brightness of the resulting sound can be adjusted using the Color control.

All of the resonators have an On/Off switch and a Gain control. A resonator that is turned
off does not need CPU. Turning off the first resonator does not affect the other ones.

Resonators Il through V follow the Note parameter defined in Resonator |, but they can each
be individually transposed +/- 24 semitones using the Pitch controls and detuned in cents
using the Detune controls.
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The output section features the obligatory Dry/Wet control and a Width parameter that
affects only the wet signal and blends the left and right outputs of Resonators -V into a
mono signal if set to zero.

18.21 Reverb
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18.21.1 Input Processing

The input signal passes first through high and low cut filters, whose X-Y controller allows
changing the band’s center frequency (X-axis) and bandwidth (Y-axis). Either filter may be
switched off when not needed to save CPU power.

Predelay controls the delay time, in milliseconds, before the onset of the first early reflection.
This delays the reverberation relative to the input signal. One's impression of the size of a

real room depends partly on this delay. Typical values for “natural” sounds range from 1ms
to 25ms.

The Reverb Effect.
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18.21.2 Early Reflections

These are the earliest echoes that you hear after they bounce off a room’s walls, before
the onset of the diffused reverberation “tail.” Their amplitude and distribution give an
impression of the room’s character.

|u

The Shape control “sculpts” the prominence of the early reflections, as well as their overlap
with the diffused sound. With small values, the reflections decay more gradually and the
diffused sound occurs sooner, leading to a larger overlap between these components. With
large values, the reflections decay more rapidly and the diffused onset occurs later. A
higher value can sometimes improve the source’s intelligibility, while a lower value may give
a smoother decay.

Spin applies modulation to the early reflections. The 2-D control accesses the depth and
frequency of these modulations. A larger depth tends to provide a less-colored (more
spectrally neutral) late diffusion response. If the modulation frequency is too high, doppler
frequency shifting of the source sound will occur, along with surreal panning effects. Spin
may be turned off, using the associated switch, with modest CPU savings.

18.21.3 Global Settings

The Quality chooser controls the tradeoff between reverb quality and performance. Econ-
omy mode uses minimal CPU resources, while First Class delivers the richest reverberation.

The Size parameter controls the “room’s” volume. At one extreme, a very large size will
lend a shifting, diffused delay effect to the reverb. The other extreme, a very small value,
will give it a highly colored, metallic feel.

The Stereo Image control determines the width of the output’s stereo image. At the highest
setting of 120 degrees, each ear receives a reverberant channel that is independent of the
other (this is also a property of the diffusion in real rooms). The lowest setting mixes the
output signal to mono.
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18.21.4 Diffusion Network

The Diffusion network creates the reverberant tail that follows the early reflections. The
decay time control adjusts the time required for this tail to drop to 1/1000th (-60 dB) of its
initial amplitude.

High and low shelving filters provide frequency-dependent reverberation decay. The high-
frequency decay models the absorption of sound energy due to air, walls and other materials
in the room (people, carpeting and so forth). The low shelf provides a thinner decay. Each
filter may be turned off to save CPU consumption.

The Freeze control freezes the diffuse response of the input sound. When on, the reverber-
ation will sustain almost endlessly. Cut modifies Freeze by preventing the input signal from
adding to the frozen reverberation; when off, the input signal will contribute to the diffused
amplitude. Flat bypasses the high and low shelf filters when freeze is on. If Flat is off, the
frozen reverberation will lose energy in the attenuated frequency bands, depending on the
state of the high and low shelving filters.

The Echo Density and Scale parameters provide additional control over the diffusion’s den-
sity and coarseness, and, when the room size is extremely small, have a large impact on the
coloration contributed by the diffusion.

The Chorus section adds a little modulation and motion to the diffusion. Like the Spin
section, you can control the modulation frequency and amplitude, or turn it off.

18.21.5 Output

At the reverb output, you can adjust the effect’s overall Dry/Wet mix, and vary the amplitude
of reflections and diffusion with the Reflect Level and Diffuse Level controls.
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18.22 Utility
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Utility can perform some very useful tasks, especially in combination with other effects.

Most obvious is the Gain control, which allows adjusting the level of the input signal from
-36 to +36 dB. The Gain control is located below the Mute button, which simply turns the
signal off if pressed.

Note: The active/mute controls of a track are always placed at the very end of the signal
chain. However, since you can place Utility anywhere in a signal chain, you can use its mute
function to cut the input of a delay line or reverb without turning off the output of these
devices.

The Left/Right buttons allow further processing of only the left or right channel of a sample.
If, for example, Left is turned on, the right channel is ignored and the left channel appears
on both outputs. This is especially useful if you have a stereo file that contains different
information on both channels and you want to use only one.

The Width control acts as a continuous mono to stereo controller when set from 0 to 100
percent. However, beyond 100 percent the output starts to “fold in” on itself. In the full
right position the output contains only the difference between the left and right channels. If

The Utility Effect.
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either the Left or Right button is activated, the Width control has no function and is therefore
bypassed.

At the bottom of the device you will find two Phase (@) controls, one for each channel. As
the name implies they invert the phase of each channel.



Chapter 19

Live MIDI Effect Reference

Live comes with a selection of custom-designed, built-in MIDI effects. The “Working with
Instruments and Effects” chapter (see Working with Instruments and Effects) explains the
basics of using effects in Live.
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19.1 Arpeggiator
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Live's Arpeggiator effect takes the individual notes in a played MIDI chord, or notes played
singly, and plays them as a rhythmical pattern. The sequence and speed of the pattern
can be controlled by the device, which also provides a full complement of both classic and
original arpeggiator features.

Arpeggiators are a classic element in Eighties synth music. The name originates with the
musical concept of the “arpeggio,” in which the notes comprising a chord are played as
a series rather than in unison. “Arpeggio” is derived from the lItalian word “arpeggiare,”
which refers to playing notes on a harp.

19.1.1 Style and Rate Sections

Arpeggiator’s Style chooser determines the sequence of notes in the rhythmical pattern.

The Arpeggiator Effect.

“Up” and “Down”.
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Play Order places notes in the pattern according to the order in which they are played. This

“UpDown"” and
“DownUp”.

“Down & Up"” and “Up
& Down”.

“Converge” and
“Diverge”.

“Con & Diverge”.

“Pinky Up” and “Pinky
UpDown”.

“Thumb Up” and
“Thumb UpDown".
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is therefore only recognizable when more than one chord or note has been played.

In addition to the Arpeggiator styles above, there are a number of random styles. Random
randomly selects incoming MIDI notes for playback. Random Other creates a random
pattern from incoming MIDI notes, and then plays the randomly generated chord repeatedly.
Random Once creates a random pattern from incoming MIDI notes and repeats the pattern
until it has been transposed or retriggered, at which point a new pattern is created.

Arpeggiator will play the pattern of notes at the speed set by the Rate control, which can
be calibrated in either milliseconds or beat-time using the neighboring Sync/Free button.
With Sync chosen, Arpeggiator will be synced to song time.

A Gate control to the right of Rate determines the length of notes played by Arpeggiator
as a percentage of the current Rate setting. Any setting larger that 100% will therefore play
notes that overlap (i.e., are legato).

The rhythmic pattern generated by Arpeggiator does not necessarily have to be straight;
patterns can be given groove with the respective control just beneath the Mode chooser.
Groove in Arpeggiator works just like it does for clips (see Groove), so that the intensity of
the groove is set in the Control Bar.

With the Hold parameter active, Arpeggiator will continue to play the pattern even after the
keyboard keys have been released. The pattern will be repeated until any other keyboard
key is pressed. When Hold is active and any of the original keys also remain physically held,
notes can be added to the pattern simply by playing them. Notes can also be removed from
the pattern in this scenario by playing them a second time, allowing the gradual buildup
and rearrangement of the pattern over time.

Tip: If you want the pattern to stop playing, momentarily deactivate Hold.

The Offset parameter shifts the sequence of notes in the pattern by the number of places
selected with the control. This is best illustrated with an example: A setting of “1” makes
the second note in the pattern play first, and the first note last. If you imagine the pattern
as a circle of notes that is played in a clockwise direction from a set start point, the Offset
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parameter effectively rotates this circle counter-clockwise one note at a time, changing
where in the pattern play begins.

With the Repeats parameter, the pattern can be set to repeat a specified number of times
until it is retriggered. A setting of “inf” will repeat the pattern indefinitely. Hint: This
feature provides an excellent way of emulating the strum of a guitar or playing a chord as
an arpeggio once or twice. Another interesting effect can be achieved by combining this
feature with the Retrigger parameter, which we will explain in a moment. This can be used
to create rhythmically generated arpeggios separated by pauses.

The Retrigger parameter resets the pattern so that it starts again from the beginning.
Retriggering can be deactivated (Off), set to occur when new notes are pressed (Note) or
set to occur at a specified song position or beat-time (Beat). Beat retriggering can be
specified in terms of notes or bars and is aligned with song position. An LED in the upper
right corner of the section indicates when the pattern has been retriggered.

19.1.2 Transposition and Velocity Sections

The pattern generated by Arpeggiator can be transposed; the device’s transposition controls
allow forcing this transposition into a specific major or minor key or (using the Transpose
chooser’s Shift option) doing it in semitones. The distance between transposition steps is
set in scale intervals (for Major and Minor transposition) or semitones (for Shift transposition)
with the Distance control. Using the Steps parameter, you can choose the number of times
the sequence is transposed: A setting of 8 will transpose the sequence a total of eight times,
playing it in higher notes each time.

The dynamics of Arpeggiator are controlled using the velocity section. With Velocity set
to On and Target set to 0, for example, the sequence will gradually fade out, eventually
reaching O velocity. The Decay control sets the amount of time Arpeggiator takes to reach
the Target velocity. With Retrigger activated, retriggering of the sequence will also retrigger
the velocity slope.
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Tip: The velocity section’s Retrigger option can be used in conjunction with Beat retriggering
to add rhythm to the dynamic slope.

19.2 Chord

D chord @0
Shift 1 Shinz  Shin3

M

0st 0st 0st
[100 % « [100 % « [100 % «

Shift 4 Shift 5 Shift &

ONONO!

0 st 0st 0 st

[100 % «f [100 % «| [100 % «

This effect assembles a chord, as the name implies, from each incoming note and up to six
others of user-defined pitch. The Shift 1-6 knobs allow selecting the pitch of the notes that
contribute to the chord from a range of +/- 36 semitones relative to the original. Setting
Shift 1 to +4 semitones and Shift 2 to +7 semitones, for example, yields a major chord in
which the incoming note is the root.

The Velocity control beneath each Shift knob makes further harmonic sculpting possible,
given that the instrument allows for changes in volume or timbre as function of velocity. It
is a relative control, with a range of 1 to 200 percent (100 percent defined as playing at a
velocity equal to that of the incoming MIDI note). Use the Velocity controls to do anything
from adding slight overtones to washing out most of the other chord elements.

The order in which pitches are added to the chord is inconsequential: The effect of a
+12 semitone shift added with the Shift 1 control, for example, is equal in effect to a +12

The Chord Effect.
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semitone shift added with the Shift 6 control.

Note that no two notes of the same pitch can contribute to the chord, and that selecting the
same shift value twice (e.g., +8 semitones on both Shift 2 and Shift 3) will result in the latter
control becoming gray, indicating that it is a duplicate and therefore not in use. Actually,
there is no such thing as two notes with the same pitch playing at the same time within the
entire Live universe.

19.3 Pitch
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The Pitch Effect.
Pitch is a transposition tool that changes incoming note pitch by +/- 48 semitones.

The Range and Lower Limit controls act together to set a pitch range through which notes
are allowed to pass. Notes outside of the defined pitch range will be blocked, and the
effect’s LED light will flash when this happens.

Notes outside of the pitch range are limited based on their untransposed pitch, prior to the
transposition stage of the effect.
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19.4 Random
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Random adds an element of the unknown to the otherwise commonplace pitch parameter.
The Chance control defines the likelihood that an incoming note’s pitch will be changed by a
random value. You can think of it as being something like a dry/wet control for randomness.

The random value that determines the pitch change is created by two variables: The Choices
control defines the number of different random notes possible, from a range of 1 to 24; the
Scale control value is multiplied by the Choices control value, and the result dictates the
pitches that random notes are allowed to have relative to that of the incoming note.

For example, with Chance set to 50 percent, Choices set to 1 and Scale set to 12, half of the
resulting notes will play at the original pitch and half will play 12 semitones higher. But, with
Chance set to 50 percent, Choices set to 12 and Scale set to 1, half of the resulting notes
will play at the original pitch and half will play at one of any that are 12 semitones higher.

These examples assume Sign buttons that are set to “Add.” The Sign controls decide
whether the random alteration adds to the original note’s pitch, subtracts from it, or does a
little of both. The LEDs below the Sign controls give you a visual idea of how output pitch
compares with that of the original.

Hint: Try using the Scale effect after Random to obtain random values within a specific

The Random Effect.
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harmonic range.

19.5 Scale
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Scale alters incoming note pitch based on a scale mapping. Each incoming note is given
an outgoing equivalent on the X-Y scale map of the effect: All incoming Cs, for example,
might be converted to outgoing Ds.

The X-Y scale map is 12 squares in length and width, corresponding to the 12 notes in a full
octave. Darker squares represent the black keys on a keyboard. The base of the diagonal
scale (the lower left square) shown on the map can be changed using the Base control. The
X-axis of the map shows incoming note values, and the Y-axis their outgoing equivalents.
Use mouse-clicks to move or delete the yellow squares, which define where an incoming
note will be sent on the scale. (Deleting a note on the scale map means that it will no longer

play.)

The Range and Lower Limit controls define the note range within which scale mapping
will take effect. Outside of the range defined by these controls, the Scale effect will be
inapplicable, and the LED light will flash to indicate that some notes are not being processed

The Scale Effect.
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by the effect, but are playing at their unaltered pitch.

19.6 Velocity
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Velocity re-maps the 127 MIDI note velocity values. The Out Low and Out Hi knobs control
the outgoing velocity (from 1 to 127), which is represented by the Y-axis of the X-Y display.
Incoming velocities that are shown in the display are within the range chosen by the In
Low and In Hi choosers, and are represented on the X-axis. The resulting curve shows how
velocity is being altered by the effect.

If In Low and Out Low are both set to 1, and Out Hi and In Hi are set to 127, the display will
show a straight diagonal line that indicates the equivalent of an effect bypass: Softly played
notes are being output quietly and vice versa. If instead, Out Hi is set to 1 and out Low to
127, the slope of the line will be reversed, and softly played notes will actually produce the
loudest output.

What happens to incoming notes that are outside of the range set with the In Low and In
High controls? This depends on which Mode is selected. Clip Mode does just what it says:
It clips incoming note velocities so that they stay within the range. Gate Mode removes

The Velocity Effect.
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incoming notes altogether if their velocities are outside of the range. You will see the little
LED in the effect flash when a note is blocked by gating. In Fixed Mode, the Out Hi velocity
defines all outgoing note velocities, regardless of incoming note velocity.

The Random function adds or subtracts a random value to the all velocities, and is repre-
sented by a gray area on the display curve.

The Drive and Compand controls can be combined to create more complex curves. Com-
pand is a simultaneous expanding and compressing tool. When set to values greater than
0, it forces incoming notes to the outer boundaries of the curve, making them play either
loudly or softly. Compand values of less than 0, on the other hand, force outgoing velocity
toward the mid-range. Drive pushes all values in the curve to the outer extremes. Use these
two controls together to sculpt or even redefine the dynamic structure of a piece.



Chapter 20

Live Instrument Reference

Live comes with a selection of custom-designed, built-in instruments. The “Working with
Instruments and Effects” chapter (see Working with Instruments and Effects) explains the
basics of using instruments in Live.
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Impulse is a drum sampler with complex modulative capabilities. The eight drum samples
loaded into Impulse’s sample slots can be time-stretched, filtered and processed by enve-
lope, saturation, pan and volume components, nearly all of which are subject to random
and velocity-based modulation.

20.1.1 Sample Slots

Samples are dragged and dropped into Impulse’s eight sample slots from the Browser or the
Session and Arrangement Views. Samples can be deleted with your computer keyboard’s
Backspace/Delete key.

Imported samples are automatically mapped onto your MIDI keyboard, providing that it is
plugged in and acknowledged by Live. C3 on the keyboard will trigger the leftmost sample,
and the other samples will follow suit in the octave from C3 to C4. Impulse’s eight slots will
appear labeled in the MIDI Editor's key tracks (see Editing MIDI Notes and Velocities) when
the “Fold” button is active, even if the given key track is void of MIDI notes. Mapping can

The Impulse Instrument.
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be transposed from the default by applying a Pitch device (see Pitch), or it can be rearranged
by applying a Scale device (see Scale).

Each of the eight samples has a proprietary set of parameters, located in the area below the
sample slots and visible when the sample is clicked. Adjustments to sample settings are only
captured once you hit a new note — they do not affect currently playing notes. Note that
this behavior also defines how Impulse reacts to parameter changes from clip envelopes or
automation, which are applied once a new note starts. If you want to achieve continuous
changes as a note plays, you may want to use the Simpler (see Simpler).

Slot 8's parameters also include a “Link” button, located in the lower left corner, which links
slot 8 with slot 7. Linking the two slots allows slot 7’s activation to stop slot 8's playback, and
vice versa. This was designed with a specific situation in mind (but can, of course, be used
for other purposes): Naturalistic closed hi-hat cymbals will shut down open hi-hat cymbals.

Each slot can be played, soloed or muted using controls that appear when the mouse hovers
over it.

20.1.2 Start, Tune and Stretch

The Start control defines where Impulse begins playing a sample, and can be set to up
to 100 ms later than the actual sample beginning. The Transposition control adjusts the
transposition of the sample by +/- 48 semitones, and can be modulated by incoming note
velocity or a random value, as set in the appropriate fields.

The Stretch control has values from -100 to 100 percent. Negative values will shorten the
sample, and positive values will stretch it. Two different stretching algorithms are available:
Mode A is ideal for low sounds, such as toms or bass, while Mode B is better for high sounds,
such as cymbals. The Stretch value can also be modulated by MIDI note velocity.
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20.1.3 Filter

The Filter section offers a broad range of filter types, each of which can impart different
sonic characteristics onto the sample by removing certain frequencies. The Frequency
control defines where in the harmonic spectrum the filter is applied; the Resonance control
boosts frequencies near the points in the spectrum where frequencies are excluded by
filtering. Filter Frequency can be modulated by either a random value or by MIDI note
velocity.

20.1.4 Saturator and Envelope

The Saturator gives the sample a fatter, rounder, more analog sound, and can be switched
on and off using the appropriate switch. The Drive control boosts the signal and adds
distortion. Note: Turning Drive up makes almost every signal get much louder, and so will
usually require that volume be lowered manually. Extreme Drive settings on low-pitched
sounds will produce the typical, overdriven analog synth drum sounds.

The envelope can be adjusted using the Decay control, which can be set to a maximum of
60.0 seconds. Impulse has two decay modes: Trigger Mode allows the sample to decay with
the note; Gate Mode forces the envelope to wait for a note off message before beginning
the decay. This mode is useful in situations where you need variable decay lengths, as is the
case with hi-hat cymbal sounds.

20.1.5 Pan and Volume

Each sample has Volume and Pan controls that adjust amplitude and stereo positioning,
respectively. Both controls can be modulated, Pan by velocity and a random value, and
Volume by velocity only.
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20.1.6 Global Parameters

The parameters located to the right of the sample slots are global controls that apply to all
samples within Impulse’s domain. Volume adjusts the overall level of the instrument, and
Pitch adjusts the transposition of all notes. The Time control governs the time-stretching
and decay of all samples, allowing you to morph between short and stretched drum sounds.

20.1.7 Individual Outputs

When a new instance of Impulse is dragged into a track, its signal will be mixed with those
of the other instruments and effects feeding the audio chain of the track. It can oftentimes
make more sense to isolate the instrument or one of its individual drum samples, and send
this signal to a separate track. Please see the Routing chapter (see Tapping Individual
Outs From an Instrument) to learn how to accomplish this for Impulse’s overall signal or for
Impulse’s individual sample slots.
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Simpler is an instrument that integrates the basic elements of a sampler with a set of classic
synthesizer parameters. A Simpler voice plays a user-defined sample section, which is in
turn processed by envelope, filter, LFO, volume and pitch components.

20.2.1 Sample View

The Sample View displays the sample waveform. Samples can be dragged into Simpler
either directly from the Browser, or from the Session or Arrangement View in the form of
clips. In the latter case, Simpler will utilize only the section of the sample demarcated by
the clip’s start/end or loop markers. Samples can be replaced by dragging in a new sample.

20.2.2 Sample Controls

Simpler plays a specific region or loop of the sample, as determined by a group of sample
controls.

The Simpler Instrument.
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The Start and Length controls work together to specify where Simpler begins and ends its
sweep of the sample. As the name implies, Start defines where sample playback starts.
The sample will play for the length defined by the Length parameter. Both parameters are
defined as a percentage of the whole region, so setting start to 25 percent and length to
50 percent, for example, will start playback 1/4 of the way through the sample and stop
playback at the 3/4 mark (using 50 percent of the sample).

Samples are played by Simpler as one-shots or as loops, depending on whether or not the
Loop switch is active. When looping is active, the Loop control dictates the length of the
loop, starting from the end of the playing sample. Simpler will play the first instance of a
looped sample beginning with the Start point, then continue playing only the length of the
loop.

It is possible for glitches or pops to occur between a looped sample’s start and end points
due to the discontinuity in waveform amplitude (i.e., the sample’s loudness). The Snap
switch will help mitigate these by forcing Simpler's loop markers to snap to zero-crossing
points in the sample (points where the amplitude is zero). Note: Snapping is based on the
left channel of stereo samples. It is therefore still possible, even with Snap activated, to
encounter glitches in the right channel of a stereo sample.

You can also smooth the transition from loop end to loop start by using the Fade control,
which crossfades the two points. This method is especially useful when working with long,
textural samples.

20.2.3 Zoom

Quite often, one starts with a longer region of a sample and ends up using only a small part
of it. Simpler’s two Zoom buttons (“+" and “-") allow you to zoom in around the selected
length, or zoom out to access a larger area. When zooming in on small portions of long
samples, it will probably be necessary to repeatedly shrink the highlighted sample region,
as Simpler will zoom no further than the length of this region. Note: After zooming in, the



20.2. SIMPLER 292

Start, Loop and Length parameters will be resized so that there is no audible difference.
This means that the Start and Length values are altered by zooming, and automation or clip
envelopes utilizing these parameters will behave differently after the operation.

20.2.4 Envelope

Simpler contains the classic ADSR Envelope section, as seen in most synthesizers, for shaping
the dynamic structure of the sample. It also has two additional envelopes, one for the filter
and one for pitch, which are available by toggling the respective buttons in the envelope
section. Attack controls the time in milliseconds that it takes for the envelope to reach
its peak value after a note is played. Decay controls the amount of time it takes for the
envelope to drop down to the Sustain level, which is held until the note is released. Release
time is the amount of time after the end of the note that it takes for the envelope to drop
from the Sustain level back down to zero.

The influence of envelopes on pitch and filter cutoff can be decided using the envelope
amount controls in each of these sections.

20.2.5 Filter

The Filter section offers classic 12 dB or 24 dB low-pass, band-pass and high-pass filters, as
well as a notch filter, each of which can impart different sonic characteristics onto the sample
by removing certain frequencies from the waveform. The most important parameters are
the typical synth controls Frequency and Resonance. Frequency determines where in the
harmonic spectrum the filter is applied; Resonance boosts frequencies near the points in
the spectrum where frequencies are excluded by filtering.

The best way to understand the effects of these controls is to play with them...

The Frequency parameter can be modulated by an LFO, note velocity and an envelope —
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each of which have an amount control in the Filter section. The Key (tracking) control allows
for shifting the filter’s frequency according to note pitch.

20.2.6 LFO

The LFO (low-frequency oscillator) section offers square, sine, triangle, sawtooth up, saw-
tooth down and random waveforms. The main control in this section is the Rate control,
which changes the LFO frequency within a range of 0.05 to 30 Hz. LFOs are applied individ-
ually to each voice, or played note, in Simpler. Square, triangle and sawtooth LFOs restart
each time a new voice is played, while sine and random do not. The Key parameter changes
the definition of each LFO’s Rate as a function of the pitch of incoming notes. A high Key
setting assigns higher notes a higher LFO rate. If Key is set to zero, all voices’ LFOs have
the same rate and may just differ in their phase.

The LFO will modulate the filter, pitch, panorama and volume according to the setting of
the LFO amount controls in each of these sections.

The time taken for the LFO to reach normal level can be set with the Attack control.

20.2.7 Pitch, Pan, Volume and Voices

Simpler plays back a sample at its original pitch if the incoming MIDI note is C3, however the
Transpose control allows transposing this by +/- 48 semitones. Pitch can also be modulated
by an LFO or pitch envelope using the amount controls in this section. The pitch envelope is
especially helpful in creating percussive sounds. Simpler reacts to pitch bend MIDI messages
with a sensitivity of +/- 5 semitones. You can also modulate the Transpose parameter with
clip envelopes and external controllers.

The Voices parameter sets the maximum number of voices that Simpler can play simultane-
ously. If more voices are trying to play than what you have allocated with the Voice control,
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“voice stealing” will take place, in which the oldest voice(s) will be dropped in favor of those
that are new. For example, if your Voices parameter is set to 8, and ten voices are all vying to
be played, the two oldest voices will be dropped. (Simpler does try to make voice stealing
as subtle as possible.) A small LED near the Voices control flashes when a voice has been
stolen.

Panorama can be set with the Pan control, and this control can be further affected by a
random factor or modulated by the LFO.

Finally, the output volume of Simpler is controlled by the Volume control, and can also be
dependent upon note velocity, as adjusted by the Velocity control. Tremolo effects can be
achieved by increasing the influence of the LFO over volume with the respective control.

20.2.8 Glide and Spread

Simpler includes a polyphonic glide function. When this function is activated, new notes
will start with the pitch of the last note played and then slide gradually to their own played
pitch. Glide can be turned on or off and adjusted with the Glide Time control.

Simpler also offers a special Spread parameter that creates a rich stereo chorus by using
two voices per note and panning one to the left and one to the right. The two voices are
detuned, and the amount of detuning can be adjusted with the Spread control.

Tip: Whether or not spread is applied to a particular note depends upon the setting of
the Spread parameter during the note-on event. To achieve special effects, you could, for
instance, create a sequence where Spread is 0 most of the time and turned on only for some
notes. These notes will then play in stereo, while the others will play mono.
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20.2.9 Strategies for Saving CPU Power
Real-time synthesis needs lots of computing power. However, there are strategies for
reducing CPU load. Save the CPU spent on Simpler by doing some of the following:

e Turn off the Filter if it is not needed.

o Use filter types that are less expensive when possible. A filter's cost correlates with the
steepness of its slope —a “LP 24" is more expensive than a “LP 12.”

e Turn off the LFO for a slightly positive influence on CPU.

e Stereo samples need significantly more CPU than mono samples, as they require twice
the processing.

e Decrease the number of simultaneously allowed voices with the Voice control.

20.3 Operator
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Operator is an advanced and flexible synthesizer that combines the concept of “frequency
modulation” (FM) with classic subtractive synthesis. It utilizes four multi-waveform oscillators
that can modulate each other’s frequencies, creating very complex timbres from a limited
number of objects. Operator includes a filter section, an LFO and global controls, as well
as individual envelopes for the oscillators, filter, LFO and pitch.

The full version of Operator is not included with the standard version of Live, but is a special
feature available for purchase separately. For details, please visit the Ableton webshop!,
where you will be offered the opportunity to buy Operator online. Once you have purchased
Operator, you will need to unlock it before using it, as described in the chapter on unlocking
(see Unlocking Live).

20.3.1 General Overview

The interface of Operator consists of two parts: the display surrounded on either side by
the shell. The shell offers the most important parameters in a single view and is divided into
eight sections. On the left side, you will find four oscillator sections, and on the right side
from top to bottom, the LFO, the filter section, the pitch section and the global parameters.
If you change one of the shell parameters, the display in the center will automatically show
the details of the relevant section. When creating your own sounds, for example, you can
conveniently access the level and frequency of all oscillators at once via the shell, and then
adjust each individual oscillator’s envelope, waveform and other parameters in its display.

Operator can be folded with the triangular button at its upper left. This is convenient if you
do not need to access the display details.

1 http://www.ableton.com/shop
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Each of Operator’s oscillators can either output its signal directly or use its signal to modulate
another oscillator. Operator offers nine predefined algorithms that determine how the
oscillators are connected. An algorithm is chosen by clicking on one of the structure icons
in the global display, which will appear if the bottom right (global) section of the shell is
selected. Signals will flow from top to bottom between the oscillators shown in an algorithm
icon.
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Typically, FM synthesis makes use of pure sine waves, creating more complex waveforms
via modulation. However, in order to simplify sound design and to create a wider range of

Operator Folded.

Operator’s Global
Display.



20.3. OPERATOR 298

possible sounds, we designed Operator to produce a variety of other waveforms, including
noise. The instrument is made complete with an LFO, a pitch envelope and a filter section.
Note that lots of “classic” FM synthesizers create fantastic sounds without using filters at
all, so we suggest exploring the possibilities of FM without the filter at first, adding it later
if necessary.

Operator will keep you busy if you want to dive deep into sound design! If you want to break
the universe apart completely and reassemble it, you should also try modulating Operator’s
controls with clip envelopes (see Clip Envelopes) or track automation (see Automation and
Editing Envelopes).

20.3.2 Oscillator Section and Aliasing

Fixed TLevel
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The oscillators can basically play back five waveform types — sine, square, sawtooth, triangle
and noise — as chosen from the Wave chooser in the individual oscillator displays. The first of
these waveforms is a pure, mathematical sine wave, which is usually the first choice for many
FM timbres. Since FM synthesis has a long tradition in hardware synthesizers, we added
some variations of the pure sine wave that allow for more realistic modeling of vintage digital
synthesizers. The differences between these sine waves are very subtle, and whether or not

Oscillator D’s Display
and Shell Parameters.
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they are audible is highly dependant upon the individual sound. We also added “Sine 4 Bit”
and “Sine 8 Bit" to provide the retro sound adored by Cé4 fans, and “Saw D" and “Square
D" digital waveforms, which are especially good for digital bass sounds. Another special
case is the noise waveform. This is not real noise, generated by a random generator, but a
looping noise sample. For more “statistical” noise, one could modulate the noise oscillator
with another oscillator, or with real noise from the LFO. The square, triangle and sawtooth
waveforms are resynthesized approximations of the ideal shape. The numbers included in
the displayed name (e.g., “Sq6") define how many harmonics are used for the resynthesis.
Lower numbers sound mellower and are less likely to create aliasing when used on high
pitches.

Hint: Oscillator waveforms can be copied and pasted from one oscillator to another using

the @ (PC)/ (Cul ]® (Mac) context menu.

Aliasing distortion is a common side effect of all digital synthesis and is the result of the
finite sample rate and precision of digital systems. It mostly occurs at high frequencies. FM
synthesis is especially likely to produce this kind of effect, since one can easily create sounds
with lots of high harmonics. This also means that more complex oscillator waveforms, such
as “Saw32,” tend to be more sensitive to aliasing than pure sine waves. Aliasing is a two-
fold beast: A bit of it can be exactly what is needed to create a cool sound, and a bit too
much can make the timbre unplayable, as the perception of pitch is lost when high notes
suddenly fold back into arbitrary pitches. The Tone parameter in the global section allows
for controlling aliasing. Its effect is sometimes similar to a low-pass filter, but this depends
on the nature of the sound itself and cannot generally be predicted. If you want to familiarize
yourself with the sound of aliasing, turn Tone up fully and play a few very high notes. You
will most likely notice that some notes sound completely different from other notes. Now,
turn Tone down and the effect will be reduced, but the sound will be less bright.

The frequency of an oscillator can be adjusted in the shell with its Coarse and Fine controls.
An oscillator’s frequency usually follows that of played notes, but for some sounds it might
be useful to set one or more oscillators to fixed frequencies. This can be done for each
individual oscillator by activating the Fixed option. This allows the creation of sounds in
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which only the timbre will vary when different notes are played, but the tuning will stay the
same. Fixed Mode would be useful, for example, in creating live drum sounds. Fixed Mode
also allows producing very low frequencies down to 0.1 Hz. Note that when Fixed Mode is
active, the frequency of the oscillator is controlled in the shell with the Frequency (Freq) and
Multiplier (Multi) controls.

Operator includes a special Osc<Vel control for each oscillator that allows altering frequency
as a function of velocity. This feature can be very useful when working with sequenced
sounds in which the velocity of each note can be adjusted carefully. Part of this functionality
is the adjacent quantize control. If this control is activated, the frequency will only move in
whole numbers, just as if the Coarse control were being manually adjusted. If quantize is
not activated, the frequency will be shifted in an unquantized manner, leading to detuned
or inharmonic sounds (which very well could be exactly what you want...).

The amplitude of an oscillator depends on the Level setting of the oscillator in the shell
and on its envelope (see Envelopes), which is shown in its display and can be adjusted
from there. It can also be modified by note velocity and note pitch with the Level<Vel and
Level<Key parameters available in the lower portion of each oscillator’s display.

The phase of each oscillator can be adjusted using the Phase control in its display.

As explained earlier (see General Overview) oscillators can modulate each other when set
up to do so with the global display’s algorithms. When an oscillator is modulating another
oscillator, two main properties define the result: the amplitude of the modulating oscillator
and the frequency ratio between both oscillators. Note that Oscillator D can modulate itself
via the Feedback parameter available in its display.
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20.3.3 LFO Section
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The LFO in Operator can practically be thought of as a fifth oscillator. It runs at an audio rate,
and it modulates the frequency of the other oscillators. Itis possible to switch modulation by
the LFO on or off for each individual oscillator (and the filter) using the Destination buttons
in the LFO's display. The LFO can also be turned off if it is unused.

The LFO offers a choice of classic LFO waveforms, sample and hold (S&H), and noise.
Sample and hold uses random numbers chosen at the rate of the LFO, creating the random
steps useful for typical retro-futuristic sci-fi sounds. The noise waveform is simply band-
pass-filtered noise.

Tip: FM synthesis can be used to create fantastic percussion sounds, and using the LFO
with the noise waveform is the key to great hi-hats and snares.

The frequency of the LFO is determined by the LFO Rate control in the shell, as well as the
low/high setting of the adjacent LFO Range switch. The frequency of the LFO can follow
note pitch, be fixed or be set to something in between. This is defined by the Rate<Key
parameter in the LFO’s display.

The intensity of the LFO is set by the LFO Mod control in the shell. This parameter can be
modulated by note velocity via the display’s Amt<Vel control. The LFO’s intensity is also

Operator’s LFO
Parameters.
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affected by its envelope (see Envelopes).

20.3.4 Envelopes

Operator has seven envelopes: one for each oscillator, a filter envelope, a pitch envelope
and an envelope for the LFO. All envelopes are constructed similarly and feature some
special looping modes.

An envelope’s shape is defined by six parameters: three rates and three levels. A rate is the
time it takes to go from one level to the next. For instance, a typical pad sound starts with
the initial level "-inf dB” (which is silence), moves with an attack rate to its peak level, moves
from there to the sustain level with a decay rate, and then finally, after note-off occurs,
back to “-inf dB” at the release rate. Operator’s display provides a good overview of the
actual shape of any particular envelope and lets you directly adjust the curve by clicking and

dragging.

Hint: Envelope shapes can be copied and pasted from one place to another in Operator
usingthe O (PC)/ [Ctrl_ ] (Mac) context menu.

With FM synthesis, it is possible to create spectacular, endless, permuting sounds; the key
to doing this is looping envelopes. Loop Mode can be activated in the lower left corner of
the display. If an envelope in Operator is in Loop Mode and reaches sustain level while the
note is still being held, it will be retriggered. The rate for this movement is defined by the
Loop Time parameter. (Note that envelopes in Loop Mode can loop very quickly and can
therefore be used to achieve effects that one would not normally expect from an envelope
generator.)

While Loop Mode is good for textures and experimental sounds, Operator also includes Beat
and Sync Modes, which provide a simple way of creating rhythmical sounds. If set to Beat
Mode, an envelope will restart after the beat time selected from the Repeat chooser. In Beat
Mode, the repeat time is defined in fractions of song time, but notes are not quantized.
If you play a note a bit out of sync, it will repeat perfectly but stay out of sync. In Sync
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Mode however, the first repetition is quantized to the nearest 16th note and, as a result, all
following repetitions are synced to the song tempo. Note that Sync Mode only works if the
song is playing, and otherwise it will behave like Beat Mode.

Note: To avoid the audible clicks caused by restarting from its initial level, a looped envelope
will restart from its actual level and move with the set attack rate to peak level.

The rates of all the envelopes in Operator can be scaled in unison by the Time control in
the global section of the shell. Note that beat-time values in Beat and Sync Modes are not
influenced by the global Time parameter. Envelope rates can be further modified by note
pitch, as dictated by the Time<Key parameter in the global section’s display. The rate of an
individual envelope can also be modified by velocity using the Time<Vel parameter. These
modulations in conjunction with the loop feature can be used to create very, very complex
things...

The pitch envelope can be turned on or off for each individual oscillator and for the LFO
using the Destination A-D and LFO buttons in its display. It can also be turned off altogether
via the pitch section of the shell. The pitch envelope amount is adjusted with the adjacent
Pitch Env control.

Tip: If the pitch envelope is only applied to the LFO and is looping, it can serve as another
LFO, modulating the rate of the first. And, since the envelope of the LFO itself can loop, it
can serve as a third LFO modulating the intensity of the first!
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20.3.5 Filter Section
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As mentioned earlier, the filters are not the main focus of this instrument. However, they
can be very useful for modifying the sonically rich timbres created by the oscillators. And,
since the oscillators also provide you with the classic waveforms of analog synthesizers, you
can very easily build a subtractive synthesizer with them.

The filter section offers 12 dB low-pass, band-pass, high-pass and notch filters. Note that
the notch filter is not of true notch filter design but a bell-shaped curve with very low gain,
which removes more of the frequencies around the center.

Filter cutoff frequency and resonance can be adjusted in the shell. Filter frequency can also
be modulated by note velocity, note pitch, the LFO and the filter envelope (see Envelopes).
The Freqg<Vel, Freq<Key and Envelope controls in the filter’s display set these three func-
tions, respectively.

20.3.6 Global Controls

The maximum number of Operator voices (notes) playing simultaneously can be adjusted
with the Voices parameter in the global display. Ideally, one would want to leave this setting

Operator’s Filter Section.
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high enough so that no voices would be turned off while playing, however a setting between
6 and 12 is usually more realistic when considering CPU power (see Strategies for Saving
CPU Power).

Tip: Some sounds should play monophonically by nature, which means that they should
only use a single voice. (A flute is a good example.) In these cases, you can set Voices to 1.
If Voices is set to 1, another effect occurs: Overlapping voices will be played legato, which
means that the envelopes will not be retriggered from voice to voice, and only pitch will
change.

A high quality setting (HiQ) can be switched on and off in the global display, controlling the
interpolation algorithm of the oscillators and LFO. This setting will affect the sound of some
waveforms more than others (especially the noise waveform) and also affects CPU resources
(see Strategies for Saving CPU Power).

Global Volume and Transpose controls for the instrument can be found in the global section
of the shell, and a Pan control is located in the global section’s display. Pan can be modulated
by a random factor or by note pitch, using the adjacent Rnd and Key controls, respectively.

MIDI pitch bend messages will affect Operator as defined by the PB Range control in the
pitch section of the display.
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20.3.7 Glide and Spread
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Operator includes a polyphonic glide function. When this function is activated, new notes
will start with the pitch of the last note played and then slide gradually to their own played
pitch. Glide can be turned on or off and adjusted with the Glide Time control in the pitch
display.

Operator also offers a special Spread parameter that creates a rich stereo chorus by using
two voices per note and panning one to the left and one to the right. The two voices are
detuned, and the amount of detuning can be adjusted with the Spread control in the pitch
section of the shell.

Tip: Whether or not spread is applied to a particular note depends upon the setting of
the Spread parameter during the note-on event. To achieve special effects, you could, for
instance, create a sequence where Spread is 0 most of the time and turned on only for some
notes. These notes will then play in stereo, while the others will play mono.

Operator’s Pitch Section.
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20.3.8 Strategies for Saving CPU Power

If you want to save CPU power, turn off features that you do not need or reduce the number
of voices. Specifically, turning off the filter or the LFO if they do not contribute to the sound
will save CPU power.

For the sake of saving CPU resources, you will also usually want to reduce the number of
voices to something between 6 and 12, and carefully use the Spread feature. The high
quality setting can also be turned off to conserve CPU resources.

Note that turning off the oscillators will not save CPU power.

20.3.9 Finally...

Operator is the result of an intense preoccupation with FM synthesis and a love and dedi-
cation to the old hardware FM synthesizers, such as the Yamaha SY77, the Yamaha TX81Z
and the NED Synclavier Il. FM synthesis was first explored musically by the composer and
computer music pioneer John Chowning in the mid-1960s. In 1973, he and Stanford Uni-
versity began a relationship with Yamaha that lead to one of the most successful commercial
musical instruments ever, the DX7.

John Chowning realized some very amazing and beautiful musical pieces based on a syn-
thesis concept that you can now explore yourself simply by playing with Operator in Live.

We wish you loads of fun with it!

20.3.10 The Complete Parameter List

The function of each Operator parameter is explained in the forthcoming sections. Remem-
ber that you can also access explanations of controls in Live (including those belonging to
Operator) directly from the software by placing the mouse over the control and reading the
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text that appears in the Info View (see Using the Info View and Index). Parameters in this list
are grouped into sections based on where they appear in Operator.

Global Shell and Display

Time- This is a global control for all envelope rates.

Tone- Operator is capable of producing timbres with very high frequencies, which can
sometimes lead to aliasing artifacts. The Tone setting controls the high frequency content
of sounds. Higher settings are typically brighter but also more likely to produce aliasing.

Volume- This sets the overall volume of the instrument.

Algorithm- An oscillator can modulate other oscillators, be modulated by other oscillators,
or both. The algorithm defines the connections between the oscillators and therefore has a
significant impact on the sound that is created.

Voices- This sets the maximum number of notes that can sound simultaneously. If more
notes than available voices are requested, the oldest notes will be cut off.

High Quality (HiQ)- This changes the interpolation algorithm of the oscillators and the LFO.
If turned off, some timbres will sound more rough, especially the noise waveform. Turning
this off will also save some CPU power.

Time<Key- The rates of all envelopes can be controlled by note pitch. If the global Time<Key
parameter is set to higher values, the envelopes run faster when higher notes are played.

Pan- Use this to adjust the panorama of each note. This is especially useful when modulated
with clip envelopes.

Pan<Key (Key)- If Pan<Key is set to higher values, low notes will pan relatively more to the
left channel, and higher notes to the right. Typically this is used for piano-like sounds.

Pan<Random (Rnd)- This defines the extent to which notes are randomly distributed between
the left and right channels.
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Pitch Shell and Display

Pitch Envelope On- This turns the pitch envelope on and off. Turning it off if it is unused
saves some CPU power.

Pitch Envelope Amount (Pitch Env)- This sets the intensity of the pitch envelope. A value of
100% means that the pitch change is exactly defined by the pitch envelope’s levels. A value
of -100% inverts the sign of the pitch envelope levels.

Spread- If Spread is turned up, the synthesizer uses two detuned voices per note, one
each on the left and right stereo channels, to create chorusing sounds. Spread is a very
CPU-intensive effect.

Transpose- This is the global transposition setting for the instrument. Changing this param-
eter will affect notes that are already playing.

Pitch Bend Range (PB Range)- This defines the effect of MIDI pitch bend messages.

Pitch Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes (see Envelope Display).

Glide (G)- With Glide on, notes will slide from the pitch of the last played note to their
played pitch. Note that all envelopes are not retriggered in this case if notes are being
played legato.

Glide Time (Time)- This is the time it takes for a note to slide from the pitch of the last
played note to its final pitch when Glide is activated. This setting has no effect if Glide is
not activated.

Pitch Envelope to Osc (Destination A-D)- The pitch envelope affects the frequency of the
respective oscillator if this is turned on.

Pitch Envelope to LFO (Destination LFO)- The pitch envelope affects the frequency of the
LFO if this is turned on.
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Filter Shell and Display

Filter On- This turns the filter on and off. Turning it off when it is unused saves CPU power.

Filter Type- Low-pass, band-pass and high-pass are second order filters with resonance.
Their names imply the part of the spectrum they affect. The notch filter passes everything
apart from its center frequency and is more audible with low resonance settings.

Filter Frequency (Freq)- This defines the center or cutoff frequency of the filter. Note that
the resulting frequency may also be modulated by note velocity and by the filter envelope.

Filter Resonance (Res)- This defines the resonance around the filter frequency of the low-pass
and high-pass filters, and the width of the band-pass and notch filters.

Filter Frequency<Velocity (Freq<Vel)- Filter frequency is modulated by note velocity accord-
ing to this setting.

Filter Frequency<Key (Freqg<Key)- Filter frequency is modulated by note pitch according to
this setting. A value of 100% means that the frequency doubles per octave. The center
point for this function is C3.

Filter Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes (see Envelope Display).

Filter Frequency<Envelope (Envelope)- Filter frequency is modulated by the filter envelope
according to this setting. A value of 100% means that the envelope can create a maximum
frequency shift of approximately 9 octaves.

LFO Shell and Display

LFO On- This turns the LFO (low-frequency oscillator) on and off. Turning it off when it is
unused saves some CPU power.
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LFO Waveform- Select from among several typical LFO waveforms. Sample and Hold creates
random steps, and Noise supplies band-pass-filtered noise. All waveforms are band-limited
to avoid unwanted clicks. Cyclic waveforms restart with each note-on message.

LFO Range- The LFO covers an extreme frequency range. Choose Low for a range from 50
seconds to 30 Hz, or Hi for 8 Hz to 12 kHz. Due to the possible high frequencies, the LFO
can also function as a fifth oscillator.

LFO Rate (Rate)- This sets the rate of the LFO. The actual frequency also depends on the
setting of the LFO Range and the LFO Rate<Key controls.

LFO Amount (Mod)- This sets the intensity of the LFO. Note that the actual effect also
depends on the LFO envelope.

LFO to Osc (Destination A-D)- The LFO modulates the frequency of the respective oscillator
if this is turned on.

LFO Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes (see Envelope Display).

LFO Rate<Key (Rate<Key)- The LFO's frequency can be a function of note pitch. If this is set
to 100%, the LFO will double its frequency per octave, functioning like a normal oscillator.

LFO Amount<Velocity (Amt<Vel)- This setting adjusts modulation of the LFO intensity by
note velocity.

Oscillators A-D Shell and Display

Osc On- This turns the oscillator on and off.

Osc Coarse Frequency (Coarse)- The relationship between oscillator frequency and note
pitch is defined by the Coarse and Fine parameters. Coarse sets the ratio in whole numbers,
creating a harmonic relationship.
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Osc Fine Frequency (Fine)- The relationship between oscillator frequency and note pitch
is defined by the Coarse and Fine parameters. Fine sets the ratio in fractions of whole
numbers, creating an inharmonic relationship.

Osc Fixed Frequency On (Fixed)- In Fixed Mode, oscillators do not respond to note pitch
but instead play a fixed frequency.

Osc Fixed Frequency (Freq)- This is the frequency of the oscillator in Hertz. This frequency
is constant, regardless of note pitch.

Osc Fixed Multiplier (Multi)- This is used to adjust the range of the fixed frequency. Multiply
this value with the value of the oscillator’s Freq knob to get actual frequency in Hz.

Osc Output Level (Level)- This sets the output level of the oscillator. If this oscillator is
modulating another, its level has significant influence on the resulting timbre. Higher levels
usually create bright and/or noisy sounds.

Osc Waveform (Wave)- Choose from a collection of carefully selected waveforms, including
slight derivations of sine waves that are especially useful for creating emulations of vintage
digital hardware synthesizers.

Osc Phase (Phase)- This sets the initial phase of the oscillator. The range represents one
whole cycle.

Osc Frequency<Velocity (Osc<Vel)- The frequency of an oscillator can be modulated by
note velocity. Positive values raise the oscillator’s pitch with greater velocities, and negative
values lower it.

Osc Freg<Vel Quantized (Q)- This allows quantizing the effect of the Frequency<Velocity
parameter. [If activated, the sonic result is the same as manually changing the Coarse
parameter for each note.

Volume Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes (see Envelope Display).
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Osc Output Level<Velocity (Vel)- This defines how much the oscillator’s level depends upon
note velocity. Applying this to modulating oscillators creates velocity-dependent timbres.

Osc Output Level<Key (Key)- This defines how much the oscillator’s level depends upon
note pitch. The center point for this function is C3.

Osc D Feedback (Feedback)- Osc D can modulate itself. The modulation is dependent not
only on the setting of the feedback control but also on the oscillator level and the envelope.
Higher feedback creates a more complex resulting waveform.

Envelope Display

Envelope Attack Time (Attack)- This sets the time it takes for a note to reach the peak level,
starting from the initial level. The shape of this segment of the envelope is linear.

Envelope Decay Time (Decay)- This sets the time it takes for a note to reach the sustain level
from the peak level. The shape of this segment of the envelope is exponential.

Envelope Release Time (Release)- This is the time it takes for a complete fade-out of a note
after a note-off message is received. The shape of this segment is exponential. The note
will fade out from the value of the envelope at the moment the note-off message occurs,
regardless of which segment is currently active.

Envelope Initial Level (Initial)- This sets the initial value of the envelope.
Envelope Peak Level (Peak)- This is the peak level at the end of the note attack.

Envelope Sustain Level (Sustain)- This is the sustain level at the end of the note decay. The
envelope will stay at this level until note release unless it is in Loop, Sync or Beat Mode.

Envelope Mode (Mode)- If this is set to Loop, the envelope will start again after the end of
the decay segment. If set to Beat or Sync, it will start again after a given beat-time. In Sync
Mode, this behavior will be quantized to song time.



20.3. OPERATOR 314

Envelope Beat/Sync Rate (Repeat)- The envelope will be retriggered after this amount of
beat-time, as long as it is still on. When retriggered, the envelope will move at the given
attack rate from the current level to the peak level.

Envelope Loop Time (Time)- If a note is still on after the end of the decay/sustain segment,
the envelope will start again from its initial value. The time it takes to move from the sustain
level to the initial value is defined by this parameter.

Envelope Rates<Velocity (Time<Vel)- Envelope segments will be modulated by note velocity
as defined by this setting. This is especially interesting if the envelopes are looping. Note
that this modulation does not influence the beat-time in Beat or Sync Modes, but the
envelope segments themselves.



Chapter 21

MIDI and Key Remote Control

To liberate the musician from the mouse, most of Live's controls can be remote-controlled
with an external MIDI controller and the computer keyboard. This chapter describes the
details of mapping to the following specific types of controls in Live's user interface:

1. Session View slots. Note that MIDI and computer key assignments are bound to
the slots, not to the clips they contain.

2. Switches and buttons, among them the Track and Device Activator switches, the
Control Bar's tap tempo, metronome and transport controls.

3. Radio buttons. A radio button selects from among a number of options. One
instance of a radio button is the crossfader assignment section (see Using Live's
Crossfader) in each track, which offers three options: The track is assigned to the
crossfader’s A position, the track is unaffected by the crossfader, or the track is
affected by the crossfader’s B position.

315
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4. Continuous controls, like the mixer's volume, pan and sends.

5. The crossfader, the behavior of which is described in detail in the respective
section of this manual (see Using Live's Crossfader).

21.1 Keyboard Remote Control

The Key Map Mode
Switch.

Creating remote-control assignments for your computer keyboard is straightforward:

1. Enter Key Map Mode by pressing the KEY switch in the upper right-hand corner
of the Live screen. Notice that assignable elements of the interface become
highlighted when you enter Key Map Mode.

2. Click on the Live control you wish to assign to a key.
3. Press the key to which you wish to assign the control.
4. Leave Key Map Mode by again pressing the Key Map Mode switch.

Keyboard assignments can be deleted using your computer’s Backspace or Delete key while
Key Map Mode is active.

Keyboard assignments will be implemented by Live in the following ways:

e Clips in Session View slots will be affected by mapped keys according to their Launch
Mode settings (see Launch Modes).

e Keys assigned to switches will toggle switch states.

¢ Keys assigned to radio buttons will toggle through the available options.
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Please be sure not to confuse keyboard remote-control functionality with Live's ability to use
the keyboard as a pseudo-MIDI device (see Playing MIDI With the Computer Keyboard) that
can generate MIDI notes from computer keystrokes for use with instruments.

21.2 MIDI Remote Control

Live can be controlled remotely with an external MIDI device such as a keyboard or controller
box. Live also supports Mackie Control, a topic that is covered in a separate chapter (see
Mackie Control) in this manual, for completely mouse-free program operation.

Before we explain how remote-control assignments are made and implemented, let us first
make the distinction between MIDI remote control and a separate use of MIDI in Live:
input for MIDI tracks. Let's say that you are, for instance, using a MIDI keyboard to play
an instrument in one of Live's MIDI tracks (see Working with Instruments and Effects). If
you assign F2 on your MIDI keyboard to a Session View Clip Launch button, that key will
cease play F2 on your MIDI track’s instrument, as it now “belongs” solely to the Clip Launch
button.

MIDI keys that become part of remote-control assignments can no longer be used as input
for MIDI tracks.

This is a common cause of confusion that can be easily resolved by looking at the Control
Bar's MIDI indicators (see MIDI In/Out Indicators).

21.2.1 MIDI Remote Input and Output

Before making any MIDI assignments, you must first set up Live to recognize whichever MIDI
device(s) you are using for remote control. This is done in the MIDI/Sync tab of the Live
Preferences, where you can select devices for remote-control input and output.
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The "Active Devices"” table lists all available input and output MIDI devices. To use a device
for remote mapping, make sure the corresponding switch in the “Remote” column is set to
On. You can use any number of MIDI devices for remote mapping; Live will merge their
incoming MIDL.

When Live recognizes a MIDI message, the Control Bar's MIDI In indicator (see MIDI In/Out
Indicators) will flash.

Audio MIDUSync Plug-in Defaults Misc Products

Input Track Sync | Remote

Selecting a MIDI Device
for Remote Control.

Turn external devices on for remote control in the Output section when working with con-
troller boxes that use endless knobs or motorized faders. These devices need to be updated
when a control’s value changes in Live, because the position of the motorized faders or LED
chains has to match the new value.

21.2.2 Assigning MIDI Remote Control

= ==

The MIDI Map Mode
Switch.

Once your remote-control setup has been finished in the Preferences, giving MIDI controllers
and notes remote-control assignments is simple:
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1. Enter MIDI Map Mode by pressing the MIDI switch in the upper right-hand
corner of the Live screen. Notice that assignable elements of the interface
become highlighted.

2. Click on the Live control you wish to assign to MIDI.

3. Send a MIDI message by pressing a keyboard key, turning a knob, etc., on your
MIDI controller. To assign a Session slot to a MIDI note range for chromatic
playing, first play the root key (this is the key that will play the clip at the default
transposition), then, while holding down the root key, press keys below or above
the root to define the limits of the range.

4. Leave MIDI Map Mode by again pressing the MIDI Map Mode switch.

MIDI assignments can be deleted using your computer’s Backspace or Delete key while
MIDI Map Mode is active.

21.2.3 Mapping to MIDI Notes

MIDI notes send simple on/off messages to Live's interface elements. MIDI note-on and
note-off messages have the following effects on controls in Live:

e Session View Slots- Note-on and note-off messages affect clips in the slot according
to their Launch Mode settings (see Launch Modes).

e Switches- A note-on message toggles the switch state.

¢ Radio Buttons- Note-on messages toggle through the available options.
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21.2.4 Mapping to Absolute MIDI Controllers

Absolute MIDI controllers send messages to Live in the form of absolute values ranging
from O to 127. These values lead to different results depending on the type of Live control
to which they are assigned. A value message of 127, for example, might turn the Volume
control on a Live track all the way up or play a Session View clip. Specifically, MIDI-controller
messages from 0 to 127 have the following effects on controls in Live:

e Session View Slots- Controller values above 63 are treated like note-on messages.
Controller values below 64 are treated like note-off messages.

e Switches- Controller values 64 and above turn the switch on. Controller values below
64 turn it off.

e Radio Buttons- The controller's 0...127 value range is mapped onto the range of
available options.

e Continuous Controls- The controller’s 0...127 value range is mapped onto the param-
eter’s range of values.

Live also supports pitch bend messages and high-precision controller messages with a
0...16383 value range. The above specifications apply to pitch bend and high-precision
controllers as well, except that the value range’s center is at 8191/8192.

21.2.5 Mapping to Relative MIDI Controllers

Some MIDI controllers can send “value increment” and “value decrement” messages instead
of absolute MIDI messages. These controls prevent parameter jumps when the state of a
control in Live and the corresponding control on the hardware MIDI controller differ. For
example, imagine that you have assigned the pan knob on your controller box to the pan
control in a Live track. If the hardware control is panned hard right, and the Live control is
panned hard left, a slight movement in a hardware pan knob that sends absolute messages
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would tell Live to pan right, causing an abrupt jump in the track’s panning. A pan knob
sending relative messages would prevent this, since its incremental message to Live would
simply say, “Pan slightly left.”

There are several types of relative controllers: Signed Bit, Signed Bit 2, Bin Offset and Twos
Complement. Live can recognize the type of relative controller you are working with as you
make remote-control assignments, and you can help this by moving the relative controller
knob slowly to the left when you make the assignment. If you know the relative controller
type, you can manually select it in the chooser that appears in the Status Bar at the bottom
of the Live screen while mapping a Live control.

Live will do the following with relative MIDI-controller messages:

e Session View Slots- Value increment messages are treated like note-on messages.
Value decrement messages are treated like note-off messages.

e Switches- Increment messages turn the switch on. Decrement messages turn it off.

e Radio Buttons- Increment messages make the radio button jump forward to the next
available option. Decrement messages make it jump backward.

e Continuous Controls- Each type of relative MIDI controller uses a different interpre-
tation of the 0...127 MIDI-controller value range to identify value increments and
decrements:

Convention (Mode) Increment | Decrement
Relative (Signed Bit) 001-064 065-127
Relative (Signed Bit 2) | 065-127 001-064
Relative (Bin Offset) 065-127 063-001
Relative (2's Comp.) 001-064 127-065

Please consult the documentation that came with your MIDI controller if you need further
information on relative MIDI controllers.
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21.3 Relative Session View Navigation

Notice that you can make not only absolute mappings to individual slots and scenes, but
also relative mappings to move the highlighted scene and operate on the highlighted clips.

In Key or MIDI Map Mode, a strip of assignable controls appears below the Session grid:
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1. Assign these buttons to keys, notes or controllers to move the highlighted scene
up and down.

2. Assign this scene number value box to a MIDI controller, preferably with an
endless knob, to scroll through the scenes. For details, see the discussion of
Relative Map Modes (see Mapping to Relative MIDI Controllers).

3. Assign this button to launch the highlighted scene. If the Misc Preferences’
“Select Next Scene on Launch” option is checked, you can successively go
through the scenes.

4. Assign these buttons to launch the clip at the highlighted scene, in the respective
track.

Relative session mapping is useful for navigating a large Live Set, as Live always keeps the
highlighted scene at the Session View's center.
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21.4 Mapping to Clip View Controls

The Clip View (see Clip View) displays the settings for whichever clip happens to be currently
selected. It might also display settings for a clip multi-selection. In avoiding unpleasant
musical surprises, it is important to remember that creating remote-control mappings for
any control in the Clip View interface could potentially affect any clip in the Live Set. For
this reason, we recommend mapping Clip View controls to relative MIDI controllers (see
Mapping to Relative MIDI Controllers) to prevent undesirable jumps in parameter values.



Chapter 22

Mackie Control

The comprehensive Mackie Control mixing surface puts all of Live’s real-time creative power
at your fingertips.

Mackie Control allows for mouse-free program operation and navigation. Through the
bi-directional connection between Live and the Mackie Control, any changes made in the
program are reflected in the mixing surface, and vice versa. To establish this connection,
open Live's MIDI/Sync Preferences. At the bottom of the window, you will find the Remote
Control Surfaces options. Selecting “Mackie Control” from the Control Surface chooser,
and then setting the necessary input and output, will establish the connection between Live
and the control surface.

It is possible to expand the number of Mackie Control channel strips available using a
hardware extension. This extension is separately set up in Live's Preferences (signified by
“"MackieControlXT" in the Control Surface chooser). If the Mackie Control extension is
selected from the topmost chooser, it will control the Live tracks beginning at the left-hand
side of the program, and should therefore be placed to the left of the Mackie Control mixing
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surface. If selected from the lower chooser, the Mackie Control extension should be placed
to the right of the main Mackie Control.

The following sections will describe how to operate the Mackie Control with Live. You may
find the mixing chapter (see Mixing) to be particularly useful in locating and understanding
Live’s track controls.
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22.1 Channel Strips

The Eight Channel Strips
and the Master Strip.

The Mackie Control's eight channel strips and master strip are automatically assigned to
tracks in Live. Each of these strips has a set of track controls, including a motorized fader and
a V-Pot, for controlling any number of track parameters. The Mackie Control’s bank/channel
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controls (see Bank/Channel and Flip/Return) allow reassigning the channel strips to access
an unlimited number of Live tracks.

1. Arm — By default, this arms the track for recording in exclusion of all other tracks.
To arm the track nonexclusively (i.e., in addition to other tracks), hold down the
Mackie Control’s Control button (see Software-Specific Controls) while pressing
this. Note that a Misc Preference setting in Live allows deactivating exclusive
track arming. When this setting is deactivated, the behavior of this knob with
respect to exclusive and nonexclusive arming is reversed.

2. Signal LED — Shows an armed track’s input signal level from MIDI or audio; shows
an unarmed track’s output signal level.

3. Solo — Activates/deactivates soloing for the track in exclusion of all other tracks.
To solo the track nonexclusively (i.e., in addition to other tracks), hold down the
Mackie Control’s Control button (see Software-Specific Controls) while pressing
this. Note that a Misc Preference setting in Live allows deactivating exclusive
track soloing. When this setting is deactivated, the behavior of this knob with
respect to exclusive and nonexclusive soloing is reversed.

4. Mute — Mutes/unmutes the track nonexclusively.

5. Select — Selects the track, both in Live and on the Mackie Control, for various
functions.

6. V-Pot/Fader — The fader controls track volume by default but can be flipped (see
Bank/Channel and Flip/Return) to control track panning. Please see the next
section (see V-Pots and Assignment Switches) for the details on V-Pots.



22.2. V-POTS AND ASSIGNMENT SWITCHES 328

22.2 V-Pots and Assignment Switches

The V-Pots and
i L Assignment Switches.

The Mackie Control's V-Pots have dual functionality in many cases, as they can be both
rotated and pressed. When being used to adjust single parameters (those belonging to
track devices, for example), pressing a V-Pot returns a control to its default value. Pressing a
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V-Pot when dealing with a control that has various options (filter type choosers, for example),
selects the options in sequence. With controls having only two options (e.g., an on/off
switch) pressing a V-Pot toggles the options.

There are six assignment switches to the right of the channel strips on the Mackie Control.
These select which parameters are displayed in the main display, and set these parameters
to be available for control with the V-Pots. The two-character display above the assignment
switches shows the currently selected assignment mode.

1. I/O - Switches the V-Pot and main display to /O mode. This allows Live’s track
inputs and outputs (see Routing and |/O) to be set with the V-Pots.

e Click once to select the track’s Input Type chooser.

e Click twice to select the track’s Input Channel chooser.
e Click three times to select the Output Type chooser.

e Click four times to select the Output Channel chooser.

2. Send - Switches the V-Pot to control the levels of all available Send controls
for the currently selected track. If more than eight sends are available, you can
navigate through them using the previous and next buttons (see item 5, below).

3. Pan - Assigns the V-Pot and main display to the track’s Pan control.

4. Devices — Pressed once, this will bring up all available devices for the currently
selected track in the main display. Using the page buttons (see item 5, below),
you can then scroll through the available devices and choose a particular device
to edit by pressing the V-Pot. When you are done editing device settings, you
can change the selected track or press the device assignment switch again to
return to scrolling and selecting devices.

When device settings are being changed, the name and settings of the selected
device are shown in the main display. You can use the V-Pot to change parameter
values as described in the introduction to this section.
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5. Previous/Next — If, in any of the above assignment modes (especially with de-
vices), more than one page of parameters is available, these buttons will scroll
through the pages. LEDs above these switches illuminate when more pages are

available before or after the current one.
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22.3 Bank/Channel and Flip/Return

0
0
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0
=g &
0

e

Bank, Channel, Flip and
Return Buttons.

1. Bank - If more than eight tracks are being used in Live, these buttons can be
used to page through the additional tracks and set them to the Mackie Control’s
eight channel strips. The bank “+"” and “-" buttons page the channel strips in
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increments of eight (or more, if a fader extension is installed) to the right or left,
respectively. To go to the first/last page, hold down the Mackie Control's Shift
button (see Software-Specific Controls) while pressing these.

2. Channel — You can use the channel “+" and “-" buttons to scroll through the
additional tracks singly, setting them to the Mackie Control’s eight channel strips.
To go to the first/last track, hold down the Mackie Control’s Shift button (see
Software-Specific Controls) while pressing these.

3. Flip — When flip mode is enabled (as shown by the illuminated LED above the
button), the functionality of the V-Pots and faders is switched. This is the case in
all available assignment modes.

4. Return — By default, the channel strips display only those tracks in Live that
contain clips. When return mode is enabled (as shown by the illuminated LED
above the button), the channel strip will show and control the return tracks. All
assignments and modes will function otherwise identically.
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22.4 Transport

The Transport Controls.

1. Previous/Next Locator — Using these buttons, you can skip forward or backward
through the Arrangement from locator to locator (see Launching the Arrange-
ment with Locators). Note that the Arrangement start and end are also marked
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with “invisible” locators to which you can navigate using these buttons. The LEDs
above these buttons are illuminated when a previous/next locator is available in
the respective direction.

Loop On/Off — Toggles the Arrangement Loop switch on/off.
Punch-In/Punch-Out — Toggles Live's Punch-In/Punch-Out switches on/off.
Home — Jumps to the Arrangement start, 1.1.1.

End — Jumps to the Arrangement end.

Rew/Forw — When pressed once, these buttons will move the play position one
beat backward/forward. When held down, the buttons move forward/backward
in increments of one bar during Arrangement playback, one beat if the Arrange-
ment is stopped. Holding down the Mackie Control’s Alt button (see Software-
Specific Controls) when the Arrangement is playing will also move in one-beat
increments forward/backward.

. Stop — Stops Arrangement playback.

Play — Plays the Arrangement from the song start or insert marker.

Record — Toggles the Record button on/off.

. Arrows —

e In the Session View, the arrows navigate through the Session View grid.
Pressing the zoom button in the middle of the arrows will fire the currently
selected clip, or stop another playing clip in the same track if the cur-
rently selected slot is empty. To stop playing the selected clip, hold down
the Mackie Control's Options button (see Software-Specific Controls) while
pressing zoom, and use the Alt button (see Software-Specific Controls) to
add/remove the selected slot’s Clip Stop button.

Note that the LEDs associated with the zoom buttons will display the play
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11.

12.

status of a clip: an illuminated LED signifies a playing clip; a blinking LED
signifies a clip that has been triggered but is not yet playing; and an unillu-
minated LED signifies a stopped clip or empty slot.

¢ In the Arrangement View, with the zoom button enabled (i.e., its LED illu-
minated), you can use the arrow buttons for zooming and scrolling in the
currently selected track. When zoom is not enabled, the arrow buttons can
be used to select tracks.

Scrub — This fires the currently selected scene in the Session View and has no
effect in the Arrangement View. To stop all running clips, hold down the Mackie
Control's Options button (see Software-Specific Controls) while pressing this.

Jog Wheel - In the Session View, the jog wheel scrolls through the scenes. In
the Arrangement View, the jog wheel moves the play position. To change global
quantization, hold down the Mackie Control’s Control button (see Software-
Specific Controls) while turning the jog wheel. You can also use the Mackie
Control’s Alt button (see Software-Specific Controls) in the Arrangement View to
move the play position in smaller increments.
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22.5 Software-Specific Controls

The Software-Specific
Controls.

1. Shift, Option, Control, Alt — Used to access additional Mackie Control options.

2. SMPTE/Beats — Toggles between displaying beats/bars and SMPTE in the time
display.
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Name/Value — Switches the meters in the main display on/off. Note that these
meters appear only when pan assignment mode (see V-Pots and Assignment
Switches) is active.

F-Keys — These keys can be mapped freely to controls in Live (see MIDI Remote
Control).

ViewArr (On) — Toggles Arrangement View and Session View. When the Mackie
Control's Shift key is held down, this sets the program focus to the Arrangement
View or Session View, whichever is currently on screen.

ToggleDetail (Rec/Rdy) — Toggles Clip View and Track View. When the Mackie
Control's Shift key is held down, this sets the program focus to the Clip View or
Track View, whichever is currently on screen.

. ViewBrowser (SnapShot) — Shows/hides the Browser. When the Mackie Control’s

Shift key is held down, this sets the program focus to the Browser.

. ViewDetail (Touch) — Shows/Hides the Clip/Track View. When the Mackie Con-

trol's Shift key is held down, this sets the program focus to the Clip View or Track
View, whichever is currently on screen.

Undo and Redo — Undoes/redoes the last change made to the Live Set. The LED
will illuminate if there is an available action to undo/redo.

BTA (Cancel) - Stops clips in the Session View from playing differently than how
they were recorded into the Arrangement, and returns to playing the Arrange-
ment. The LED will illuminate if there is an Arrangement state available to which
to return.

Locator (Marker)— Deletes a locator (see Launching the Arrangement with Locators)
when a locator is currently selected and the song is stopped. Otherwise, it cre-
ates a new locator at the current play position.

DrawMode (Enter) — Enables/disables Draw Mode, for drawing notes and en-
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velopes.

13. Follow (Mixer) — Toggles Follow Mode, which scrolls Live's display to follow
playback.



Chapter 23

Synchronization and ReWire

23.1 Synchronizing via MIDI

The MIDI protocol defines two ways to synchronize sequencers, both of which are supported
by Live. Both protocols work with the notion of a sync master, which delivers a sync signal
that is tracked by the sync slave(s).

e MIDI Clock. MIDI Clock works like a metronome ticking at a fast rate. The rate of the
incoming ticks is tempo-dependent: Changing the tempo at the sync master (e.g., a
drum machine) will cause the slave to follow the change. The MIDI Clock protocol also
provides messages that indicate the song position. With respect to MIDI Clock, Live
can act as both a MIDI sync master and slave.

e MIDI Timecode. MIDI Timecode is the MIDI version of the SMPTE protocol, the
standard means of synchronizing tape machines and computers in the audio and
film industry. A MIDI Timecode message specifies a time in seconds and frames
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(subdivisions of a second). Live will interpret a Timecode message as a position in the
Arrangement. Timecode messages carry no meter-related information; when slaving
Live to another sequencer using MIDI Timecode, you will have to adjust the tempo
manually. Tempo changes cannot be tracked. Detailed MIDI Timecode preferences
are explained later in this chapter (see MIDI| Timecode Options). With respect to MIDI
Timecode, Live can only act as a MIDI sync slave, not a master.

23.1.1 Synchronizing External MIDI Devices to Live

Live can send MIDI Clock messages to an external MIDI sequencer (or drum machine). After
connecting the sequencer to Live and setting it up to receive MIDI sync, turn the device on
as a sync destination in Live's MIDI Preferences.

Choosing a MIDI Slave
for Live.

The lower indicator LED next to the Control Bar's EXT button will flash when Live is sending
sync messages to external sequencers.

23.1.2 Synchronizing Live to External MIDI Devices

Live can be synchronized via MIDI to an external sequencer. After connecting the sequencer
to Live and setting it up to send sync, use Live’s MIDI Preferences to tell Live about the
connection.
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Audio MIDUSync Plug-In Defaults Misc Products

Input Track Sync Remote

Then, activate external sync either by switching on the EXT button in the Control Bar or
using the External Sync command in the Options menu. The upper indicator LED next to
the EXT button will flash if Live receives useable sync messages.

Desktop |

When Live is synced to an external MIDI device, it can accept song position pointers from
this device, syncing it not only in terms of tempo but in terms of its position in the song. If
the master jumps to a new position within the song, Live will do the same. However, if the
Control Bar's Loop switch is activated, playback will be looped, and song position pointers
will simply be “wrapped” into the length of the loop.

23.1.3 MIDI Timecode Options

Timecode options can be set up per MIDI device. Select a MIDI device from the MIDI/Sync
Preferences’ Active Device list to access the settings.

The MIDI Timecode Frame Rate setting is relevant only if “MIDI Timecode” is chosen from
the MIDI Sync Type menu. The MIDI Timecode Rate chooser selects the type of Timecode
to which Live will synchronize. All of the usual SMPTE frame rates are available. When the
Rate is set to “SMPTE All,” Live will auto-detect the Timecode format of incoming sync
messages and interpret the messages accordingly. Note that you can adjust the Timecode

Setting up Live as a MIDI
Slave.

The External Sync
Switch.
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format that is used for display in the Arrangement View: Go to the Options menu, and then
access the Time Ruler Format sub-menu.

The MIDI Timecode Offset setting is also only relevant if “MIDI Timecode"” is chosen from
the Sync Type menu. You can specify a SMPTE time offset using this control. Live will
interpret this value as the Arrangement’s start time.

23.1.4 Sync Delay

The Sync Delay controls, which are separately available for each MIDI device, allow you to
delay Live’s internal time base against the sync signal. This can be useful in compensating
for delays incurred by the signal transmission. The Sync Delay for a specific MIDI device
appears as you select the MIDI device from the MIDI Preferences’ Active Device list. To
adjust the delay, have both Live and the other sequencer play a rhythmical pattern with
pronounced percussive sounds. While listening to the output from both, adjust the Sync
Delay control until both sounds are in perfect sync.

MIDI Sync MIDI Timecoda

23.2 Connecting via ReWire

Live supports the ReWire interface for connecting with another ReWire-compatible audio
program running on the same computer.

Adjusting Sync Delay.
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The ReWire technology, developed by Propellerhead Software, provides ReWire-compatible
programs with:

e common access to the audio hardware;

e shared transport functionality;

e synchronization to audio word clock and song positioning;

e exchange of audio streams.
The programs in a ReWire connection play distinct roles: The ReWire master accesses the
audio hardware and provides mixing facilities; the ReWire slave(s) have no direct link to the
audio hardware, but instead send their audio output into the Master’s mixer.
Common ReWire master applications are Digidesign Pro Tools, Steinberg Cubase and
Nuendo, Emagic Logic Audio, MOTU Digital Performer, Cakewalk Sonar and Cycling 74
Max/MSP. Common ReWire slave applications are Propellerheads Rebirth, Propellerheads
Reason, Arturia Storm, Cakewalk Project 5 and Cycling 74 Max/MSP. Live can act as both a
ReWire master and slave.
Note that the ReWire protocol itself does not consume much CPU power. However, as

expected, running two audio-intensive programs on the same computer requires more
resources than running a single program.

23.2.1 Running Live in ReWire Master Mode

The step-by-step procedure for sending MIDI to and receiving audio from a ReWire slave
program is presented in the routing chapter (see ReWire Slave Routing).
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23.2.2 Running Live in ReWire Slave Mode

If you have not used Live yet, please launch Live so that it can install its ReWire engine in
your system.

Live will run in ReWire slave mode if it detects a running ReWire master application upon
startup. Therefore, always start the ReWire master application first, and then start Live.

Likewise, you will first have to quit Live, then the ReWire master application.
Live's operation in ReWire slave mode differs from the usual operation in some regards:

e Live will not have direct access to the audio interfaces; audio input/output is handled
by the ReWire master application. No audio input will be available to Live.

e The sample rate is determined by the host application rather than by Live.

e External synchronization will be disabled (synchronize to the ReWire master application
instead). Live will not send sync or controller messages to the MIDI output. Controlling
Live via MIDI is still possible.

e Live will not act as a ReWire master application. For instance, you cannot run Rebirth
as a ReWire slave of Live while Live is running as a ReWire slave of Cubase. You can,
however, run both Live and Rebirth as ReWire slaves of Cubase at the same time.

23.2.3 More on ReWire

You can find tutorials on connecting Live to specific ReWire master programs at the Ableton
tutorial website!.

The Ableton FAQ website? is the first place to go if you encounter ReWire-related problems.

Thttp://www.ableton.com/tutorials
2http://www.ableton.com/faq
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If you cannot seem to find an answer there, please contact the Ableton support team?3.

3http://www.ableton.com/suppor‘t


http://www.ableton.com/support

Chapter 24

Computer Audio Resources and
Strategies

Real-time audio processing is a demanding task for general-purpose computers, which were
likely designed to run spreadsheets and surf the Internet. An application like Live requires
a powerful CPU and a fast hard disk. This section will provide some insight on these issues,
and should help you avoid and solve problems with running audio on a computer.

24.1 Managing the CPU Load

To output a continuous stream of sound through the audio hardware, Live has to perform
a huge number of calculations every second. If the processor can't keep up with what
needs to be calculated, the audio will have gaps or clicks. Factors that affect computational
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speed include the processor's clock rate (e.g., speed in MHz or GHz), architecture, memory
cache performance (how efficiently the processor can grab data from memory) and system
bus bandwidth — the computer’s “pipeline” through which all data must pass. For this
reason, many people involved with pro audio use computers that are optimized for musical

applications.

The Control Bar's CPU meter displays how much of the processor’s computational potential is
currently being used. For example, if the displayed percentage is 10 percent, the computer
is just loafing along. If the percentage is 100 percent, the processor is being maxed out — it's
likely that you will hear gaps, clicks or other audio problems. Note that the CPU meter takes
into account only the load from processing audio, not other tasks the computer performs
(e.g., managing Live’s user interface). Audio calculations have the highest priority in Live.
Therefore, even if the CPU shows a high percentage of processor usage, the audio stream
should remain uninterrupted. However, non-critical functions (such as screen redraws) might
slow down because these tasks are handled only when the audio processing “lightens up”
a bit.

24.1.1 CPU Load from Multichannel Audio

One source of constant CPU drain is the process of moving data to and from the audio
hardware. This drain can be minimized by disabling any inputs and outputs that are not
required in a project. There are two buttons in the Audio Preferences to access the Input
and Output Configuration dialogs, which allow activating or deactivating individual ins and
outs.

Live does not automatically disable unused channels, because the audio hardware drivers
usually produce an audible “hiccup” when there is a request for an audio configuration

The CPU Load Meter.
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change.

24.1.2 CPU Load from Tracks and Devices

Generally, every track and device being used in Live incurs some amount of CPU load.
However, Live is “smart” and avoids wasting CPU cycles on tracks and devices that do not
contribute anything useful.

For example, dragging devices into a Live Set that is not running does not significantly
increase the CPU load. The load increases only as you start playing clips or feed audio into
the effects. When there is no incoming audio, the effects are deactivated until they are
needed again. (If the effect produces a “tail,” like reverbs and delays, deactivation occurs
only after all calculations are complete.)

While this scheme is very effective at reducing the average CPU load of a Live Set, it cannot
reduce the peak load. To make sure your Live Set plays back continuously, even under
the most intense conditions, play back a clip in every track simultaneously, with all devices
enabled.

24.1.3 Track Freeze

Live's Freeze Track command, available from the Edit menu, can greatly help in managing
the CPU load incurred by devices and clip settings. When you select a track and execute
the Freeze command, Live will create a sample file for each clip in the track, calculating and
“freezing” the contribution of devices and clip parameters. Thereafter, clips in the track will
simply play back their freeze samples rather than repeatedly calculating processor-intensive
device and clip settings in real time.

Most device and clip features in frozen tracks are not accessible. However, launching clips
can still be done freely, and mixer controls such as volume, pan and the sends are still
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available. Note that track freeze is not part of Live’s Undo history, but executing the Edit
menu’s Undo command to undo an action that affected a frozen clip will automatically
unfreeze the respective track.

Once any processor issues have been resolved (or you have upgraded your machine!), you
can always select a frozen track and choose Unfreeze Track from the Edit menu to change
device or clip settings. On slower machines, you can unfreeze processor-intensive tracks
one at a time for editing, freezing them again when you are done.

Besides providing an opportunity to conserve CPU resources on tracks containing a large
number of devices, the Freeze command simplifies sharing projects between computers.
Computers that are a bit low on processor power can be used to run large Live Sets as
long as any CPU-intensive tracks are frozen. This also means that computers lacking certain
devices used in one Live Set can still play the Set when the relevant device tracks are frozen.

The samples generated by the Track Freeze command are stored in your temporary recording
folder until you save your Live Set, at which point they are moved to your Sounds folder (see
The Sounds Folder and Self-Containing).

Note: Frozen Arrangement View tracks will play back any relevant material stretching beyond
the lengths of their clips (e.g., the “tails” on Reverb effects). In the Session View, only
two loop cycles are included in the frozen clip, which means that clips with unlinked clip
envelopes (see Unlinking Clip Envelopes From Clips) will play back differently when frozen
if those envelopes are longer than two loop cycles.

24.2 Managing the Disk Load

A hard drive’s access speed (which is related to, but not identical to, rotational speed) can
limit Live's performance. Most audio-optimized computers use 7200 RPM or faster drives.
Laptops, to save power, often use 5400 RPM or slower drives, which is why projects on
laptops usually have lower track counts. The amount of disk traffic Live generates is roughly
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proportional to the number of audio channels being written or read simultaneously. A track
playing a stereo sample causes more disk traffic than a track playing a mono sample.

KEY MiD 48 ° E

The Disk Overload indicator flashes when the disk was unable to read or write audio quickly
enough. When recording audio, this condition causes a gap in the recorded sample; when
playing back, you will hear dropouts.

Do the following to avoid disk overload:

¢ Reduce the amount of audio channels being written by choosing mono inputs instead
of stereo inputs in the Audio Preferences’ Channel Configuration dialog.

¢ Use RAM Mode (see Clip RAM Mode) for selected clips.

e Reduce the number of audio channels playing by using mono samples instead of
stereo samples when possible. You can convert stereo samples to mono using any
standard digital audio editing program, which can be called up from within Live (see
Destructive Sample Editing).

The Disk Overload
Indicator.



Chapter 25

Live Keyboard Shortcuts

25.1 Showing and Hiding Views

Windows Macintosh
Toggle Full Screen Mode F11 (Cul JF1L )
Toggle Session/Arrangement View
Toggle Track/Clip View
Hide/Show Track/Clip View & JF12 )
Double-Click Clip / Track | Double-Click Clip / Track
Hide/Show Info View 2) 2)
Hide/Show Overview (Cul (AL (O] (CEENEEEE)
Hide/Show In/Out (Cul @Al 0] G ®At 0
Hide/Show Sends Cul JAL (s & BAL (s
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25.2. ACCESSING MENUS

Windows Macintosh
Hide/Show Mixer (Cul @A M
Hide/Show Crossfader | [(Cul Al J[F)
Open the Preferences | N/A EEES
Close the Preferences | N/A Esc

25.2 Accessing Menus

352

Under Windows, you can access each menu by pressing [Alt ] and the first letter of the

menu ((Alt_J[F] for “File”, for instance). While a menu is open, you can use:

. to navigate the menu items;

¢ [« to open the neighboring menu;

e [Return) to choose a menu item.

25.3 Adjusting Values

Windows Macintosh
Increment/Decrement *
Large Increment/Decrement Pagg [fPagel | [¥Page (tPage
Return to Default (Delete]
Type in Value o). (9] 0] .. (9]
Go to Next Field (Bar.beat.16th) | [ ], ) L0
Abort Value Entry Esc Esc
Confirm Value Entry Return]
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25.4 Browsing

353

In addition to the shortcuts shown here, editing shortcuts (see Editing) can also be used in

the Browser.

Windows Macintosh
Activate Browser Search Mode Ccul & JF | @& WD )F)
Load Selected Item From Browser
or Double-Click | or Double-Click

Scroll Up/Down ) (4]

Open/Close Folders «> <>

Preview Selected File >

Set Selected Folder as Browser Root | Return) Return)
25.5 Transport

Windows Macintosh

Play from Start Marker/Stop

Continue Play from Stop Point Space Space

Play Arrangement View Selection | (Ctl )(Space) (Alt ~-)(Space)
Record

Back to Arrangement F10 F10
Activate/Deactivate Track 1..8 FL_ ). [P ]| F _J. FB_ ]
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25.6 Editing

354

Windows Macintosh

Cut c KX

Copy G B

Paste @ &V

Duplicate | (Ctl (D) (CEESI)

Delete

Undo (3]

Redo Cc )& 2 | & (@

Rename | (Cil ][R] S ®R

Select All | (Cul J(A) (CEESN
By holding down an additional modifier key, some of the above commands can also be
applied to:

Windows | Macintosh

Clips and Slots Across all Tracks

Time Across all Tracks

The Selected Part of the Envelope | (Al At

can be used to move from one track or scene to another while renaming.

25.7 Loop Brace and Start/End Markers

The loop brace and start/end markers must first be selected before any of the following
commands will apply to them.



25.8. SESSION VIEW COMMANDS

Windows Macintosh
Move Start Marker to Position Click Click
Nudge Loop Left/Right
Move Loop By Loop Length ¥
Double/Halve Loop Length [Cul () (F) (@ ®)(+)(4)
Shorten/Lengthen Loop (Cul [«
Select Material in Loop Click Loop Brace Click Loop Brace
or or @ B L

25.8 Session View Commands

See also the editing commands (see Editing).

Windows Macintosh
Launch Selected Clip/Slot Return) Return)
Select Neighbouring Clip/Slot | Arrow Keys Arrow Keys
Select all Clips/Slots (Cul (A G _HA
Copy Clips Drag Drag
Add/Remove Stop Button [E) E
Insert MIDI clip (ST ) © ®@ MW
or Double-Click Slot | or Double-Click Slot
Insert Scene (Cul 0] & &0
Insert Captured Scene (Col ] i) (3
Drop Browser Clips as a Scene
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25.9 Arrangement View Commands

The shortcuts for zooming (see Zooming, Display and Selections), snapping/drawing (see
Grid Snapping and Drawing) and loop/region settings (see Loop Brace and Start/End
Markers) also work in the Arrangement View. See also the editing commands (see Editing).

Windows Macintosh
Split Clip at Selection (I E)
Consolidate Selection into Clip (CHESD
Loop Selection c_®L
Insert Silence (Cl (1] & R
Pan Left/Right of Selection (Cul At ] & ®Ar
Unfold all Tracks Unfold button | (At~ Unfold button
Scroll Display to Follow Playback (D
25.10 Commands for Tracks
See also the editing commands (see Editing).
Windows Macintosh
Insert Audio Track (Cul )[T)
Insert MIDI Track
Insert Return Track Cul ] T
Rename Selected Track (Crl R} @ BR]
While Renaming, Go to next Track
Arm/Solo Multiple Tracks (Cul ] Click Click
Add Device from Browser Double-Click Double-Click




25.11. COMMANDS FOR BREAKPOINT ENVELOPES
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25.11 Commands for Breakpoint Envelopes

The shortcuts for zooming (see Zooming, Display and Selections), snapping/drawing (see
Grid Snapping and Drawing) and loop/region settings (see Loop Brace and Start/End

Markers) also work in the Envelope Editor and Arrangement View. See also the editing
commands (see Editing).

Windows | Macintosh
Finer Resolution for Dragging Ctrl
Enable Dragging Over Breakpoints

25.12 Key/MIDI Map Mode and the Computer MIDI Key-

board
Windows Macintosh
Toggle MIDI Map Mode | (Ctd ]
Toggle Key Map Mode (IS
Computer MIDI Keyboard | (Ctl J[& k) | (& B K]




25.13. ZOOMING, DISPLAY AND SELECTIONS

25.13 Zooming, Display and Selections

Windows Macintosh
Zoom In +]
Zoom Out (-]
Drag/Click to Append to a Selection
Click to Add Adjacent Clips to Multi-Selection
Click to Add Nonadjacent Clips to a Multi-
Selection
Follow (Auto-Scroll) (crl J[F)
Pan Left/Right of Selection (Cul AR ) At )

25.14 Clip View Sample Display
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The shortcuts for zooming (see Zooming, Display and Selections) and loop/region settings

(see Loop Brace and Start/End Markers) also work in the Sample Display.

Windows Macintosh
Move Selected Warp Marker > ()
Select Warp Marker
Scroll Display to Follow Playback
Move Clip Region with Start Marker
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25.15 Clip View MIDI Editor

The shortcuts for zooming (see Zooming, Display and Selections), snapping/drawing (see
Grid Snapping and Drawing) and loop/region settings (see Loop Brace and Start/End
Markers) also work in the MIDI Editor.

Windows Macintosh
Quantize G ®U
Scroll Editor Vertically
Scroll Editor Horizontally (Ctl )¥PageltPagel | (& % ¥ Pagel(tPage
Copy Note (cul ] Drag Drag
Change Velocity From Note Editor Drag Drag
Add/Delete Note in Edit Mode Double-Click Double-Click
Scroll Display to Follow Playback CEESE
Move Clip Region with Start Marker | (& )« & )=

25.16 Grid Snapping and Drawing

Windows | Macintosh

Toggle Draw Mode (Cul B
Narrow Grid Cul 1) | G _F
Widen Grid cul 2] | @ &2
Triplet Grid crl B3] | (@ 8B
Snap to Grid Cul fa) | G K4
Fixed/Zoom-Adaptive Grid (Cul 5
Bypass Snapping While Dragging | [Alt




25.17. GLOBAL QUANTIZATION

25.17 Global Quantization

Windows | Macintosh

Sixteenth-Note Quantization

Crl (6] 6]

Eighth-Note Quantization

Quarter-Note Quantization

1-Bar Quantization

(CuT Jo) | © 6]

Quantization Off

cul 0] G %))

25.18 Working with Sets and the Program

Windows Macintosh
New Live Set
Open Live Set © ©
Close Live Set
Save Live Set (cul )(s) & $)(s)
Save Live Set As... | (& Jcul 8] | @& G RW(s)
Quit Live Q Q)
Hide Live N/A
Render to Disk cr )¢ IR | G _¥EL  JR)
Export MIDI file cl )& JE) | © ®E  IE)
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25.19. WORKING WITH PLUG-INS AND DEVICES

25.19 Working with Plug-Ins and Devices

361

Windows Macintosh
Show/Hide Plug-In Windows (Cul (P} & BP)
Open Second/Multiple Windows with
Plug-In Edit Button
Open Mac Keystroke Plug-In Window N/A )
with Plug-In Edit Button
Group/Ungroup Devices (Cul ]G] & %)

Activate/Deactivate All Devices in Group

Device Activator

Device Activator

Click to Append Devices to a Selected
Device

Load Selected Device From Browser

or Double-Click

or Double-Click

25.20 Using the Context Menu

A context menu is available in Live for quick access to many commonly used menu items.
To access the context menu, 3 (PC) / 8 (Mac) on the part of the interface where
you would like to execute a particular command. It is worth noting that Live's context menu
may sometimes contain applicable settings from the Preferences. You should change these
options with care, as they will affect not only the currently selected item but the general

settings of the program.

Some commands only appear in the context menu. These are: the Create Folder, Analyze
Audio, Search In Folder, Close All Folders and Refresh commands from the Browser (see
Working with the File Browsers); the special grid marker commands for directing Auto-
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Warp (see Syncing Longer Pieces); detailed options for zoom-adaptive and fixed grid line
width (see Using the Editing Grid); and copying and pasting for Operator’s (see Operator)
envelopes and oscillators.
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Index
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A
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sales. ..o 21
technical support.............cooolL 20
web addresses
FAQS. .o 344
registration....... ... i 14
tutorials . ... 344
unlocking. ..o 16
webshop ... 19
Active Devices list. ..o, 153
Adaptive Grid options........................... 73
Add/Remove Stop Button command ............ 84
analysisfiles............. 53
storing clip settingsin..................... 105
analysis of files
batch processing ...................oo 54
Analyze Audio command...............oooo 54
Arm Recording button .................... 172,182
Arpeggiatoreffect ... 275

364

Arrangement ............... see Arrangement View
Arrangement Overview.......................... 65
Arrangement Position fields ..................... 67
Arrangement View ..., 64
and copying to Session..................... 87
and Session View ..o, 24
grid sNappiNg.......oviiiiiiii 73
insertmarker.......... oo 66
loopinginthe...................oo 70
navigation........... ... ..o 65
recording new clipsinthe ................. 183
scrubarea ... 67
Arrangement Viewselector ...................... 24
asdfiles..........oooi see analysis files
audioclips ... see clips
audioeffects...............ooiLL see devices
audiofiles...............oo see samples
audio interface setup . .. see Audio Preferences, see
routing
Audio Preferences..........cooiiiiiiiiiiii, 8
Audio Record Folder preference ............... 190
audiotracks. ... see tracks
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Audio Units Plug-ins, using............. see devices
authorization .................. see copy protection
Auto Filtereffect................L 239
Auto Paneffect ...t 241
Auto-Hide Plug-In Windows option ............ 206
Auto-Open Plug-In Windows option ........... 206
Auto-Warp ... 118
Auto-Warp Long Samples preference .......... 123
automation........ ... 39, 215
andgridlines.............ooiii 219
Arawing . .o.oeei 218
editing ..o 219
overriding/reactivating .................... 216
reCOrdiNg .« .o v et 215
Automation Control chooser................... 218
Automation Device chooser.................... 218
B
Back to Arrangement button ........... 27,86, 216
Beat Repeateffect........................ ... 242
beat-time ruler
and Arrangement editing................... 65
and editing envelopes..................... 235
and editing MIDIl ...l 127
inthe MIDI Editor ...t 128
BeatsMode. ...t 121
breakpoint envelopes..... see automation, see clip
envelopes
Browse Presets button ................ ... ... 198

Browser . see File Browser, see Live Device Browser,
see Plug-In Device Browser

365
browsingfiles ... 45
C
Capture and Insert Scene command............. 85
ChallengeCode........cooiiiiiii 15
Check for Updates command..................... 1
Chordeffect ... 279
Chorus effect ... 244
Clip Activator switch.......................o. L. 92
ClipboxX.....ooiii 90
Clip Colorchooser ... 92
Clip Envelope Control chooser................. 225
Clip Envelope Device chooser.................. 224
clipenvelopes...............ooiiL, 40, 223
and changing note pitch................... 226
and changing note volume ................ 228
asLFOs .. ..o 237
changing clipsfor......................o.. 230
creating long loops with................... 235
for MIDI controls ...........c..cooiiiiiat. 233
general editingof ......... ...l 224
imposing rhythm with............... .. ... 236
loop/region settings for.................... 234
mixer control modulation with ............. 231
scrambling beats with ................ ... 229
unlinking from clips........................ 234
using for fade-outs ........................ 234
ClipFade switch ............. ...t 106
ClipGainslider..............oooooi. 103

Clip Groove chooser ... 93
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Clip Launchbutton...............ocoiiiaat. 79
Clip Namefield ..., 92
Clip Nudge buttons ............................. 94
ClipOverview........coooiiiiiiiiiiiii i, 88
for zooming/scrolling .............. ... ... 98
Clip Quantization chooser...................... 141
Clip Record button...................o. . 38, 185
Clip Signature fields............................. 93
ClipStopbutton ... 79
adding/removing ... 84
Clip Update Rate preference................... 110
ClipView. ... 88
and playing the Arrangement............... 68
and remote-control mapping.............. 323
SCrUb area.......oouvviiiiniiii i, 100
Clip View boxes selector .......... 91,125,139, 224
clips. .o 24
addingfadesto..............cooiiiinn.t. 106
arranging/editing . ... 71
astemplates...................o 230
audioclips......cooviiiiii 28
clip multi-selections..................... ... 89
deactivating/muting ... 92
editing MIDI notes/velocities .............. 124
importing from files.....................L 50
in Arrangement View .................. ... 71
in audio/MIDI tracks .................oooo 27
in Session View ... 79
Live Clips.......ooooiiiii 58
managing meter offset...................... 95

MIDlclips. ... ..o 30

FENAMING .ttt et ettt 92
FEVEISING . ettt et 108
saving settingsfor................. ..., 105
setting propertiesof ............ ... ..o 88
Close All Folders command ................ 47,198
ComplexMode ... 123
compressed audio files................ see samples
Compressor leffect............................ 246
Compressor Il effect................oo. 248
Computer MIDI Keyboard button .............. 154
Computer MIDI Keyboard option .............. 154
Consolidate command ...................... ... 76
context menuU ...t 361

Control chooser .. see Automation Control chooser,
see Clip Envelope Control chooser

control surfaces ................ see Mackie Control
Copy Envelope command...................... 221
copy protection ... 12
count-in forrecording ... 189
Count-Insetting..............cooii 189
CPU . 346
CPULoadmeter. .........ooviiiiiiiiiiaan... 347
Create Analysis Files preference................. 54
Create Folder command......................... 51
crossfader. ... ... 34,175

and remote control .......... ... ...l 175

automatingthe...................... ... 176
Cue Out chooser.........ooiiiiiiiiiiiiat 177
CUE POINES ..o see locators
CUBING ettt ettt e e 177
Cut Envelope command ....................... 221
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CutScenescommand ..................cooi.... 84
CutTimecommand ................coviiiit. 74
D
Decoding Cache preferences.................... 52
Default Preferences. ..., 9
and recording clips.....................LL 190
for clip settings..................oo 110
Delay Compensation option ................... 214
Delete Automation command.................. 216
Delete command
anddevices ............... i 196
andenvelopes...........coooiiiii 225
and key mapping............ooiiiiii. 316
and MIDI mapping ... 319
andtracks........ .. .. i 173
intheBrowser.............oooiiii ... 51
Delete Locatorbutton........................... 69
Delete Locator command ....................... 69
Delete Scenescommand........................ 85
Delete Time command .......................... 75
DemoMode ... 18
Demo Sets . ..o 23
Detunefield ..........o i 103
Device Activator switch ........................ 196

Device chooser ... see Automation Device chooser,
see Clip Envelope Device chooser

devices.. ... 31

compensating for delays................... 214

device groups ..ot 201

367
Presets .......oovviiiiiiiiiii 197
the Live audio effects...................... 238
the Live instruments....................... 285
the Live MIDl effects....................... 274
using Audio Units Plug-ins................. 212
using Live devices ... 194
using plug-in devices...................... 202
using VST Plug-ins. ...t 207
Double/Halve Original BPM buttons ....... 109, 115
Draw Mode . ..o 218
and drawing MIDI ... 126
with clip envelopes........................ 226
Draw Modecommand ...........cooovvienin... 218
Duplicate Envelope command ................. 221
Duplicate Scenes command ..................... 85
Duplicate Time command ....................... 75
E
Edit menu commands
and automation ........... ... .. 216, 221
and MIDInotes.......cooooviiiiiiiiii.. 133
and renderingtodisk........... ...l 56
andreturntracks ........ ... o 174
anNd SCENES ..o vttt 81
andtracks.......... 173
inthe Browser ..., 50
with Clip Stop buttons...................... 84
with clips ... 92
withscenes. ... 84
effects ... see devices
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Envelope Editor...............ooiilL. 90, 224
envelopes...... see automation, see clip envelopes
Envelopesbox ....................oo 90, 224
EQFoureffect.........coooiiiiiiii 251
EQThreeeffect..........cooiiiiiiiiii .. 250
Erosioneffect..............coiiiii 252
Exclusive Arm option............coooiviiia.. 172
Exclusive Solo option ...................... 172
Exit Search button................c.oiL. 48
Export MIDI Clip command...................... 58
exporting audio................. see Render to Disk
external sync............. see MIDI synchronization
F
FAQS ..ot see Ableton
File Browser........c.oooviiiiiiiiiiiiiii i, 45
opening Setswith the....................... 23
Filter Delay effect.................oi. 253
Fixed Grid command................oooia. 74
Fixed Grid options .............ccoviiiiiiii... 73
FLACTiles.....cooviviiiiiiii, see samples
Flangereffect............. oot 255
Foldbutton........coooiiiiiii i, 130
Folder-Up button..........................o. L. 46
Follow Actions ......o.oviviiiiiiiii i, 143
Followcommand .............. .. ... . .... 66, 99
Followswitch...................... 66,99, 113, 129
Freeze Track command......................... 348
freezing tracks ......... .. 348

368

G
Gateeffect........cooiiiiii i 256
GateMode ......ooviiiiiii 140
Global Quantization chooser.................... 38
and Session recording............... o 184
Grain Delay effect...............cocooii 258
Grain Flux field. ... 122
Grain Sizefield................ 122
Grain Size knob ....... ... 122
grid
and Arrangement editing................... 73
and envelope drawing..................... 219
and MIDl editing ... 131
in editing clip envelopes................... 236
workingwiththe............................ 73
groovefeature .........coviiiiiiiiiiiiia 93
Group Devices command ...................... 201
H
harddisk ... see CPU
Hard Disk Overload indicator................... 350
hiding products ... 21
High Quality switch ...............o.oo . 106
|
/O see routing
importing files......... ... o 50
Impulse instrument.....................o 286

and individual outputs..................... 289
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andMIDI ... .. 286
filter. .o 288
global parameters................... ... ... 289
Linkbutton...........ooo i 287
panandvolume................. ... 288
sample slots and controls.................. 286
saturator and envelope.................... 288
Start, Tune and Stretch .................... 287
INfoView .. ..o 7
insert
effect. .. 194
instrument. ... i 194
plug-ins ... 202
track. ... 172
Insert Audio Track command ................... 172
insertmarker.........co 66
Insert MIDI Clip command ..................... 124
Insert MIDI Track command .................... 172
Insert Return Track command .................. 174
Insert Scenecommand ............ ... .. ..o 85
Insert Silence command......................... 75
instruments ............................ see devices
K
Keep Offset button..........................o... 95
Key Map Mode switch ......................... 316
Key/MIDI In Indicator ...t 156
Key/MIDI Out Indicator ............coovivinn.n. 156
keyboard shortcuts. ... 351

369

L
latency ... see Sync Delay setting
Launch box. ..o 90, 139
LaunchModes ..., 140
Launch Sample Editor button .................. 103
LegatoMode .....ooviiiiii 142
[€SSONS ..o e et 7
lbrary . ....o 44
Link/Unlink Envelope switch.................... 234
Live Clips........oooiiiii 58
Live Device Browser........................ ..., 194
Live Packs.....coveiiii 63
Locate In Browser button........................ 48
locators ... 68
Lock Envelopes command ..................... 220
Lock Envelopes switch ...................... .. 220
loop brace

in the Arrangement......................... 70

withclips............ooo 101
Loop Selection command ....................... 70
Loop Start/Punch-In Position fields .............. 70
Loop switch

ClipView..........ooooiiiiiiii 101, 235

Control Bar......ooooviiiiii i 70

with MIDl clips..........ooococii 131
Loop To Next Locator command ................ 69
Loop/Punch Region Length fields ............... 70
Loop/Region controls ...................... 99,101

and clip envelopes ........................ 234

with MIDI clips............ooooo. 131
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Loop/Warp Short Samples preference.......... 123
M
Mackie Control...........coiiiiiii i 324
mapping to MIDI/keys. ... 41, 317
andrecording .......coiiiiiiii 190
Master Out chooser............cooooiiiiinn... 177
Mastertrack. ... 173
Metronome switch ......... ..., 187
MIDI
EXPOIrtiNG ... ivit i 58
quantizing ... 132,188
sending bank/program changes........... 109
MIDIclips ..o see clips
MIDI controllers................ see Mackie Control
MIDI controllers/messages..................... 319
MIDIEditor. .....ooviiii i 90, 124
and drawing MIDI ... 126
and drawing velocities..................... 136
andgridlines................oooial 131, 135
and recordingMIDI.................oL 186
creating and editingnotes................. 133
editing velocities ............... ... 136
loop/region settings for.................... 131
navigation............ ...l 127
rearranging Notes in.................oo... 132
MIDl effects.......cooiiiiniiiiin.., see devices
MIDIfiles.....oooii 30
MIDI implementation .......................... 319

MIDI interface setup.................... see routing

MIDI Map Mode switch .................... . 318
MIDI Preferences ...........coooiiiiiiiiiiiiii. 9
MIDI synchronization........................... 339
MIDI Timecode Frame Rate preference......... 341
MIDI Timecode Start Offset preference......... 342
MIDI Track In Indicator........................ 156
MIDI Track Out Indicator....................... 156
MIDI tracks .......ooviiiiiiii see tracks
Misc Preferences ..., 9
001 0= SP 33, 169
Mixer Section selector................coooiu.t. 171
modulation .................. see clip envelopes
MONTEOr MIX .o e et 174
MONITONING .« e et 150
monitoring through Live..... see Audio Preferences
MP3files ... see samples
Multiple Plug-In Windows option............... 206
mMuting......c.coovvvene... see Track Activator switch
clips. oo 92
N
Narrow Grid command ......................... 73
New command..........coooviiiiiiiiiiiiniiin.. 59
Next Locator button ...t 69
normalizing rendered audio ..................... 56
Note Editor ..o 125
Notes boxX.....oviii 91
Nudge buttons............ see Clip Nudge buttons
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Oggfiles......cooooiiiiiii . see samples

Open/Open Recent command .................. 59

Operator instrument ........................... 295
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aliasingand Tone.......................... 299
and CPU resources .........c..ccovvvnennn. 307
ENVElOPES .. vt 302
filter. ..o 304
Glideand Spread....................... ... 306
global controls ................... ... 304
layout ..o 296
LFO 301
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parameter list.............. ... 307
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unlocking . ... 12

Original BPM field ........................ 109, 115

Overdub Switch ... 184, 186

Overdubbing ... 186

P

Pancontrol.........c.coiiiiii 172

Pan quick-chooser button ....... see quick-chooser

buttons

Paste Scenes command .............. ... 85

Paste Time command ...................... ..., 74

pencil tool ... see Draw Mode

Phasereffect........ooooo i, 260

371

Ping Pong Delay effect......................... 261
Pitch Bend quick-chooser button see quick-chooser
buttons

Pitch effect. ... 280
Playbutton......... ..o 66
Plug-In Device Browser..................c...... 203
Plug-In Device Browserselector................. 203
Plug-In Edit button.................. ... ..., 206
Plug-In Performance setting.................... 207
Plug-In Preferences....................o.... 9,207
Plug-In Unfold button.......................... 204
plug-ins, using .................ooo see devices
pre-listening samples............... see previewing
Pre/Post switches ... 174
Preferences.........coooiiiiiiiiiiii i, 8
Preset Save button ... 199
Previewswitch ........................ 49,126, 127
Preview Volume knob ... 187
previewing

inthe Browser............coooiiiiii, 49

in the MIDI Editor ...............oooiintt, 126
Previous Locator button......................... 69
PrOCESSOT .. vt eie e see CPU
Products Preferences ......................... 9,12

and Live Packs...............ooii 63
Punch-In/Out switches ......................... 184
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